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Abstract 

The role of TGFβ Mediated Osteocytic Perilacunar/canalicular Remodeling in Age-related Bone 

Fragility 

By 

Charles A Schurman 

 

Age-related bone fragility results from the decline of both bone mass and quality over a 

lifetime. While therapies exist that focus on bolstering bone mass, little is known about the cellular 

and molecular mechanisms controlling bone quality (BQ). Osteocytes comprise 90-95% of all 

bone cells and regulate local quality through perilacunar/canalicular remodeling (PLR). However, 

little is known about their role in the age-related bone fragility. Aging in bone leads to several bone 

quality defects including uncoupling of bone deposition and resorption, alterations to bone 

material properties, and degeneration of the underlying osteocyte Lacuno/canalicular Network 

(LCN). While the coordinated decline of these behaviors remains unexplained the role of 

osteocytes in each of these processes implicate osteocytes in bone aging. 

Several hallmarks of aged bone also appear in bone from mice with limited transforming 

growth factor beta (TGFb) signaling in osteocytes, including poor fracture resistance and 

degeneration of the osteocyte LCN. Loss of TGFβ signaling in osteocytes also results in 

decreased expression of PLR enzymes responsible for maintaining bone material properties. 

Thus, a similar phenotype arises with aging and with the losses to TGFβ signaling in osteocytes. 

However, the extent to which these similarities are mechanistically related remains unclear.

 This work outlines the study of PLR and tracks TGFβ signaling and PLR in osteocytes 

over a lifetime to uncover molecular and mechanical mechanisms partially responsible for age-

related bone fragility. Identification of specific mechanical weaknesses, the molecular and 

chemical players behind them, and the cellular processes responsible for their emergence provide 

new therapeutic targets for improving bone quality and fracture resistance with age. 
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Chapter 1: Introduction 
 
 
 

Skeletal fragility is as much a biologic and clinical concern as it is a mechanical, material, 

and engineering affair. Any study of the skeletal strength and fracture should be concerned with 

its cellular and biologic origin as well as its nature as a hierarchically ordered structural material. 

Noting on the later, as a structural system the skeleton can be thought of in engineering terms 

and theories to classify and qualify its behavior in varying situations of mechanical demand. Using 

these schools of thought, one can understand the physics behind the forces exerted upon the 

skeleton as a structure and how it may ‘fail’ under differing applied loads and strains to assay the 

maximum extents to which the skeleton can function within this role. However, the skeleton’s 

nature as a biologic material elevates it above general static engineered materials as it has the 

capability to grow, to adapt, and even to renew. This remarkable capability to reverse damage 

through cellular and molecular means places the skeleton among the echelon of materials current 

engineers and designers can only dream about, self-renewing stability. Again however, as all 

biologic systems are bound to do, the skeleton and its cellular components age and the 
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mechanisms responsible for its material upkeep go awry and thus its structural stability suffers. 

Biologic mechanisms and life itself are then centered in the narrative of skeletal health and the 

defense against skeletal fragility. In this work, we will consider the aging skeleton, and more 

poignantly skeletal material, from both sides as a living and dynamic biologic system and as an 

engineered structural material generated and managed by its biologic components. 

 

Strength or Toughness? 

The conflict between strength and toughness is at the heart of most structurally designed 

materials, and even as a biologic material designed over millennia and crafted by evolution, the 

skeleton does not escape this conflict of duality. Almost all structural materials, designed by 

humans at least, must meet the requirements that they are both strong, able to hold or resist 

amounts of required weight or applied load, while also being tough, or damage resistant. The 

skeleton is no different as it must support the weight of the body, articulate against itself, and 

enable locomotion with as little damage as possible all while avoiding catastrophic failure. 

Perhaps in a twist of metaphysical irony, the properties of strength and toughness can be mutually 

exclusive.1 Where “strength” in engineering terms describes the ability for a material to resist 

unrecoverable deformation, “toughness” is the ability to absorb energy without failure, generally 

directly through limited deformation after yielding, known as plastic deformation. Thus, where in 

the common vernacular these terms are often taken to mean the same thing, materials science 

and engineering focuses on the interplay between the mechanisms contributing individually to 

both strength and toughness. In fact, a material’s toughness is traditionally thought of as a 

combination its strength, initial resistance to movement, and its ductility, it’s plastic deformation 

capacity post initial movement. By definition, these two properties are considered mutually 

exclusive. Thus, it is the both the ability to “carry” weight and the ability to experience a change 

in structure without losing much integrity that confers toughness to a material. As such, it is lower 

strength and higher toughness materials that often win out in situations where avoidance of abject 
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failure or fracture is the primary goal. Across the animal kingdom the effects of evolutionary 

preference for high toughness and lower hardness or stiffness in load bearing bones is seen 

through the differences in modulus, mineral content, and work to fracture when comparing the 

bovine femur and the bulla from a toothed whale.2 The femoral bovine bone has a higher bending 

strength and work of fracture than the bulla - a portion of the whale’s highly developed sonar and 

hearing apparatus that does not support body weight - but lower mineral content and elastic 

modulus. These mechanical differences account for the differences in roles that these two specific 

bones play in the body where the flexibly and toughness of the femur enables mechanical support 

and locomotion and the bulla’s rigidness enables the precise sensing of minute vibrations in the 

ocean. The skeleton’s mechanical properties are then specifically optimized for their context and 

function and so the appendicular skeleton focuses on maximizing toughness.  

 If then toughness is to be prioritized for the longevity of a loading bearing material and the 

criteria for its evaluation as a structure as a whole, knowledge of the origin of toughness within 

the skeleton must be considered. Bone itself consists mainly of type I collagen, arranged in lamella 

or sheets of fibers, and inorganic calcium phosphate mineral (hydroxyapatite - HA) in the form of 

small crystals along and within the collagen fibers.3,4 Alive, bone contains between 10% and 20% 

water and of its dry mass approximately 60-70% is the bone mineral. The rest is known as the 

organic matrix which is primarily collagen type I but also contains a collection of other bone-

associated proteins critical for mineralization and assembly5. Because bone is dominated in 

composition by its mineral constituents, it is generally classified and behaves as a brittle material6. 

Brittle materials are usually inelastic, or do not deform much before fracture or failure, think of a 

ceramic pot (Fig. 1.1A). Brittle ceramic materials and bone material (Fig. 1.1B) are also high in 

strength and hardness (the ability to withstand indentation), because the rigid crystals that 

compose these minerals are small and irregularly placed creating numerous dislocations or 

continuity errors within the material7,8. In deformation terms, their inflexible crystal structures and 

irregular arrangements make it more difficult for neighboring granular pieces, or grains, of mineral 
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within ceramics to slide past themselves and allow the whole material to engage in plastic 

deformation. In addition, the brittle nature of ceramics can be connected in part to grain 

boundary/interfacial effects where within an individual crystal/grain, plastic deformation is 

impeded by the inability of charged atoms to be displaced from their equilibrium positions. This 

contrasts with traditionally tough materials, such as most metals (Fig. 1.1C), where plastic 

deformation is allowed by movement of atoms from one equivalent lattice position to another 

allowing crystals and/or grains to individually stretch before finally being pulled out of the bulk 

material. This is the physical root of brittleness in ceramics, they resist motion but once moved 

the discontinuous pieces are no longer held together and the system fractures. Because bone is 

a brittle material, dominated by strength but desiring toughness, other aspects than its mineral 

must lend toughness to bone.  

 

 

Figure 1.1: Brittle versus ductile fracture in materials and bone. Materials of different types 
experience fracture in different ways. Most minerals and hard ceramics (A,B) are unable to 
engage in plastic deformation and experience brittle fracture on the nanoscale where rigid crystals 
that cannot deform are either cleaved through or split at crystal and grain boundaries leaving an 
uneven, sharp surface as seen through SEM (B, inset). Bone mineral (A) is mainly ceramic in 
nature and fractures primarily in a brittle fashion with little stretching of the mineral crystals as 
seen by the rough surface in the SEM (A, inset) surrounding the more polished surface of an inner 
osteocyte lacuna. Ductile materials, like metals (C) that have intrinsically high toughness, are able 
to plastically deform after yielding before failure resulting in necking, or stretching, of the material 
on the macroscale and an accompanying dimpling/cupping pattern on the nanoscale (C, inset) as 
the result of individual metal crystals stretching prior to separation from the bulk material. 



 5 

Bone as a Hierarchically Ordered Material 

Bone belongs to another specialized class of materials that are hierarchically ordered, meaning 

the bone material has transcending levels of organization on multiple length scales from the 

smallest most principal nanoscale components up to whole-tissue levels3,9 (Fig.1.2). Each level 

attains specific properties at its principle length scale that add to bone’s toughness, but also 

acquires emergent behaviors from each successive layer underneath it. The specific number oof 

levels of hierarchy in bone from the nano, micro, to macro length scales can depend upon species 

and overall body size. 

 As discussed, bone is primarily composed of a mineral known as hydroxyapatite 

(Ca5(PO4)3(OH). This mineral is arranged in hexagonal crystals composed of two individual base 

molecules and so its chemical structure is usually represented as Ca10(PO4)6(OH)2 to indicate the 

two-sided nature of the crystal unit cell5. Other trace minerals, fluoride, chloride, and carbonates 

may substitute the terminal hydroxides to generate additional specialized minerals, although this 

is more likely to occur in tooth enamel than within bone. The chemical bonds holding the crystal 

together are on the order of Angstroms, or tenths of nanometers, and crystalize into long slender 

crystals nanometers in length10. These crystals form the smallest level of order within bone and 

represent 60-70% of bone by mass and are what grant bone its brittleness and strength.  

 Bone’s toughness on the other hand, is generated primarily through its organic 

components. On the organic, or carbon-based, side bone on the nanoscale is a collection of amino 

acid chains each individual piece blueprinted in DNA of the collagen I genes. Collagen I itself is a 

protein encoded by two separate genes: alpha-one and alpha-two.  These alpha-one and alpha-

two ‘sub-chain’ proteins combine in a 2:1 ratio, wind together, and become the next level of order 

known as the tropocollagen triple-helix. Chemical bonds among the sub-chains bind the individual 

pro-collagen molecules together generating a new structure around 300 nanometers in length. 

The new tropocollagen molecule, a twisted and kinked structure, has more rigidity than the 

individual alpha chains and its wound structure grants a certain amount of ‘spring-like’ stretching 
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capability, the first emergent tensile capability found in bone that will go on to generate tissue 

scale toughness for the whole tissue.  

 
Figure 1.2: Hierachical order of bone. Bone has trancending levels of organization from the 
nanoscale up to the whole tissue level. The primary scale where bone becomes a composite 
material exists at its most basic level of organization where mineral crystals and collagen protein 
assemble to form periodic structures. Patterning of this composite material in successively higher 
levels grants bone toughness and tensile properties absent from bone mineral alone. 

 

Stepping up another level, the organic and inorganic portions of bone, collagen and 

mineral, come together to create the composite mineralized collagen fibril. On this level, individual 

tropocollagen helices are arranged in regular intervals both longitudinally and latitudinally with HA 

crystals orderly inserted with the gaps between the terminal ends of tropocollagen, or less ordered 

along the lengths of the fibrils11,12. The individual tropocollagen helices are connected to one 

another through a series of interfibrillar chemical crosslink events tightly controlled through an 

enzymatic maturation process13. These crosslinking events generate another level of tensile 

strength for bone, connecting hundreds of individual collagen helices into millimeter length 

collagen fibrils with regular spacing about 67 nanometers apart known as the collagen “d-

spacing”. Individual helices within this superstructure are able to unbind and slide against one 

another when highly stretched where mechanical energy is consumed to unbind individual helices 

from their fibrils9. Further still, these collagen fibrils are collected into yet another larger structure 

as fibril arrays or long fibers tens of millimeters in length. Superficial interaction of collagen with 
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other non-collagenous bone proteins, (bone sialoprotein, dentin matrix phosphatase-1, 

osteocalcin, etc…), may interact with one another and loosely bound positive ions such as calcium 

and magnesium through electrostatic and other weak bond interactions to generate “sacrificial 

bonds”14. These sacrificial bonds may be separated and reformed during minimal stretching and 

add another layer of tensile strength and toughness to bone. 

 Collagen fibers and fiber arrays are laid out in layers known as lamella in the next level of 

bone hierarchy. Within a single lamella, many collagen fibers run parallel next to one another 

while multiple lamella can be stacked upon one another in vary orientations, depending on bone 

type, to generate fiber patterns 3–7 μm thick.4 Common orientations for layering these fiber 

patterns include a “woven” or less ordered orientations common in immature not-yet-remodeled 

bone, and as “twisted plywood” structures as found in mature cortical, or lamellar long bone. In 

cortical, compact bone of the diaphysis, lamella encircle central points and form concentric circles 

to create bone columns called osteons around either the central marrow cavity, as seen in smaller 

mammals like mice, or around blood vessels and canals to generate what are known as haversian 

systems in larger mammals. For smaller mammals, like mice commonly used in scientific 

research, this is the final layer of order before lamella are shaped and molded into the final bone, 

as the central marrow cavity and outer periosteal cellular layers are sufficient to provide long 

bones with appropriate vascular and oxygen supply. However, for humans and other larger 

mammals that require additional vascular supply to cortical bone compartments, circular osteons 

and their internal haversian systems make up the next to last layer of order in bone.  

For us and other larger animals, impacting edges of osteons meet each other at more 

highly mineralized boarders called cement lines. Cement lines are important in larger bones as 

they create inhomogeneities within the bulk material that can help redirect and absorb energy 

during cracking. Collections of osteons come together to form the largest portions of cortical bone, 

while spongey or trabecular bone is composed of thinner lamellar sheets surrounded by marrow 

towards the metaphysis and epiphysis of long bones. The delineation between compact, cortical 
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bone, and spongey, trabecular bone is one of the largest levels of delineation in bone hierarchy 

and depends on the orientation and arrangement of its underlying lamella. As a part of this final 

layer of bone order is the overall shape of the bone. While the molecular control mechanisms that 

determine the sophisticated geometry of bones remains under study, their final shapes are tightly 

related to function as is seen in the diversity of bone shape, size, and function.2  

 

Mechanisms of Toughening 

At each level toughness and strength are drawn from the specific composition and arrangement 

of the material at that length scale and those underneath. Bone can increase its toughness and 

fracture resistance in two primary ways, through intrinsic or extrinsic toughening mechanisms. 

First, in intrinsic toughness, bone can increase the energy required to initiate  a crack by deforming 

plastically before a crack begins. Second, it can increase its use of extrinsic toughening 

mechanisms or behaviors that act behind a progressing crack to shield remaining material from 

the crack tip8,9. Unfortunately, bone mineral has little intrinsic toughness because it is primarily a 

brittle ceramic. Unlike metals and other non-brittle materials, bone mineral does not engage in 

much plastic deformation after yielding. Instead, after yielding, the stressed mineral rapidly 

fractures allowing crack progression. What little plastic deformation bone does have is derived 

from its nature as a composite material with organic components and multiple levels of structure. 

Thus, the few abilities collagen has to stretch and slide grant bone its limited plasticity. These 

include fibrillar uncoiling and sliding and sacrificial bonding, mechanisms on the scale of tens to 

hundreds of nanometers on the lower levels of hierarchy. Past this, bone can engage in extrinsic 

toughening mechanisms, or behaviors that can reduce the energy of a growing crack behind the 

advancing edge of the defect to increase its toughness post-yield. These behaviors essentially 

extend the life of the material even in the presence of a defect/crack. They include 1) constrained 

microcracking that can relieve built up strain in the material generated by the compressive edge 

of an advancing crack, 2) unbroken ligament bridging parallel to the direction of the advancing 
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crack that provides small amounts of structure within the crack, 3) collagen-fibril bridging 

perpendicular to the crack that holds material together longer in the crack wake, and 4) crack 

deflection that can redirect the crack along longer paths before ultimate fracture. Each of these 

mechanisms relies on the composite nature of bone and the specific ways that its hierarchal 

structure allows for motion to relieve or reduce internal strains. 

 As a complex material bone has many ways to resist and reduce mechanical stresses and 

strains but many of these rely on motion or damage of underlying structures. In an instance of 

sudden impact or deformation, if bone sufficiently halts the progression of a crack and prevents 

complete failure, there is still the presence of a large defect within the material. Even everyday 

wear and tear can generate microcracks or fibrillar motion known in the long term as fatigue 

damage15,16. In living bone, cellular mechanisms of remodeling, to be discussed in more detail in 

later chapters, can actively repair and reestablish structural integrity17. While not considered a 

specific method of “toughening”, these cellular behaviors greatly enhance the overall lifetime of 

bone and can even repair full fractures should they occur, thus damage that may spell the end for 

other engineered materials is able to be compensated for by biologic action within bone. 

 

Losing Bone Toughness 

Besides the generation of diffuse microdamage there are several additional possible alterations 

to the bone material that can negatively impact the toughness of bone. First and most obvious 

are deficits to bone mineral content. Prolonged lack of dietary calcium or vitamin D deficiency may 

negatively affect bone mass and can develop into disease conditions such as Rickets and 

osteomalacia where bone softens and becomes more fracture prone. Osteopenia and 

osteoporosis, clinical conditions of low bone mass, are also linked to genetic abnormalities that 

prevent the normal accrual of bone mass during growth and adolescence as well as drug affects 

and other lifestyle conditions (smoking, heavy alcohol use, lack of exercise, etc…). Previously 

healthy elderly individuals are also at risk for osteoporosis as bone resorption can outpace bone 
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deposition in aged individuals18. While it can occur through several ways, the direct loss of bone 

mineral in the skeleton reduces its strength and resistance to fracture directly impacting 

toughness.  

 Less well understood  are the changes to the organic matrix of bone upon which toughness 

is more directly related. The collagen matrix of bone requires chemical crosslinking to establish 

its levels of order that allow for fibril motion and stretching. In some genetic disorders, mutations 

within the collagen I genes, for example Osteogenesis Imperfecta (OI), prevent the normal 

formation of the collagenous matrix needed for bone growth and results in under-mineralized but 

also misshaped bones with insufficient mechanical properties19. Some forms of OI are linked to 

the inability for mutated collagen to serves as a reservoir for molecular regulators of bone, such 

as Transforming Growth Factor Beta (TGFβ), and over activity of these molecules on the cellular 

level can lead to imbalanced bone cell activity disrupting bone homeostasis and strength. These 

direct modifications or mutations within the collagen producing genes can produce collagen 

unable to provide its mechanical and biologic functions.  

Even if the collagen genes are unaffected, other genetic disorders may impact the final 

collagen matrix. As part of the collagen maturation process, procollagen molecules undergo 

several steps of enzymatic post-translational modification. In some genetic disorders, such as 

Ehlers-Danlos syndrome that results in Lysyl Hydroxylase insufficiency or malfunction, collagen 

does not progress through these maturation stages properly because the enzymes required are 

defective20,21. This prevents proper collagen cross-linking that is necessary for the matrix 

stabilization. Several other enzymes are involved in the many steps of this process and alterations 

to their activity may impact collagen, and thus bone, stability.  

Collagen is additionally prone to excessive crosslinking in non-enzymatic manners that 

can impair the flexibility of bone. These cross-links, also known as advanced glycation end-

products (AGEs), occur through the Maillard reaction where extracellular sugars spontaneously 

react with amino groups along collagen to form new molecular connections along and between 



 11 

collagen fibrils13,22. Because of their spontaneous nature and reliance on free-floating sugars, 

AGEs are particularly influential with age and diseases like Diabetes where they can accumulate 

up to as much as ten times with age than their original concentrations23. Such excessive levels of 

crosslinking have been shown to tighten collagen molecules and prevent intrinsic toughening 

mechanisms in bone such as fibrillar sliding.  

 An additional, and often overlooked, alteration to bone collagen that may affect 

mechanical properties is racemization and isomerization of the collagen molecule. Racemization 

is the spontaneous conversion of the native form of amino acids or sugars to the rare D form, the 

mirror-imaged version of the same molecule. These events are spontaneous and can cause kinks 

in the peptide backbone of collagen impacting mechanical behavior. Accumulation of D-isomers 

is common in tissues with low turnover such as dentin, the lower skin dermis, cartilage, and aged 

bone. In bone, racemization and isomerization have shown to involve the aspartic acid residue 

within the end-regions of type I collagen in the so called CTX sequence. Because of high bone 

remodeling in children, isomerized collagen is continuously cleared during bone remodeling and 

growth and high levels of this altered collagen do not accumulate. In adults, where bone 

remodeling is slower than the rate of isomerization, the equilibrium is achieved, resulting in a fairly 

constant a/b-CTX ratio from the age of 20 years and above where about only 20% of CTX peptide 

remains in its original a form and 80% is isomerized24,25. While the direct mechanical 

consequences are currently unknown, elderly individuals with high (within the top quartile) urinary 

a/b-CTX ratios had elevated risk of fracture independent of hip bone mass and bone turnover 

rate13,22. Though the direct mechanisms by which racemization and isomerization may interfere 

with bone toughness remain unknown, the association with age-related fracture and slower bone 

remodeling is of concern. Alterations to the chemical nature of collagen fibrils and their 

interactions with neighboring fibrils, either by interrupting natural maturation processes or 
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additional alterations beyond these, can negatively affect the ability for collagen to properly 

engage in toughening mechanisms. 

 Comprising anywhere from 10 to 20% of bone volume in a living system, water is a 

determinant of bone’s mechanical stability. Within bone water can be classified to one of two 

specific compartments: bond water and pore water26. Bound water is water that is structurally and 

chemically incorporated to the chemical constituents of bone or hydrostatically held near the 

hydrophilic resides of the collagen molecule (e.g., lysine, arginine, and hydroxyproline). Bound 

water contributes directly to bone toughness by conferring ductility or plasticity to bone and 

decreases with age along with fracture resistance. In rodents, the degree of mineralization within 

cortical bone increases throughout life, while bound water fraction decreases, suggesting that 

increased mineralization may displace water within the bone matrix over time. Atomic force 

microscopy (AFM) studies have shown that a small decrease in water content (from 12% by 

weight to 9% by weight of water) drastically increased the stiffness of bundles of mineralized fibrils 

and increased molecular packing of the collagen relative to the mineral phase.27,28 Notched 

bending tests on dehydrated bone samples displayed a loss of extrinsic toughening mechanisms 

specifically the inability to form fibrous bridges in the wake of the crack29. Thus dehydration of 

bone leading to a loss of bound water is detrimental in many ways to proper bone mechanics. 

Pore water is water that resides within the channels of the Haversian system as well as within the 

smaller lacunar/canalicular network in which osteocytes reside. Pore water largely doesn’t 

contribute to bone mechanics but can be involved in viscoelastic effects such as hydraulic 

stiffening where, at high strain rates, bone with high porosity and increased pore water may benefit 

from some mechanical stiffening30,31. To see large effects through hydraulic stiffening, however, 

pore volumes must be increased to 30-40% of bone volume, and this predisposes bone to several 

other structural weaknesses. Water provides many functions chemically and structurally, and 

dehydration of the bone, particularly with age, is determinantal to toughness by decreasing 

collagen flexibility and increasing overall brittleness. 
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Cellular and Molecular Regulation of Bone Material Properties 

The skeleton is susceptible to many physical and chemical changes that may alter its material 

properties, toughness, and mechanical stability.  While the nature of these changes and how their 

presence directly impacts bone material properties and fracture resistance are understood from 

an engineering and physical perspective, the sophistication of our understanding of these physical 

mechanisms dwarfs our understanding of the biological mechanisms that are responsible for 

achieving them. Because these chemical and physical alterations primarily occur on the lowest 

length scales, it is appropriate to observe the direct enactors of these events and the regulatory 

systems that manage these changes on the same length scales. Primarily, when considering 

bone matrix material properties, the focus lands on bone embedded osteocytes - the dominant 

cell type within bone32. Osteocytes reside directly within the bone matrix, represent 90 to 95 

percent of all cells in the adult skeleton, and directly regulate bone matrix material properties, and 

thus bone quality, in a number of ways. Osteocytes act to coordinate and balance the activity of 

osteoblasts and osteoclasts, the bone surface-residing cells that deposit and resorb bone 

respectively 33. Osteocytes also engage with their own local bone material through a process 

known as perilacunar/canalicular remodeling (PLR) that allows them to control local bone matrix 

properties33,34. By orchestrating the activity of the other major bone cell types and by directly 

interacting with the bone matrix themselves, osteocytes have recently become known as the 

“master regulators” of bone health and homeostasis. In PLR, osteocytes excrete several factors 

that directly engage their local bone matrix including matrix metalloproteinases (MMPs) and other 

proteolytic enzymes as well as change their local pH to resorb and reform surrounding mineral. 

PLR may be active at low levels constantly to recycle damaged or worn-out bone material or 

called upon to create dramatic change within the skeleton, such as occurs during lactation to 

release calcium from the skeleton for milk production within mammals. By interacting with bone 

material at the cellular scale and below, osteocytes play a major role in the molecular regulation 

of bone material properties.  
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 Of the many molecular and biologic regulators of bone cell behavior, Transforming Growth 

Factor Beta has multifaceted effects on the three bone cell types to regulate both bone mass and 

bone quality35,36.  Osteoblasts produce and store inactive TGFβ within the mineralized bone 

extracellular matrix (ECM) in a latent form37. TGFβ activation can be achieved through integrins 

and mechanical stimulation, or by acid catalyzation by bone resorbing osteoclasts38. TGFβ 

regulates bone mass by promoting osteoblast differentiation and migration, and promoting bone 

resorbing osteoclast survival, helping to couple formation and resorption39. In osteocytes, TGFβ 

plays important roles in the regulation of both bone mass and bone quality by coordinating 

mechanoregulated bone formation through control of sclerostin and by mediating 

perilacunar/canalicular remodeling34,40,41. Through osteocytic PLR, TGFβ regulates bone quality, 

and more specifically the material properties of bone, independently of bone mass. Loss of TGFβ 

signaling in osteocytes of mice resulted in suppressed gene expression of enzymes characteristic 

of PLR that directly engage the bone material. Bones from these mice displayed cellular defects 

through lost integrity of the osteocyte network and exhibited poor material properties and reduced 

fracture toughness34. Limiting TGFβ signaling in osteocytes disrupted PLR, an important 

homeostatic mechanism that supports material properties and toughening mechanisms, and 

resulted in losses to bone quality and bone toughness. 

 

Osteocytes, Age, and TGFβ  

As one of the direct regulators of the bone extracellular matrix and bone material properties, 

osteocyte PLR is a critical homeostatic mechanism used to renew bone quality throughout life.  

However, bone quality declines with age through numerous ways including chemical alterations 

to bone matrix that modify material properties, changes to bone shape and microstructure, and 

through accumulation of fatigue damage and microcracking. The toughening mechanisms that 

increase fracture resistance in bone rest on the function of mineralized collagen which is 

susceptible to chemical and enzymatic factors. Throughout a lifetime bone remodeling decreases 



 15 

through incompletely understood mechanisms and bone accumulates modifications through 

changes to collagen crosslinking, water content, and others.42–44 Previous studies on aged mouse 

bone demonstrate that excessive crosslinking limits the ability of collagen to deform under stress 

preventing crack bridging and lowering bone toughness43. In addition, the cessation of bone 

remodeling with age allows for the accumulation of micro-cracks in bone and lowers overall 

toughness16. The changes that occur to the bone matrix with age are related to osteocyte function 

and identify osteocytes as a possible cellular agent responsible for bone aging. The  molecular 

mechanisms behind the declines in osteocyte function however remain unexplained. 

 I found that the low bone quality phenotype of aged bone resembled that of bone with 

interruptions to osteocyte TGFβ signaling in which osteocyte PLR is suppressed (TβRIIocy-/-). 

These similarities hint at a common mechanism responsible for low bone remodeling and bone 

weakness with age. Biochemical studies on old human bone 

show declining levels of TGFβ	 ligand with age45, and my 

recent preliminary data from RNA sequencing on aged mice 

bone shows lower expression of TGFβ	and PLR related genes 

across a lifetime (Fig. 1.3). These changes coincides with a 

decrease in overall bone material quality and an increase in 

clinical fracture46. While the nanoscale material qualities and 

collagen modifications of TβRIIocy-/- mice have yet to be 

characterized, our previous studies demonstrate notable bone 

quality defects and diminished PLR in these mice. Given that 

aged bone and bones from TβRIIocy-/- mice share several 

hallmarks of poor bone quality, this work will test the 

hypothesis that declining TGFβ signaling in osteocytes with 

age leads to an arrest of osteocyte behavior and bone 

remodeling altering bone homeostasis and allowing for the 

Figure 1.3 TβRIIocy-/- and aged 
bone demonstrate hallmarks of 
PLR suppression A) RT-qPCR 
from TβRIIocy-/-   and B) RNAseq of 
aged bones show  significant 
repression of enzymes critical for 
PLR. * P<0.05, n=4-6 
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accumulation of modifications to the bone matrix which results in worsening bone quality  over a 

lifetime.   

 This work utilizes a combination of engineering and molecular biology approaches to 

demonstrate the effects of age on bone material properties and trace the molecular roots of these 

changes over time. Using a novel mouse line of disrupted TGFβ signaling in osteocytes, aged 

bone tissue and its cellular components are rigorously evaluated using a suite of sophisticated 

techniques including high resolution fluorescent confocal microscopy, robust computer modeling, 

synchrotron aided X-ray examination of bone tissue, and RNA sequencing. Combination of these 

advanced techniques allow for the assessment of the effects of aging on bone on a resolution 

and breadth not yet attempted and builds a comprehensive understanding of the cellular, 

molecular, and material roots of age-related bone fragility.  
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Chapter 2: Materials and 
Methods 
 

 

Murine studies  

Male C57BL/6 mice (WT, wild type) aged 2 months (N=3), 1 year, 2 years, and 2 ½ years (N=4), 

3 years (N=5) were received from the Buck Institute for Research on Aging. A well characterized 

line of mice with ablated TGFb receptor II in osteocytes with deficits to perilacunar/canalicular 

remodeling was used to interrogate the role of TGFb driven PLR in age-related one fragility.  In 

brief, mice possessing loxP sites flanking exon 4 of the Tgfbr2 gene on a C57BL/6 background 

were crossed with hemizygous −10kb-DMP1-Cre+/− mice1,2 in litters with approximately 50% 

DMP1-Cre+/−;TβRIIflfl (TβRIIocy−/−) mice with ablated TGFb receptor II in osteocytes and 50% 

“control”, DMP1-Cre−/−;TβRIIfl/fl littermate controls (TβRIIctrl / Ctrl) . All mice genotypes were 

confirmed by PCR genotyping. Male and female mice of these lines were allowed to age naturally 

to 4 months (16 weeks), 6 months (24 weeks), 12 months (48 weeks), and 15 months (60 weeks) 

before euthanasia and sample collection (N=7/9 per group). Over their lifetime, animals were 
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housed in groups no greater than 5 in a specific pathogen-free environment with temperature 

maintained between 68 °F and 74 °F, humidity between 30% and 70%, with a 12-h light/dark 

cycle and access ad. libitum to water and rodent chow (LabDiet 5053). All animal procedures 

were approved by the Institutional Animal Care and Use Committee of the University of California 

San Francisco and the Buck Institute for Research on Aging. 

 

RNA expression analysis 

Humeri from mice were cleaned of soft tissue, metaphysis and periosteum dissected away, and 

the marrow removed via centrifugation. Two humeri per animal were snap-frozen in liquid nitrogen 

and combined in a single tube with 1.5 mL of QIazol (Invitrogen). Tubes were stored on ice and 

each bone sample homogenized with a rotor-stator homogenizer (GLH, Omni). Lysate was then 

stored at -80 °C until RNA extraction3–5.  

 For RNA extraction, QIAzol lysate was thawed, and 220 μL chloroform per mL of lysate 

was added and mixed well via pipette. After solution began to separate (2-3 mins on benchtop), 

samples were then centrifuged for 15 minutes at 12,000 g at 4 °C, and the aqueous supernatant 

was carefully transferred to a clean tube. mRNA was purified using the miRNeasy Mini Kit 

(Qiagen), following manufacturer’s instructions. On-column DNase (Qiagen) was applied for 15 

minutes, and the RNA was eluted in 60 μL RNase-free water. RNA concentration was quantified 

with a NanoDrop spectrophotometer and the product stored at -80 °C until use.  

Raw mRNA sequence expression from a pre-selected subset of 813 genes was quantified 

from purified RNA using the nanoString6,7 Fibrosis mRNA expression panel and a custom panel 

of bone specific genes available through the UCSF Skeletal Biology and Biomechanics Core. 

Quantitative analysis was completed using nanoString nCounter analysis nSolver 4.0 and 

Advanced Analyses 2.0 available from nanoString6. This allowed for robust expression analysis 

of over 800 genes from 150 ng of RNA7. 
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RNA Sequencing for the aged wildtype mice (Buck Institute) and a group of young (8 

week) male TβRIIocy−/− mice and their control (Cre negative) littermates was completed on the 

Illumina HiSeq 4000 at the UCSF Functional Genomics Core. Single-end 50 bp RNA-seq reads 

were aligned to the Ensembl mouse GRCm38.87 reference genome using STAR 2.5.2b 

aligner8. Analysis of the aged mice bone resulted in 745 million total reads with an average of 

78.7% of these reads aligning uniquely to the mouse genome. Sequencing of the TβRIIocy−/− 

experiment yielded ~948 million reads with an average read depth of 118 million reads/sample. 

Average normalized read count for genes of interest was calculated with reference to the young 

(2 mo.) control group of either experiment. The DESeq2 package in R Statistical Computing 

Environment9 was used to find differentially expressed genes with a false discovery rate of 0.1. 

Normalized read-count comparisons for selected genes were found by normalizing to relevant 

control group average and statistically compared via Bonferroni corrected student’s T-test for 

multiple comparisons as appropriate. 

 

Silver Nitrate Staining 

Femurs were prepared for histological examination as described elsewhere3,5,10 paraffin-

embedded in 7 mm thick blocks, and axially sectioned along the diaphysis at 6-7 μm. Dehydrated 

tissue sections were stained with a Ploton silver nitrate stain11  for visualization of the osteocyte 

lacunar/canalicular network in 2D. Images were acquired using a Nikon Eclipse E800 bright-field 

microscope at 100x with an oil immersion objective.  Canalicular length was manually measured 

with ImageJ12.  

 

Confocal Fluorescent Imaging of the LCN 

Femurs for fluorescent imaging were cleaned of soft tissue, scraped of the periosteum and fixed 

in 10% neutral buffered formalin for 48 hrs at 4°C. Bones were demineralized with 0.5M EDTA 

(pH 7.5) for two weeks. Marrow was gently flushed with warm saline, bones were cryoprotected 
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in a using a sucrose gradient of 15% and 30% for 30 minutes each before being axially frozen 

embedded in OCT (Tissue-Tek®). Following protocols as described5,10,13,14, 50 μm cryosections of 

the diaphyseal femur were sectioned on a Microm HM 550 cryostat (ThermoFisher) and stained. 

Briefly, stains utilized the hydrophobic lipophilic dye, DiI (1,1'-Dioctadecyl-3,3,3',3'-

Tetramethylindocarbocyanine Perchlorate) (ThermoFisher) at 100 μM in 50% DMSO:50% 

PBS to visualize the LCN cell membrane surfaces, Alexa Fluor 488-Phalloidin (ThermoFisher) at 

165 nM to visualize the cell F-actin cytoskeleton, and DAPI at 4 μM in PBS for identification of cell 

nuclei. Bone sections were optically cleared using a 2-2-thiodiethonal (TDE, Sigma-Aldrich, St. 

Louis MO) gradient over 24 hours, mounted in TDE, sealed with a toluene free nail polish, and 

imaged immediately on a Lecia DMi8 (Leica Microsystems) inverted microscope running on LASX 

software at 100x with an oil immersion objective.  ROIs 75 μm x 75 μm x ≥35 μm were captured 

for 3 independent regions around the cortex within lamellar bone for each sample at a 500x500 

pixel resolution in the XY plane, resulting in a digital pixel resolution of 150 nm/pixel. Given the 

optical wavelength of the fluorophores used, we were practically diffraction limited to a resolution 

of ~450 nm, constraining analysis to features greater than ~3 pixels in width. Z step distance was 

set to 0.3 μm resulting in ≥119 captured planes for each ROI, which were standardized to exactly 

119 Z planes (35.7 μm depth) for all 3D analysis. Individual fluorescent channels were background 

subtracted and merged into composite 8-bit 3D images utilizing FIJI software12. The isotropic 

aspect ratio of 2x1 in the Z direction was corrected for in all 3D reconstructions in Fiji, IMARIS, 

and Materialise MIMICS for model construction.  

Selected areas for network imaging were contained to lamellar and not woven areas of 

bone containing, by eye, roughly the same numbers of osteocytes to capture as closely as 

possible similar canalicular regions. This was done to prioritize later network analysis and to limit 

computational load. Because of region selection, osteocyte volume density is not different in the 

images between the models, as is an expected and well documented effect of age13,15 Lower 

magnitude tile-scans to capture only nuclear signal across the entire bone surface were 
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completed to investigate osteocyte presence and viability in the models on a larger scale. In this 

comparison we do find a decrease in osteocyte number in aged compared to young controls, 

while we found no difference in the TβRIIocy-/- model compared to its control, in-line with previous 

results3,13. For this reason, osteocyte area density is presented instead of volume density within 

the models which has been artificially ‘selected’. It would be technically unfeasible and 

computationally prohibitive to attempt canalicular analysis as described in this report on the scale 

of whole bone cross-sectional area at this time.  

  

Image Processing and Structural Analysis 

LCN Geometry 

Quantification of canalicular tortuosity, canalicular spacing, and LCN volume fraction in 3D was 

completed using a combination of FIJI plugins, including BoneJ16 and the Simple Neurite Tracer. 

IMARIS (Oxford Instruments), made available by the UCSF Biological Imaging and Development 

Core, was used to segment and quantify the canalicular sprouting points within the first bifurcation 

and observe canalicular branching behavior in expanding concentric regions along the canaliculi 

away from the cell body.  

For canalicular spacing and LCN volume fraction, use of BoneJ16 required additional noise 

reduction for thresholding to generate binary representations of each data set suitable for use 

with these protocols. While image processing was uniform across the data sets, results for 

spacing and volume fraction are displayed as fold-change normalized to the average of the 

relevant control group to demonstrate the uniformity in distribution and magnitude of difference 

between the models. 

 

Canalicular Dendrite Segmentation and Quantification at the Sprouting Point 

Florescent Confocal image files (.LIF) from Leica DMI8 imaging are imported into Imaris v9.5.1 

(Oxford Instruments). The images are background subtracted using the Imaris Image Processing 
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sub-menu. Using the membrane dye channel as a template, an Imaris ‘surface’ object is created 

to identify the osteocyte cell bodies within the imaged region. Small features are removed with a 

size exclusion filter to prevent canalicular dendrites from being included in the cell body surface 

object. Cell bodies intersecting the image borders are removed to ensure quantification of only 

whole cells.  

A Distance Transformation operation is completed on the cell surface objects, using 

MATLAB script XTenstions attainable online*, to create a new channel encoding the radial 

distances in 3D from the surface of each cell’s unique topography.  

An ROI surrounding a single cell body is defined and a new surface including canalicular 

features is created from signal from the full image channel within the defined ROI. This surface is 

used as a mask to create a channel of canalicular features associated to the enclosed cell body 

of interest to ease quantitative/computational demand.   

Using the Imaris Colocalization tool, the Distance Transform channel and the new 

canalicular channel are overlaid and regions of canaliculi with a uniform distance in 3D from the 

surface of the cell are identified.  

To identify the canalicular sprouting points, the distance along canalicular regions from 

the cellular surface is set to the minimum to ensure all identified features are within the region 

between the cell body surface and where the points where individual canaliculi begin to bifurcate. 

In order to prevent undercounting from merging of signal from adjacent canaliculi, signal from the 

areas within the cellular surface object is removed from individual cell signal channels. This allows 

for the distance at which canalicular signal is captured to be constricted to the immediate location 

of canalicular sprouting along the cellular surface. The portions of signal are saved into another 

image channel for reconstructions and quantification. 

 
* https://imaris.oxinst.com/learning/view/article/distance-transformation  
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The new “sprouts” channel is visualized in 3D with the cell body surface model to ensure 

features have been captured in all dimensions. The signal from the canalicular ‘sprouts’ is 

rendered as another new surface in 3D, size gated to remove collections of small pixels and larger 

features not belonging to canalicular sprouts, and the number of independent, non-connected 

sprouts is recorded as the individual number of canaliculi sprouting from singly analyzed 

osteocytes. 

 

Connectomic Network Analysis 

Connectomic Network Analysis of the LCN was accomplished on skeletonized representative 

maps of binarized, 8-bit confocal stacks of the LCN (N=5 per group) as described in 

Kollmannsberger et al17. Connectomic measurements were completed utilizing the MATLAB 

(Mathworks) scripts provided from the Kollmannsberger et al github*. Updated scripts with custom 

MEX files and C+ wrappers  were used to run scripts.† 

Connectomic analysis via the MATLAB package from Kollmannsberger et al17 is sensitive 

to noise in the images, thus individual image stacks were prepared manually using ImageJ to 

assemble a comparable and uniform data set for automated analysis. N=5 image stack ROIs (100 

planes at a total Z depth of 30 μM) per group were manually selected for analysis to maintain 

uniform analysis volume and to avoid large aberrations or structures (e.g. blood vessels). 

MATLAB v2019a, equipped with the Boost Graph Library for MATLAB by Gleich (2008)‡  was 

used and ran in parallel on an iMac Pro (2017) running macOS Mojave with a 3 GHz Intel Xeon 

W processor and 128 GB RAM. Automated parallel processing took 3 hours (20 ROIs total) while 

individual ROIs could run in 15-20 minutes. 

 

 
* https://github.com/phi-max/OCY_connectomics 
† https://github.com/cschurm/ocy_connectomics_updated  
‡ https://www.mathworks.com/matlabcentral/fileexchange/10922-matlabbgl?s_tid=prof_contriblnk  
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Connectomic Analysis Parameters 

Node type 

T-nodes are defined as nodes with n=3 (number of nearest neighbors) and a clustering coefficient 

(cc), or a measure of the interconnectedness of a node’s neighbors to each other. This type of 

node has the minimal number of connections required to participate in network connections and 

is a feature of branching, linear networks. C-nodes, or cluster nodes, are defined as nodes with 

high clustering coefficients (cc>0.5) that have high neighbor connectivity and create web-like 

networks. These nodes are often found in networks with high connectivity and low long-range 

order. End point nodes have a node degree of 1 and represent the ends of canalicular dendrites 

that terminate within the matrix without reconnecting to the network. These locations mark 

discontinuities within the network and non-functional path choices through the network. By 

definition no node has a degree of 2. Other types of nodes, behaviors, and classifications exist, 

the most abundant of multiple node types present in the LCN are presented here. A large 

proportion of nodes on the image borders were removed from analysis because their inclusion 

would artificially inflate the end-point values. 

 

Betweenness Centrality 

Betweenness Centrality (BC) was used to evaluate pathways between cells within the 

connectomes and is defined as the fraction of shortest paths within a network running through 

any particular node where high BC scoring nodes align near each other to present commonly 

used paths within connectomes. For visualization and comparison, we have set an arbitrary cut-

off at a BC of 0.01, or nodes that appear in at least 1% of paths within the connectome17,18.  

 

Diffusion Speed Gain 

A non-dimensional gain in diffusive speed Gnet, based on measured network values provided by 

the connectomics package was calculated and compared across a range of diffusion ratios, K. 
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These network values correspond to the average distance from a matrix voxel to the closest 

portion of the entire LCN (canalicular dendrite or cell body), dLC, the average distance from a 

matrix voxel to the nearest cell lacunae, dL, and the distance of any point within the canalicular 

network to nearest cell, dnet. To represent the difference in diffusive speed of a small molecule 

within the LCN (vnetwork) versus the mineralized matrix (vmatrix), the ratio k (vnetwork/vmatrix) was allowed 

to vary across a range of magnitudes including the regime estimated by Kollmannsberger et al 

and others to be the difference in diffusion coefficients within the two compartments of the bone 

matrix. The ratio of the combined distances dLC and dnet over the same combination but with  dnet 

“shortened” by the differences in diffusion speed, K, resolves as the speed gain term  Gnet which 

evaluates the enhancement of diffusion utilizing the network over simple diffusion through the 

matrix towards the nearest cell. 

 

FE Model Generation 

Materialise MIMICS image processing software was employed to generate a three-dimensional 

model of the osteocytes from fluorescent confocal image stacks. Confocal image stacks of 20 

(N=5 per group) osteocytes were imported into MIMICS and thresholded to allow segmentation 

of the osteocytes. Individual osteocytes were selected from deep within the bone tissue by 

selecting an approximately 25 x 25 x 25 µm region of interest around a single DAPI nuclear signal. 

To prevent loss of information during segmentation or inclusion of confounding local features, a 

minimum distance of 10 µm from the edge of the field of view and from large local landmarks (e.g. 

blood vessels) was ensured. Models were then meshed using 3-Matic voxel-meshing software 

(Materialise, Leuven, Belgium) as described previously19. Models were dimensionally constrained 

so that no feature was thinner than the effective optical ‘diffraction limit’ of the used fluorophores 

(3 pixels / ~450 nm) at any location. At sites where the dendritic dimensions are greater than ~450 

nm in diameter, these measured dimensions were used in the mesh. Dimensions of the 
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pericellular fluid space (PCS), based on previous experimental measurements20–22, were used to 

model the interstitial fluid flow. This uniform 0.08 µm PCS offset was applied to the osteocyte 

mesh surface followed by a Boolean subtraction to remove the osteocyte volume. This offset was 

reduced and multiplied by a factor of two to create the constricted (0.04 µm ) and expanded (0.16 

µm) PCS models around the same base cellular geometry. Geometries were meshed using 4-

noded tetrahedral elements and exported to COMSOL Multiphysics computational modelling 

software (Burlington, MA, USA). Similar methods were used to mesh and model three individual 

canalicular channels at different values of tortuosity across the range found within analyzed 

networks.  

 

Computational Fluid Dynamics 

The properties of the interstitial fluid were assumed to be similar to salt water, with a density of 

997 kgm-3 and a dynamic viscosity of 0.000855 kgm-1s-1 23,24. Flow within the lacunar-canalicular 

system was assumed to be laminar in nature. A pressure gradient was applied across the models 

to represent organ-level mechanical loading that generates regions of compression and tension 

driving fluid across the LCN24–26. An inlet pressure of 300 Pa was assigned to the inlets on one 

face and the remaining inlets were defined as outlets at a relative pressure of 0 Pa25,26 similar to 

the pressure gradient applied by Anderson et al.24 Models with altered volumes of PCS resulted 

in altered flow rates under these consistently applied boundary assumptions. Interstitial fluid 

velocity and shear stress were recorded as the 95th percentile values. 

 

Skeletal Phenotyping 

In order to maximize outcomes from a single bone, selected bones were utilized for both skeletal 

phenotyping and mechanical testing. To accommodate this, unfixed femoral midshafts were 

scanned using a Scanco μCT50 specimen scanner (Scanco Medical, Wangen-Brüttisellen, 
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Switzerland) with an X-ray potential of 55 kVp, current of 109 μA, and voxel size of 10 μm. Each 

scan took 35 minutes to complete during which time samples were submerged in HBSS at room 

temperature to preserve mechanical integrity. Immediately after scans, samples were placed on 

ice  and within two hours of scanning, midshafts were removed from HBSS, allowed to reach 

room temperature, and mechanically tested (see following). After 3-point bend mechanical testing, 

distal femur halves containing femoral condyles were scanned again for trabecular bone. Cortical 

analysis was conducted in a 1-mm region equidistant from the proximal and distal ends of the 

bone, using the femoral condyles and the trochanter as major landmarks, while trabecular 

segmentation and analysis was performed in a 1-mm region below the growth plate. Samples 

displaying damage near the growth plates from the mechanical tests were excluded from 

trabecular analysis, this accounted for only about 3% of samples being removed from this 

outcome. 3D measurements of cortical and trabecular parameters were obtained using Scanco 

analysis methods as described27. Cortical porosity measurements were achieved through manual  

segmentation of Scanco generated DICOM files utilizing Dragonfly (Object Research Systems, 

Montreal, Canada.) Briefly, numeric volumes as determined by Dragonfly of hand segmented 

cortical shells with pores identified were divided by the total volume of the cortical bone from 

endosteal to periosteal edges including pore volume to achieve “percent cortical porosity” for each 

sample. Segmentation was aided by Dragonfly’s hole filling tool as part of its bone analysis tool 

box. 

 

Mechanical Testing 

Within two hours of CT scanning, whole hydrated femurs were loaded to failure in three-point 

bending in the direction of primary physiological bending (posterior compression) using a Bose 

Electroforce 3200 test frame with an 8-mm span at a fixed displacement rate of 10 μm/s. Structural 

parameters were extracted from load-displacement curves using a custom MATLAB script and 

material properties were acquired by transforming specific structural properties by their individual 
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parameters from μCT as described28. Following testing, fracture surface cross-sections were 

imaged by scanning electron microscopy on a Sigma 500 VP FE-SEM (Zeiss) at an excitation 

voltage of 15 kV and a partial pressure of 35 Pa. Measurements of 

endosteal and periosteal cross-sectional diameter and thickness 

were measured with ImageJ and used to calculate moment of inertia 

assuming an elliptical cross-section and used to verify results from 

μCT MOI calculations. 

 

Synchrotron in situ Tensile testing 

Collagen fibril and hydroxy appetite mineral crystal strains were 

recorded during uniaxial tension testing of isolated, hydrated ulnae 

using synchrotron small-angle X-ray scattering (SAXS) and wide-

angle X-ray diffraction (WAXD) at beamline 7.3.3 at the Advanced 

Light Source (LBNL, Berkeley, CA)29. This strategy permits 

simultaneous, real-time measurement of specific strains in the 

composite materials as compared to bulk tissues as captured by 

CCD camera and measured with a custom Digital Image Correlation 

(DIC) MATLAB package. A two-part dental bonding adhesive 

(OptiBond, Kerr Corporation, Orange, CA) and resin (Aeliteflo, Bisco 

Dental, Schaumburg, IL) were each cured for 20 seconds on each 

end of the bone with blue light within a 3D printed “dumbbell” mold 

(Fig. 2.1) to create regions for clamping without harming the 

diaphysis exposed to the X-ray beam. In situ tensile tests were 

performed using a TST350 Tensile Testing Stage (Linkam Scientific 

Inc.) on hydrated samples at a displacement rate of 2.5 μm/s. Small 

(2x4mm) sandpaper strips were superglued to the surface of the 

Figure 2.1: Sample preparation 
for tensile testing. A) 3D 
printed mold for creating 
“dumbbell” ends for mechanical 
tensile tests. Inset  groove on top 
is a half cylinder in which mouse 
ulnas are placed in during 
embedding. B) Mouse ulna with 
the fully cured composite caps 
(above) and with only the cured 
bonding adhesive (below) 
showing the 2-step embedding 
process and how the majority of 
the diaphysis remains bare for 
X-ray exposure during testing. 
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stage clamps to increase friction on the dental composite. During testing, bones were exposed to 

the synchrotron generated X-ray beam of 10 keV for 0.1 s every 5 s until failure or until total 

radiation dose reached 30 kGy to mitigate exposure effects on the material performance of the 

bone30. The changes in collagen d-spacing and mineral crystal lattice spacing from the unloaded 

condition, as seen as a shift in the location of the Bragg scattering peak from SAXS pattern and 

the Bragg diffraction peak in the WAXD pattern, were used to calculate collagen and mineral 

associated strains, respectively. Reductions from 2D scattering/diffraction patterns and extraction 

of parameters from resulting curves were completed via a custom LabVIEW program. 

 

Immunohistochemical and Immunofluorescence Imaging 

Proximal femur halves containing the femoral condyle were cleaned of muscle and periosteum 

and fixed for 48 hours in 10% Neutral Buffered Formalin (NBF) and then incubated for 

decalcification in 0.5M disodium and tetrasodium EDTA at neutral pH for 2 weeks at 4 degrees 

C. Following decal, epiphyses are removed, marrow flushed with warm saline, and prepared for 

cryosectioning as described above and else where10,13,31. For imaging of large sections (~35 μm) 

of the osteocyte network, femurs were axially sectioned at 50 μm and stained using the lipophilic 

DiI and actin specific AlexaFlor 488 (Invitrogen) for labeling of osteocyte membranes and 

cytoskeleton, respectively. Histologic and immunofluorescence assays were completed on 8-10 

μm sections. Fluorescent confocal imaging was completed using a Lecia DMi8 (Leica 

Microsystems) inverted confocal microscope at 100x running LAS X software, while brightfield 

imaging was completed with a Nikon Eclipse E800 microscope.  

 

Biochemical Analysis 

AGEs 

Decalcified, mid-diaphyseal femurs were hydrolyzed in HCl (24 hours, 110°C) and fluorescence 

of neutralized lysates (excitation 370 nm, emission 440 nm) were referenced to a quinine sulfate 
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standard and then normalized to the collagen content calculated from the amount of 

hydroxyproline, as measured by a colorimetric assay with absorbance at 560nm, for quantification 

of Advanced Glycation End-products (AGEs) within bone as described31,32.  

 

TGFβ ELISA 

Protein from bone lysates was harvested as previously described33. Briefly, for collection of bone-

specific protein lysates, distal tibia halves were centrifuged to remove marrow and stripped of 

periosteum and connective tissue before being snap frozen in liquid nitrogen. Frozen bones were 

transferred to chilled pre-filled Bead Mill Tubes (ThermoFischer Scientific, Waltham, MA) 

containing radioimmunoprecipitation buffer [RIPA - 10mMTris, pH8, 1mM EDTA, 1mM EGTA, 140 

mM sodium chloride, 1% sodium pyrophosphate, 100mM sodium fluoride, 500μM PMSF, 5mg/mL 

eComplete Mini protease inhibitor tablet (Roche, Basil Switzerland)]. Samples were disrupted 

using a benchtop bead mill homogenizer (Omni International, Kennesaw, GA) at 4°C. Resulting 

lysates were briefly centrifuged to collect supernatants that were then sonicated for 8 times 

(15s/45s rest) in an ice-cold water bath. Serum was collected from blood as described [Dole JBMR 

2020]. Raw protein concentration from both bone lysate and serum aliquots was quantified using 

the Pierce Coomassie (Bradford) Assay Kit (ThermoFischer Scientific, Waltham, MA). Samples 

were hydrolyzed in 1N HCL at a 1:5 dilution for 10 minutes at room temperature before being 

neutralized with the same volume of 1.2 N NaOH/0.5M HEPES buffer. Total levels of TGFβ Ligand 

were quantified from neutralized samples using the Bio-Plex Pro TGF-β Assay Kit (Bio-Rad, 

Hercules, CA) on a Bio-Plex 200 (Bio-Rad, Hercules, CA) made available by the UCSF Parnassus 

Flow Cytometry Core. TGFβ ligand levels were normalized to each samples’ original total protein 

concentration from the Bradford assay. 
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Statistical Analysis and Comparison 

Ch.4 - Disrupted Osteocyte Connectivity and Pericellular Fluid Flow in Bone with Aging and 

Defective TGFb Signaling 

To establish comparable relationships between the control (2 mo. WT, TbRIIctrl) and degenerated 

(36 mo. WT, TbRIIocy-/-) models, a 2-way ANOVA with multiple post-hoc Tukey-corrected 

comparisons was completed on canalicular length results from silver nitrate staining. A small 

interaction term between the effects of background (pure or mixed BL/6) and LCN degeneration 

(age or TGFb signaling disruption) existed accounting for 8.59% of the differences found within 

the ANOVA on canalicular length; however, evaluation of the effect of background alone (pure or 

mixed C57BL/6) was found to be non-significant (p=0.6907). In post-hoc comparisons, pairwise 

comparison between the control groups (2 mo. WT & TbRIIctrl) were non-significant (p=0.2692) as 

were comparisons between the degenerated models (36 mo. WT & TbRIIocy-/-) (p=0.5083). The 

four remaining pairwise comparisons between each degenerated model to either control were 

highly significant (p<0.01), such that young TbRIIocy-/- bone was independently statistically 

different from both sets of control groups from each mouse line, while the aged WT bone was 

also independently statistically different from both sets of controls.   The robust number of 

independent comparisons that followed the same statistical relationships between controls and 

the aged WT and young TbRIIocy-/- bone imply that, on the 2D canalicular level, these two models 

of LCN network degeneration are statistically indistinguishable. However, since the effects of age 

are a combination of multiple processes declining simultaneously, it would be improper to 

implicate TGFb in all further comparisons to such detail. All following statistical comparisons are 

made between each degenerated model and their proper control (2 mo. WT vs 36 mo. WT, 

TbRIIctrl vs TbRIIocy-/-) utilizing a two-sided student’s t-test with a defined alpha level of 0.05 

(indicated by * on figures). Prism 8.4 (GraphPad Software Inc.) was used for all statistical 

comparisons. Unless otherwise stated, data is presented as mean ± SD. 
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Ch.5 - The Role of TGFβ-regulated Osteocytic Perilacunar/canalicular Remodeling in Age-related 

Bone Fragility 

Prism v.9 (Graph-pad, San Diego, CA) was used for all statistical comparisons except for ELISA 

results. For Prism analyses, a 2-way ANOVA was performed with factors of age and genotype 

with an alpha level of 0.05. While sex differences are noted throughout, they were not statistically 

compared due to their difference in biologic mechanism and each sex was run in independent 

ANOVA comparisons. Within each ANOVA, age had up to three independent levels (4, 12 and 15 

months depending on ages included) and genotype had 2 (Ctrl, TβRIIocy-/-). A priori planned 

pairwise post-hoc comparisons were completed with the Fisher’s Least Significance Difference 

Test that does not correct p-value for multiple comparisons, and instead the significant level 

(alpha = 0.05) was Bonferroni corrected for the number of comparisons being made (alpha = 

0.05/7 = 0.007). In a planned manner, not all possible pairwise comparisons are scientifically 

meaningful and power was not sacrificed for excessive comparisons. In Post-Hoc analysis for 

factors that violated the Fisher’s LSD assumption that all groups are sampled from populations 

with the same standard deviation, standard Student’s T-tests were completed for post-hoc 

assessment of significance.  For ELISA analysis with additional group complexity (factors 

including age, sex, genotype, tissue source, and ligand sub-type), full ensemble results were first 

analyzed with univariable and multilevel linear mixed models of the log of concentration to identify 

which factors (coefficients) most strongly predicted ligand concentration. Afterward, pairwise 

comparisons were completed with the non-parametric Wilcoxon signed-rank test with significant 

alpha values Bonferroni-corrected for the specific comparisons being completed in each pairwise 

comparison. Synchrotron tissue vs material strain regressions were completed with a linear least 

squares method to generate linear slopes for statistical comparisons via an extra sum-of-squares 

F test that compares independent fits of a pair of regressions with a global fit. Regressions were 

considered statistically different if the p-value for the comparison of slopes of independent 
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regressions to the global fit was below alpha=0.05/8=0.00625 for an 8-way Bonferroni correction. 

8 corrections were determined for the multi-comparisons of the four groups (young control, aged 

control, young TβRIIocy-/- and aged TβRIIocy-/-) in two ways: either genotype matched comparisons 

at the same age or within genotype comparisons across age group.   
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Chapter 3: Considerations 
for Studying 
Perilacunar/Canalicular 
Remodeling  
& Assorted Protocols 
 
This chapter has been adapted with permission from “Yee, C. S., Schurman, C. A., White, C. R. 
& Alliston, T . “Investigating Osteocytic Perilacunar/Canalicular Remodeling.” Curr Osteoporos 
Rep (2019) and “Dole, N. S., Yee, C. S., Schurman, C. A., Dallas, S. L. & Alliston, T. “Assessment 
of Osteocytes: Techniques for Studying Morphological and Molecular Changes Associated with 
Perilacunar/Canalicular Remodeling of the Bone Matrix.” Methods Mol Biol (2021).1,2 

 
I - INTRODUCTION  

Osteocytes are one of the most abundant, dynamic, and metabolically active cell types in bone3,4. 

These morphologically distinct cells originate from terminally differentiated osteoblasts that are 

entrapped within the bone matrix 3,4. One of the unique characteristics of osteocytes is their 

formation of a highly organized network within a mineralized matrix5. Osteocytes appear as 

stellate-shaped bodies that extend their long cytoplasmic dendrites into the mineralized bone 

through narrow canals called canaliculi connecting to other osteocyte dendrites via gap junctions, 

as well as with bone lining osteoblasts and osteoclasts, and vasculature, to form the 
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lacunocanalicular network (LCN).6 The intricate LCN of osteocytes is estimated to span 215m2 of 

total bone area, which is much larger than the combined surface areas of the lung, gastrointestinal 

tract, and skin5.  Fluid flow through the perilacunar and canalicular spaces, sensed as a 

mechanical signal by osteocytes, supports osteocyte cellular functions3,4,7,8. Osteocytes, in turn, 

respond to chemical, biological, and physical cues carried by this fluid with changes in cellular 

behavior. These changes include secretion of osteoclast and osteoblast regulating molecules9–11. 

Thus, an impairment in the integrity of the LCN can affect the metabolic and signaling functions 

of osteocytes, as well as their mechanosensitivity, which can compromise bone health and 

increase fracture susceptibility12,13.   

Until recently, the multifaceted role of osteocytes in bone mechanotransduction, bone 

remodeling, and mineral homeostasis was largely thought to occur indirectly through osteocyte 

regulation of osteoclast and osteoblast function. Apart from these indirect mechanisms, 

osteocytes also maintain mineral homeostasis directly by remodeling the bone matrix surrounding 

their lacunar and canalicular spaces through the process known as perilacunar/canalicular 

remodeling (PLR).14,15  In PLR, osteocytes resorb the organic and mineral components of 

perilacunar and pericanalicular ECM through a combination of matrix metalloproteases (MMPs), 

ATPase proton pumps, and other enzymes, such as cathepsin K and carbonic anhydrases16,17.  

Originally termed as ‘osteocyte osteolysis’, the concept of PLR emerged from the 

hypothesis that the surface area of the LCN is much larger than the surface area available for 

remodeling by osteoblasts and osteoclasts14,18,19. Thus, in response to a systemic imbalance in 

mineral metabolism, engaging osteocytes is far more efficient for removing small amounts of 

mineral across the enormous LCN area20. With this theory, research from the 1900s demonstrated 

that osteocytic PLR is elicited during metabolic stress to release calcium from the bone surface 

to increase its bioavailability in order to restore systemic mineral homeostasis16,18,21.  These early 

observations of PLR were almost entirely from morphologic analyses. Light and electron 

microscopy first revealed this phenomenon through enlarged lacunae and rough borders around 



 45 

osteocytes in bone infection, rickets, or osteomalacia18,22–24. Visualization of perilacunar and 

pericanalicular fluorochrome labels in bone from parathyroid hormone (PTH) treated rats25 

provided early functional evidence for the formation of new mineralized tissue by osteocytes26. 

Morphological evidence in bone from numerous species, including humans, snakes, egg-laying 

hens, rodents, and hibernating bats and ground squirrels4,15,21,27, highlights the extensive 

conservation of osteocyte PLR, especially in the context of metabolic stress. 

The osteocyte resorption machinery is not as clearly defined as it is in osteoclasts.  Except 

for some functional aspects, the structural features of osteocytes that mediate this process remain 

elusive. Current paradigms in the field suggests that acidifying factors (such as vacuolar H+ 

ATPase and carbonic anhydrases) and proteolytic enzymes (such as cathepsin K, tartrate 

resistant acid phosphatases and matrix metalloproteinases) are secreted within the perilacunar 

and pericanalicular spaces to resorb both the inorganic (crystalline hydroxyapatite) and the 

organic (mainly collagen) components of bone matrix16,28–32.  In healthy bone, the catabolic activity 

of osteocytes in resorbing LCN bone matrix is balanced by their anabolic activities. Following a 

phase of resorption, osteocytes replace the bone matrix by upregulating their expression of genes 

implicated in mineralization, namely Phex, Ank, Dmp1 and Phospho133.  

The shift between the catabolic and anabolic phases of PLR appears to be highly dynamic 

and governed by external stimuli ranging from mechanical to metabolic fluctuations. In lactation, 

one of the most well-studied examples of PLR in response to metabolic demand, osteocytes 

exhibit a dramatic increase in lacunar size and canalicular diameter to increase LCN resorptive 

capacity and meet calcium demand. Upon weaning the osteocyte LCN features return to 

normal16,34. However, in less metabolically demanding situations, PLR appears to be crucial in 

actively ‘rejuvenating’ the mineralized collagen bone matrix and in maintaining bone quality.  

Indeed, suppression of PLR causes bone fragility, even without a loss of bone mass, showing 

that PLR is a critical cellular mechanism controlling bone quality.  In this way, osteoblasts and 

osteoclasts remodel the external bone surfaces to control bone mass; whereas, osteocytes 
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remodel the LCN surface to control bone quality to achieve mechanical homeostasis.  Thus, it is 

not surprising that the key regulators of osteoblast and osteoclast function, including vitamin D, 

parathyroid hormone (PTH) and parathyroid hormone-related peptide (PTHrP), Sclerostin 

(SOST), and transforming growth factor (TGFβ), also regulate PLR16,30,35–37.  Given the 

importance of PLR in supporting mineral metabolism and mechanical homeostasis of bone, 

researchers need more tools to better understand the mechanisms controlling PLR and how it is 

disrupted in disease. 

 
II - Motivation to Investigate PLR 

Several lines of evidence motivate incorporation of PLR outcomes as a standard part of skeletal 

analyses. First, PLR participates in the crosstalk among osteocytes, osteoblasts, and osteoclasts. 

Many of the same stimuli already known to regulate osteoclast and osteoblast function also 

regulate PLR, including glucocorticoids38–41, vitamin D35,42, ovariectomy43–47, PTH15,30,48 and 

calcium or phosphate deficiency16,26,33, and other mechanisms discussed elsewhere in this work. 

In addition, PLR may be mechanosensitive. Sclerostin and TGFβ, both of which are required for 

the anabolic response of bone to mechanical load, stimulate PLR36,37,49,50. Mice exposed to 

microgravity may remodel the ECM in a mechanosensitive, MMP10-dependent manner51. 

However, in mice with immobilized hind limbs, lacunar properties (size, shape, orientation) are 

not altered, despite the corresponding decrease in bone volume and load to fracture16,52,53. Careful 

investigation utilizing a range of PLR outcomes may help to unravel these apparently 

contradictory findings. 

Second, the study of PLR will elucidate mechanisms controlling metabolic and mechanical 

homeostasis in the skeleton. Osteocytes utilize PLR to respond to metabolic stress. The lactation 

model is currently used as a gold standard model to study PLR, since osteocytes stimulate local 

mineral resorption to meet the calcium demands of milk production16,34. PLR occurs in both male 

and female mouse bone9, though the sex-dependent mechanisms that control baseline PLR 
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remain to be defined54. PLR also plays a critical role in maintaining the material quality of the bone 

matrix, in part by controlling ECM mineralization and collagen organization55,56. Though much is 

known about the biological control of bone mass, many questions remain about the mechanisms 

that control this important aspect of bone quality and the ability of bone to resist fracture.  

Third, understanding PLR may elucidate new mechanisms of musculoskeletal disease. 

As with any essential homeostatic process, deregulation of PLR is a product as well as a driver 

of degenerative disease processes. As for remodeling by osteoblasts and osteoclasts, too much 

or too little remodeling by osteocytes can be problematic (Fig. 3.1). PLR is induced in rickets and 

osteomalacia33,35, but suppressed in aging57,58. Relative to young bone, bone from aging humans 

and mice has many hallmarks of suppressed osteocyte PLR, including decreased lacunar volume, 

a diminished LCN, hypermineralization, and increased bone fragility57–59. This bone fragility is not 

fully explained by a loss of bone mass and is attributed in part to impaired bone extracellular 

matrix material properties. Mounting evidence implicates an age-dependent defect in osteocyte 

PLR, which may in turn further impact the regulation of osteoblast and osteoclast function57,60–63 . 
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 While the extent to which PLR is a driver or a side effect of age-related bone fragility is yet 

unclear, PLR suppression may play a causal role in many diseases of bone and bone quality. For 

example, in glucocorticoid-induced osteonecrosis, even prior to other symptoms, glucocorticoid 

treatment suppresses PLR with disruption of the LCN, collagen organization, and matrix 

mineralization40. These changes in mice parallel those in subchondral bone from patients with 

end stage glucocorticoid-induced osteonecrosis of the femoral head64. Given a role for PLR in 

disease and aging, an improved understanding of PLR may also lead to the identification of new 

cellular targets for musculoskeletal therapeutics.  

Figure 3.1: Homeostatic control of bone mass and quality by osteoblasts, osteoclasts, and 
osteocytes. During homeostasis (green region), optimal cellular activity of osteoblasts and 
osteoclasts maintains bone resistance to fracture. Unopposed changes in osteoblast or osteoclast 
function lead to changes in bone mass that can cause bone fragility (red regions). Osteocyte PLR 
also contributes to the mechanical homeostasis of bone. As for osteoblasts and osteoclasts, the 
effect of osteocyte PLR on bone quality is non-linear. Too much or too little osteocytic PLR can 
compromise bone quality. 
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Although review of these pioneering studies clearly implicates PLR in skeletal 

homeostasis and disease, initial interest in PLR was supplanted by the idea that osteoclasts were 

the primary bone resorbing cell type15. Coincidently, during the time in which PLR was largely 

overlooked, osteoclast and osteoblast biology advanced tremendously through the use of 

genetically modified mouse models and other molecular and cellular approaches, leaving our 

knowledge of osteocyte PLR far behind. As these models are now being employed to investigate 

the role and regulation of PLR, questions arise about the best PLR outcome measures and 

techniques used to evaluate them. Traditional morphological approaches alone are insufficient to 

probe the complex biological mechanisms involved in this process. Several new PLR outcomes 

have been described, but which of these are most useful to rigorously and efficiently evaluate 

PLR remains unclear.  

 

III - Critical Considerations for the Study of PLR 

Although aspects of PLR are apparent throughout the skeleton, the LCN varies among species, 

anatomical sites, and bone types. For example, the LCN appears vastly different when comparing 

the sparse canaliculi in elderly human trabecular bone to the robust network of canaliculi in young 

mouse cortical bone (Fig.3.2A, 3.2F). In addition to age, several other biological factors influence 

the appearance of the LCN, an important yardstick for generalized osteocyte health and activity. 

Cortical bones in humans, as well as other large mammals, are composed of Haversian systems, 

or osteons. Osteocytes within osteons arrange themselves in rings around the central vascular 

canal, with their canaliculi often perpendicular to the rings. Smaller rodents, in contrast, do not 

have Haversian systems and their long bones resemble a single large osteon around the marrow 

cavity65, often with internal rings of slightly less organized lamella and osteocyte canaliculi66. The 

effect of structural differences in bone organization on the LCN are likewise apparent in trabecular 

bone, where the diminished lamellar organization corresponds to less aligned canaliculi (Fig. 3.2C 

3.2F). Accordingly, the LCN is less aligned in the mouse mandible, which is dominated by 
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trabecular bone, relative to cortical bone of the mouse femur38, where osteocytes are spatially 

aligned perpendicular to the lamellar plane38 (Fig. 3.2E 3.2F). Even within one bone, proximal to 

distal and medial to lateral variations in the LCN are apparent. Therefore, care must be taken to 

consistently analyze LCN parameters at the same region of interest in each bone. 

 

 

Figure 3.2: Diversity in the histological appearance of the lacunocanalicular network (LCN) 
across species and bones. Differences in the LCN are apparent in silver nitrate stained sections 
of human (A), rabbit (B), and mouse (C) trabecular bone. LCN variation also appears among 
bones, as shown from mouse cortical bone of the cochlea (D), mandible (E), and femur (F). Scale 
bar, 20 µm. 

 
Among the factors that contribute to these anatomic differences in the LCN are site-

specific expression and activity of the enzymes required for PLR. For example, MMP2 expression 

varies across the skeleton, with high levels in the calvaria and low levels in the long bones29. This 

expression pattern likely explains the observation that MMP2-deficient mice have dramatic 
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alterations of the LCN in calvaria compared to moderate disruption of the LCN in long bones. 

Likewise, the LCN, collagen organization, and bone matrix mineralization were most affected in 

mid-cortical bone of MMP13-deficient mice, which was the site of highest MMP13 expression29. 

Similar differences in PLR enzyme expression may contribute to hypermineralization in the 

endocortical region compared to periosteal region of aging cortical bone58. Post-translational 

control of PLR enzymes may also determine where and how PLR is regulated, since cochlear 

bone expresses high levels of MMP13 protein, but the hearing and cochlear bone of MMP13-

deficient mice was normal67. This observation is consistent with the presence of unique 

mechanisms to control bone remodeling by osteoblasts and osteoclasts in the cochlea. 

Undoubtedly, a sophisticated network of transcriptional and post-transcriptional mechanisms 

control bone remodeling by osteocytes, as it does for osteoblasts and osteoclasts.  

Variations in the LCN and PLR within and between bones highlight the heterogeneity of 

the osteocyte population. Though the sources and the reasons for this heterogeneity remain 

largely unknown, intriguing possibilities include differences in the embryonic origin, exposure to 

physical stimuli, metabolic supply/demand, innervation, and others. For example, elongated 

lacunae are observed in cortical bones, such as the tibia, that undergo loading during 

locomotion68,69, compared to calvaria70. This suggests that loading and lacunar shape may share 

a functional relationship, which potentially contributes to the LCN differences along the cortical 

regions of long bones66. Mechanistic studies are needed to establish the causality of these and 

other observations. Meanwhile, these observations have important practical implications for the 

study of PLR. Attention to species-specific and anatomically distinct differences in bone must be 

considered when studying PLR, especially when extrapolating findings from rodent models to 

understand human clinical conditions.  

A number of mechanistic questions about the regulation of PLR further complicate our 

understanding of this process. Most work focuses on the resorption of perilacunar and 

pericanalicular bone, while much less is known about the deposition of new ECM. In some cases, 
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the induction or repression of PLR enzymes corresponds to changes in lacunar size or shape; 

whereas in others, lacunar size is unchanged, but canalicular networks are altered. The 

mechanisms that determine when, where, and how proteolysis or acidification exert their effects 

in the mineral and/or organic phases of the osteocyte microenvironment remain unclear. While 

these processes initially appeared to be coupled, more recent studies suggest that perilacunar 

remodeling is distinct from pericanalicular remodeling16,37.  

Furthermore, the approaches used to study PLR may impact the interpretation of the 

results. If distinct mechanisms control the resorption of the mineral and organic components of 

the bone matrix, then the appearance of the LCN may differ depending on whether the outcome 

is performed on mineralized bone (i.e. quantitative backscatter electron imaging) or demineralized 

bone (i.e. histological staining of the LCN). Efforts of the scientific community to elucidate the role 

of PLR in bone homeostasis, and how PLR is regulated normally and pathologically will require 

attention to the sensitivities of the methods used, as well as to the diverse regulation of PLR 

throughout the skeleton, across species, and with age. The following discussion considers these 

issues in light of a number of currently used methods used to observe and study PLR and in some 

cases protocols used by the Alliston Laboratory are explicitly outlined. It is important to note that 

combining these approaches with more sophisticated molecular and morphological approaches, 

such as RNA-Seq or back-scatter SEM, will add rigor and power to the assessment of PLR 

phenotype in bone tissue71–74. 
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IV – Approaches, Considerations, and Techniques for Studying PLR 

Molecular Assessment of PLR – RT-qPCR and Immunohistochemistry:  

Numerous enzymes have been functionally implicated in PLR through in vivo studies. 

Several enzymes, already implicated in bone remodeling by osteoclasts and osteoblasts, are 

expressed by osteocytes at the time and site of PLR. Studies in genetically modified mouse 

models have shown a functional role for several of these in PLR, including matrix 

metalloproteinases (Mmp2, Mmp13, Mmp14), Cathepsin K (Ctsk), carbonic anhydrases (Ca2), 

vacuolar H+ ATPases (Atp6v1g1, Atp6v0d2, and Atp6v0b), and tartrate resistant acid 

phosphatases (Acp5) in PLR16,31,37,40.  Analysis of gene expression using RT-qPCR and RNA-Seq 

shows that many of these genes are regulated in a coordinated manner by agents that modulate 

PLR, such as PTH, PTHrP, TGFβ, and glucocorticoids16,30,37,40.  Therefore, analysis of changes 

in mRNA and protein expression of these PLR enzymes provides a good surrogate to quantify 

dynamic changes in PLR at the molecular level.  

An important consideration of osteocyte gene expression analysis is the selection of the 

proper housekeeping gene. In RT-qPCR, in order to normalize results between conditions to 

control for differences in RNA isolation or other factors, a housekeeping gene, or a gene with 

relative stability between the tested conditions, must be used in the delta-delta CT method of 

quantifying relative gene expression levels75. Common housekeeping genes used for other cell 

types include genes for structural proteins, i.e. beta actin, or genes encoding conserved molecular 

machinery like ribosomal protein units. Because osteocytes are highly specialized cells, are 

actively producing diverse amounts of matrix material in their regulation of bone tissue, and have 

dynamic and situation dependent behaviors, housekeeping genes traditionally used for other cell 

types, especially genes for structural proteins, may not be suitable as housekeeping genes for 

evaluation of osteocyte transcriptional behavior. Thus, effort should be taken to evaluate and 

confirm the appropriate housekeeping gene used in RT-qPCR for osteocytes. 
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Before investigation into specific gene expression changes, the baselines for osteocyte 

behavior must be established. Recently, an osteocyte transcriptome has been established76 

defining the generalized landscape of osteocyte expression. From here, housekeeping genes 

conserved among other cell types can be identified within osteocytes. Instances of important 

active osteocyte research include areas of age and disease that may impact or alter osteocyte 

behavior from this baseline behavior. In these conditions, for example in age, expression patterns 

may change and genes that were once reliable housekeeping genes may be altered, removing 

them from consideration as housekeeping genes in qPCR experiments. Previous studies in 

contexts of interest, for example aging77–79, can be used to screen for commonly used 

housekeeping genes. Candidate genes from these studies can be referenced against the 

osteocyte transcriptome to see if they are utilized by osteocytes or not before testing the stability 

of these genes in osteocytes. Genes conserved in osteocytes and active in homeostasis as well 

as in age and disease present themselves as good candidate housekeeping genes because their 

use tends to not be context dependent or at least may be similar in the contexts being compared.  

Before beginning any expression related experiment, the stability of chosen housekeeping 

genes within osteocytes should first be considered. Several analytical methods exist for gene 

normalization and stability analysis80–83 and can be applied to osteocyte expression analysis. In a 

small experiment, we sought to determine a collection of housekeeping genes for aged osteocytes 

when traditional housekeeping genes, GAPDH & beta-actin, were found to be unstable with age. 

Candidate housekeeping genes were selected from a range of previous age-related studies from 

other tissues. CT expression values for these genes were collected via RT-qPCR from RNA from 

mice across a range of ages, sexes, and backgrounds. Utilizing RefFinder*, a free online tool that 

combines several methods of gene expression normalization84 candidate gene expression was 

normalized across samples and then ranked in terms of stability (Fig. 3.3). This analysis revealed 

 
* https://www.heartcure.com.au/reffinder/?type=reference 
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novel housekeeping genes and unexpected instability of genes previously used during expression 

analysis of osteocytes including GAPDH and L19, which ranked last in our analysis. Results from 

this test emphasize the importance of verifying gene stability in specialized cells such as 

osteocytes for the investigation of PLR in situations of altered homeostasis. 

 
 

In many cases, ablation of these enzymes in mice causes disruption of the LCN. 

Specifically, the long bones from lactating mice have increased mRNA expression of cathepsin 

K, TRAP (ACP5/Acp5), and carbonic anhydrase 1 and 216,36,85. Similar to osteoclasts, osteocytes 
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Delta CT SDHA 18S pol2Ra TBP YWHAZ HPRT Tuba1 GAPDH L19

BestKeeper HPRT pol2Ra SDHA YWHAZ 18S TBP Tuba1 GAPDH L19

NormFinder 18S SDHA pol2Ra TBP YWHAZ HPRT Tuba1 GAPDH L19

Genorm TBP | YWHAZ SDHA pol2Ra 18S HPRT Tuba1 GAPDH L19
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Figure 3.3: Housekeeping gene selection and stability for aged osteocytes. qPCR results 
for osteocyte enriched RNA from 8 aged mice of mixed backgrounds and both sexes were 
collected for 9 common housekeeping genes, chosen from prior studies of aging in other organ 
systems. Raw CT values were analyzed via the RefFinder method which combines multiple 
normalization methods to analyze gene stability and ranked for each methods independently 
(A) and for the RefFinder combined ranking (B) showing that housekeeping genes SDHA and 
18S outperform other commonly used housekeeping genes (GAPDH, L19). 
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simultaneously express acid catalyzed proteases and ATP proton pumps, implying a coordinated 

effort by the osteocyte to 1) establish extracellular pH gradients within the LCN and 2) activate 

proteolytic events to resorb the surrounding bone matrix16,21,37,86,87. In cortical bone from mice with 

an osteocyte-specific deletion of the TGFb type II receptor, qPCR revealed a coordinated 

repression of multiple PLR enzymes. The same bones had several features consistent with 

suppressed PLR, including diminished canalicular networks and bone quality deficits37. Other 

situations that induce or suppress PLR, for example lactation or glucocorticoid treatment, also 

show coordinated induction or repression of PLR genes respectively16,40, suggesting that PLR 

enzymes may share some common regulatory mechanisms. Since many of these PLR genes are 

expressed by bone resorbing osteoclasts and other cell types, parallel use of 

immunohistochemistry (Fig. 3.4) is needed to definitively demonstrate that gene expression 

differences in osteocyte-enriched cortical bone mRNA are primarily due to osteocytes.  

Figure 3.4: Molecular assessment of PLR. Immunohistochemistry for PLR-associated proteins 
MMP13, MMP14, CTSK and TRAP on femurs isolated from 8-week old C57BL6 mice. 7 μm thin 
paraffin embedded bone sections are is shown (A). Arrows indicate the osteocytes positive for 
the respective stain. Scale bar is 20 μm. RT-qPCR highlights the lactation mediated induction in 
PLR-related genes (B). All genes were normalized to 18s RNA as an internal control gene and 
relative changes in gene expression in the lactating C57/BL6 mice were compared against virgin 
controls. N=10 mice in each group and *p>0.05, different from the virgin mice, as calculated from 
the Student’s t-test. 
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In our laboratory, initial analyses of gene and protein expression typically focus on MMP13 

and cathepsin K, followed by MMP2, MMP14, carbonic anhydrase 2, and various ATPases (i.e. 

ATP6V1G1 and ATP6V0D2) if initial results suggest a role in PLR regulation16,37. In some cases, 

carbonic anhydrase 2 and the ATPases seem to be regulated distinctly from the expression of 

the proteases, suggesting the possible presence of compensatory mechanisms between the 

acidification and proteolytic functions of PLR.   
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Protocol - Molecular Assessment of Osteocytic PLR via qRT-PCR 

Expression of genes typically associated with the resorptive activity of osteocytes can be 

monitored to assess induction of PLR. RNA enriched for osteocytic populations can be isolated 

and quantified as described below. 

Materials: 

1. Centrifuge Multifuge 3S-R. 

2. Disposable polypropylene round-bottom tubes (15 ml). 

3. Polytron Homogenizer (ThermoSavant or equivalent). 

4. Bone spinner tubes: Make a small hole at the bottom of a 0.2ml and 0.5ml 

Eppendorf tubes. Place the 0.2 ml tube nested in the 0.5ml tube and insert 

this 2-tube assembly nested in a 1.5ml Eppendorf tube to make a bone 

spinner tube.  

5. Polypropylene Eppendorf tubes (1.5 ml). 

6. Petri dish (6 and 10 cm diameter). 

7. Sectioning materials (scissors, forceps, curved forceps). 

8. miRNeasy extraction kit (Qiagen) or equivalent. 

9. iScriptTM RT kit (BioRad) or equivalent. 

10. iQTM SYBR Green Super Mix (BioRad) or equivalent. 

11. Primers for qPCR 

12. MyIQ Single-Color-Real-Time detection system (BioRad) or equivalent. 

Methods 

1. Dissect the bones and remove the periosteal layer and muscle surrounding 

the bones as quickly as possible.  

2. Dissect off the epiphyseal ends of the bones and remove the bone marrow 

by centrifuging the bones in special bone spinner tubes at 9000 rpm for 15 

seconds. 
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3. Flash freeze the bones devoid of marrow, periosteum, and epiphyses in 

liquid nitrogen for 30 seconds. 

4. Following flash freezing, immediately immerse the samples in 15 ml 

polypropylene tubes containing 1.5 ml QIAzol (analogous to TRIzol) solution 

for every 20 mg of bone tissue. 

5. Dissociate the bone tissue in QIAzol using a Polytron tissue homogenizer at 

full speed in 10 second bursts 3-4 times, icing the samples between bursts 

for 5-10 seconds. Ensure that the samples are on ice during homogenization 

step. Homogenized samples can be stored at -80 °C in QIAzol prior to RNA 

isolation.  

6. For total RNA extraction from homogenized lysates, the miRNeasy Mini Kit 

(Qiagen), which combines a phenol/guanidine-based lysis and a silica-based 

on-column purification method for efficient and high-quality RNA extraction, 

may be used(39). This kit allows collection of both mRNA and miRNA.  If only 

the mRNA is useful for your experiments, the RNeasy Kit (Qiagen) can be 

used with the same protocol. 

7. Add 300 µl of chloroform (0.2 times the volume of QIAzol) to the QIAzol cell 

lysate and mix them thoroughly for 15 seconds. 

8. Incubate at room temperature for 2-3 minutes until separation begins to 

occur.  

9. Centrifuge the samples at 12,000 rcf for 15 minutes at 4oC.  

10. Transfer the upper aqueous phase to new tube being careful not to disturb 

or contaminate with the lower phase and follow the standard manufacturer’s 

protocol for isolating RNA. Conduct on-column DNase digestion as 

recommended in the miRNeasy mini kit protocol. 
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11. Concentration of the extracted RNA is determined using a NanoDrop™ 1000 

spectrophotometer (Nanodrop Technologies). RNA with a 260/280 ratio 

between 1.8-2.0 and a 260/230 ratio of close to 2.0 is considered of good 

quality. RNA yields are typically in the range of 7-10 µg from the whole bone 

(devoid of marrow). From trabecular bone alone, we are able to isolate 5-7 

µg of RNA, while cortical bone extraction yields at most 1-2 µg of RNA. 

12. Conduct reverse transcription using the iScript cDNA synthesis kit as per the 

manufacturer’s instructions. 1 µg of total RNA is reverse transcribed into 

cDNA using a final volume of 30 μl reaction mixture. 

13. Prepare reaction master mix as per Table 1 and add RNA samples 

separately for each reaction. 

 

Table 3.2: Reverse transcription master mix 

Reagents 1 reaction 

5X iScript RT Supermix 4 µl 

iScript Reverse Transcriptase 1 µl 

RNA template (1 µg) variable 

Nuclease free water variable 

Total volume 20 µl 

 

14. Mix the RNA and iScript master mix and incubate samples in the 

thermocycler following the temperature gradients described in Table 2. Store 

cDNA at -200C until use for quantitative RT-qPCR.  
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Table 3.3: Thermocycler reverse transcription temperature gradient 
guide 

Temperature Time 
250C 5 minutes 

460C 20 minutes 

950C 1 minutes 

250C Hold 

 

15. Carry out Quantitative RT-qPCR using the iQ-SYBR Green Supermix kit 

(Bio-Rad) on a MyIQ Single-Color-Real-Time detection system (BioRad). 

Typically, 50ng of cDNA used in a qPCR reaction mix will obtain Ct readings 

in the range of 25-30 for the PLR genes in Table 3. While the primers are 

specific for mouse bones, the protocol for RNA extraction and RT-qPCR is 

applicable to bone specimens from other species.  

 

Table 4.3: PLR gene primers for RT-qPCR 

 
16. Prepare the primer, cDNA and iQ-SYBR green master mix as outlined in 

Table 4. 

Primers for genes Sequence 

18s RNA (FP)  
18s RNA (RP) 

5’-CGAACGTCTGCCCTATCAAC-3’ 
5’-GGCCTCGAAAGAGTCCTGTA-3’ 

Mmp13 (FP) 
Mmp13 (RP) 

5’-CGGGAATCCTGAAGAAGTCTACA-3’ 
5’-CTAAGCCAAAGAAAGATTGCATTTC-3’ 

Mmp14 (FP) 
Mmp14 (RP) 

5’-AGGAGACGGAGGTGATCATCATTG-3’ 
5’-GTCCCATGGCGTCTGAAGA-3’ 

Mmp2 (FP) 
Mmp2 (RP) 

5’-AACGGTCGGGAATACAGCAG-3’ 
5’-GTAAACAAGGCTTCATGGGG-3’ 

Ctsk (FP)  
Ctsk (RP) 

5’- GAGGGCCAACTCAAGAAGAA-3’ 
5’- GCCGTGGCGTTATACATACA-3’ 

Acp5 (FP) 
Acp5 (RP) 

5’-CGTCTCTGCACAGATTGCAT-3’ 
5’-AAGCGCAAACGGTAGTAAGG-3’ 

Atp6v0d2 (FP) 
Atp6v0d2 (RP) 

5’-TCTTGAGTTTGAGGCCGACAG-3’ 
5’-GCAACCCCTCTGGATAGAGC-3’ 

Atp6v1g1 (FP) 
Atp6v1g1 (RP) 

5’-CCGTTCTCTCAGCCCAAAGT-3’ 
5’-CTCCGGTTCTTTCGCTTGC-3’ 
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Table 3.4: iQ-SYBR Green mastermix for qPCR 

 

17. Set up the experiment and program the thermocycler to the quantitative RT-

qPCR program outlined in Table 5. 

 
Table 3.5: Thermocycler RT-qPCR temperature cycle guide 

 

Normalize data to 18s RNA as the internal standard and to the corresponding control group 

using the 2–ΔΔCT method. For each run, the melting curve and saturation of amplification 

cycles are controlled by the use of MyIQ software (BioRad).  

 

  

Reagents 1 reaction Final Concentration 
Nuclease free Water Variable - 

Forward Primer Variable 300 nM (100-500 nM) 
(0.5 μL of 100 μm stock) 

Reverse Primer Variable 300 nM (100-500 nM) 
(0.5 μL of 100 μm stock) 

iQ-SYBR Green Supermix 
(2x concentration) 10 μL 1x 

Template (cDNA) 0.5 μL of 100ng/μL cDNA 
from RT 

Amount of cDNA 
equivalent to ~1pg to 
100 ng of total RNA 

Total Reaction Volume 20 μL   

Temperature Time (mins/secs) No. of cycles 
950C 2-3 min. 1 
950C 10-15 secs 

40 600C 30 secs 
55-950C (in 0.50C increments) 10-30 secs 1 
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Protocol - Molecular Assessment of Osteocytic PLR via Immunohistochemistry 

Materials 

1. Innovex Animal IHC kit  

2. Formalin-fixed, paraffin-embedded (FFPE) sections 

3. Uni-trieve (Innovex) 

4. Primary Antibodies: MMP13 antibody (abcam ab39012); MMP14 antibody 

(abcam ab38971); Ctsk antibody (abcam ab19027) 

Methods 

1. Dissect the bones and carefully scrape off the surrounding periosteum and 

muscle tissue.  

2. Fix the cleaned bones immediately in 10% neutral buffered formalin (NBF) 

for 48 hours.  

3. Following fixation, rinse the tissue samples in the 1X PBS solution to remove 

residual PFA. 

4. Decalcify the fixed bones using 0.5 EDTA for 2-4 weeks. Following 

decalcification, rinse bones in PBS (three times each for 60 minutes at 4o C) 

and then subjected to paraffin embedding. 

5.  Utilizing a microtome, generate 6-8 µm thick sections from paraffin blocks 

according to standard protocols.88  

6. Deparaffinize and rehydrate tissue sections by immersing the slides in 

100% xylene or citrisolv and EtOH gradient as described below.  

7. Immerse slides in Citrisolv three times for 5 minutes each.  

8. Immerse slides in 100% EtOH for 5minutes 

9. Immerse slides in 95% EtOH for 5minutes 

10. Immerse slides in 70% EtOH for 5minutes 

11. Immerse slides in distilled water for 5minutes. 
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12. Incubate slides in Uni-trieve for 30 minutes at 60°C. 

13. Rinse slides in distilled water two times for 3 minutes each.  

14. Incubate slides with Fc-block (329ANK) for 45 minutes at RT.  

15. Rinse slides in distilled water two times for 3 minutes each.  

16. Incubate slides with Background Buster for 45 minutes at RT.  

17. Rinse slides in distilled water two times quickly.  

18. Incubate slides with primary antibody in PBS for 1hr at RT or overnight at 

40C. Recommended dilutions of primary antibodies: MMP13- 1:100 diluted in 

1X PBS; MMP14- 1:100 diluted in 1X PBS; CTSK- 1:75 diluted in 1X PBS  

19. The next day, rinse slides in 1X PBS three times for 3 minutes each.  

20. Incubate slides with Secondary Linking Ab (329ANK) for 10 minutes at RT.  

21. Rinse slides in PBS three times for 3 minutes each.  

22. Incubate slides with Peroxidase (HRP) enzyme for 10 minutes at RT. 

23. Rinse slides in 1X PBS three times for 3 minutes each.  

24. Incubate slides with DAB working solution for 5 minutes at RT.  

25. Rinse slides in 1X PBS thrice for 3 minutes each.  

26. Mount slides with an aqueous-based mounting-medium. 
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Protocol - Molecular Assessment of Osteocytic PLR via Tartrate Resistant Acid 

Phosphatase Staining 

Materials 

1. Acid phosphatase leukocyte kit (Sigma) 

2. Fast Red Violet (Sigma) (CAS#  32348-81-5) 

3. Fast Green (Sigma)(CAS# 2353-45-9) 

4. 37% formaldehyde 

5. Formalin-fixed, paraffin-embedded (FFPE) sections 

6. Fast Red Violet Solution: First dissolve 7mg of Fast Red Violet salt in 1ml of 

1XPBS.  

7. Diazonium salt solution: Gently mix Fast Red Violet solution and with Sodium 

Nitrite Solution in a 1:1 ratio by tapping or inverting (depending on the volume 

of the solution). Allow it to stand at RT for 2minutes.  

8. 0.02% Fast Green: Dissolve 0.05g of Fast green dye in 250ml of distilled 

water.  

9. Fixative Solution: Mix 25ml citrate solution, 65ml acetone, and 8ml 37% 

formaldehyde. Store solution at 40C for up to 2 months.  

Methods 

1. Deparaffinize and rehydrate tissue samples by immersing the slides in 100% 

xylene or citrisolv and EtOH gradient as described below.  

2. Immerse slides in Citrisolv three times for 5 minutes each. 

3. Immerse slides in 100% EtOH for 5 minutes. 

4. Immerse slides in 95% EtOH for 5 minutes. 

5. Immerse slides in 70% EtOH for 5 minutes. 

6. Immerse slides in distilled water for 5 minutes. 

7. Incubate slides in Fixative Solution for 30 seconds at RT. 
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8. Rinse slides in distilled water for 5 minutes. 

9. In a coplin jar, make TRAP staining solution by mixing Napthol AS-BI 

Phosphate solution (Sigma), Tartrate solution (Sigma), Diazonium salt 

solution, Acetate solution (Sigma), and deionized water in a ratio of 

1:2:2:4:90 respectively.  

10. Immediately proceed to incubating slides in TRAP working solution for 1hr at 

37°C in the dark.  

11. Rinse slides in distilled water for 3 minutes.  

12. Counterstain by incubating slides in 0.02% Fast Green for 1 min.  

13. Rinse slides in distilled water with 2-3 quick dips.  

14. Dry slides before mounting with coverslip and a toluene/xylene-based 

mounting-medium.  
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Visualization of the Lacunocanalicular Network 

Two-dimensional Histological Analysis of the LCN: Morphological examination of the LCN 

provided the first evidence of PLR utilizing histological stains to visualize the LCN. Common  

histological stains include H&E, Alizarin red, or basic fuschin89–91, toluidine blue39,85 and ploton 

silver nitrate stains (Fig. 3.5A, 3.5B)25,33,36,38–40,67,85. For example, H&E and toluidine blue can be 

used to distinguish empty lacunae from lacunae containing osteocytes in the section plane, while 

ploton silver nitrate stains can be used for qualitative two-dimensional visualization of both lacuna 

and canaliculi.  

 

Figure 3.5: Stains highlighting morphological changes in osteocytes associated with PLR. 
Silver nitrate stain on C57/BL6 mouse bone demonstrates the osteocyte cell network in the 
paraffin embedded cortical bone (A, scale bar = 20 μm) with cresyl violet counter stain for nuclei 
(purple). Enlarged region of section from A (B, scale bar = 10 μm) depicting an osteocyte 
containing a positively stained cresyl violet nuceli (black arrow) and an osteocyte not presenting 
a nucleus within the 2D section (white arrow).  Fluorescent phalloidin (C, scale bar = 10 μm) 
staining of f-actin (green) and DAPI (blue), can be used to visualize the osteocyte cell network in 
3D with frozen, OCT sectioning and confocal microscopy. Dil stain (red) (D, scale bar = 10 μm) 
intercalates into the hydrophobic cell membrane, further illuminating osteocyte cell bodies and 
dendritic projections in 3D. 
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Semi-quantitative lacunae and canaliculi measurements have been performed and 

reported in various ways. For example, lacunae measurements have been reported as percent 

lacunocanalicular volume38, average number of lacunae occupied by osteocytes per bone 

area59,92,93, number of empty lacunae per bone area57,59,92,94, lacunar area5,25,38,92, and average 

lacunar area per osteocyte33. Canalicular measurements also have been reported as number of 

canaliculi per osteocyte33,57,59, canalicular connectivity33, canalicular branching33and canalicular 

length per osteocyte37,54,94. Lacunar and canalicular measurements have also been summarized 

and reported as lacuno-canalicular area5,67 as well as other parameters5. Due to the variety of 

these measurable LCN outcomes, an established set of lacunar and canalicular parameters is 

needed. Given the diversity and sheer size of the LCN, the manual nature of most histologic 

analysis can result in sample size and number of technical replicate images per sample too low 

or small in scope for adequate observation of the LCN.  In addition, the variable nature of 

histological stains used for LCN visualization has slowed the accurate use of automatic measuring 

software, which has further limited the field to manual measurements that are time consuming 

and subjective to the grader – adding to uncontrolled consistency across experiments. These 

issues are critical to address since PLR changes to the LCN can be subtle and may be localized 

and can require sufficient expertise to observe reliably and repeatably via histology. These 

challenges highlight the need for a standardized approach for reproducible staining, consistent 

selection of regions of interest, adequate biological and technical replicates, and blinded grading 

to overcome these limitations and significantly increase the rigor of LCN histological outcomes.  

 Three-dimensional Visualization of the LCN: Traditional two-dimensional methods of 

visualizing morphological features of the LCN are planar and ignore the three-dimensional nature 

of the osteocyte network. Reconstructing and understanding the complex geometries of the 

osteocyte LCN are critical for understanding the health, arrangement, and activity of osteocytes 

involved in PLR The reliable imaging and reconstruction of the LCN is a challenging endeavor 
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due to the density of the canalicular network and the nanoscale dimensions of these processes 

within an optically opaque, three-dimensional material.  

Several methods39,70,95 have focused on capturing the LCN in three dimensions (Fig. 

3.5C,D). With the advent of confocal microscopy, it has become more feasible to view the LCN in 

three dimensions57,96, while advancements in tissue clearing are pushing the limits of tissue 

penetration97,98. Confocal methods have allowed for the reliable collection of osteocyte lacunar 

parameters, including lacunar density, lacunar shape62, osteocyte surface area and volume99, 

volume fraction of the LCN100, canalicular density, canalicular number per osteocyte, canalicular 

volume, and canalicular length101, among many others. Light microscopy, however, is limited by 

diffraction aberrations that may skew quantitative efforts especially at the nanoscale dimensions 

of osteocyte canaliculi so care must be taken when observing these features102. Multi-photon 

microscopy has been employed to overcome some of these limitations and has also been 

successful in further increasing the penetration depth of light microscopy74,99. Despite 

advancements, these techniques are time consuming, data-expensive, and only capture a small 

window of the LCN. Even with these drawbacks, light-based microscopy remains one of the most 

common approaches to study of the osteocyte LCN in three dimensions and provides a practical 

and manageable tool with which to study PLR-related changes in osteocyte function68,103,104.  

Robust protocols used for the visualization of the osteocyte LCN in 2D via ploton silver staining, 

and in 3D via fluorescent confocal microscopy are supplied below: 
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Protocol - Morphological Assessment of Osteocytic PLR via Silver Nitrate Stain (2D) 

Materials 

1. 10% Neutral buffered formalin  

2. 1X Phosphate Buffered Saline (PBS) 

3. 100% Xylene or Citrisolv 

4. 100% ethanol (EtOH) 

5. 95% ethanol  

6. 70% ethanol  

7. 0.5 M Ethylenediaminetetraacetic Acid (EDTA) 

8. Silver Nitrate  

9. Sodium Thiosulfate 

10. Acetic Acid 

11. Sodium Acetate 

12. Cresyl violet  

13. Gelatin type B, bloom 100 (bloom is the strength of gelatin) 

14. Bone sections 

15. Disposable coplin jars. Holds 20-25ml volume and 4 slides. 

16. Gelatin-formic acid solution: Dissolve 0.2g gelatin type A, bloom 275 or B, 

bloom 75 in 10ml of warm water (50-550C). Vortex to dissolve and cool to 

room temperature (RT). After cooling, add 125µl of 90% formic acid. 

17. 50% Silver Nitrate: Dissolve 7.5g of silver nitrate (Spectrum Chemical) in 

15ml of water and mix by shaking gently. 

18. Silver Nitrate Working Solution: Mix 50% silver nitrate and gelatin-formic acid 

solution in a 2:1 ratio. Keep solution in the dark. 

19. 5% Sodium thiosulfate: Dissolve 12.5g sodium thiosulfate in 250ml water. 
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20. Cresyl violet solution: Dissolve 33.35mg of cresyl violet acetate in 25ml of 

distilled water. 

21. 0.1M Acetic Acid: Dissolve 3ml of glacial acetic acid in 500ml of distilled 

water.  

22. 0.1M Sodium Acetate: Dissolve 200mg of sodium acetate in 15ml of distilled 

water.  

23. Buffer Solution: Mix 235ml of 0.1M acetic acid and 15ml of 0.1M sodium 

acetate. Adjust pH to 3.5.  

24. Cresyl violet Working Solution: Mix 250ml of buffer solution with 25ml of 

cresyl violet solution. Mix well 30 minutes and keep solution in dark. 

Methods 

1. Dissect the bones and carefully remove the muscle tissue.  

2. Fix the cleaned bones immediately in 10% neutral buffered formalin (NBF) 

for 48 hours at RT.  

3. Following fixation, rinse the tissue samples in 1X phosphate buffered saline 

(PBS) solution for 10 minutes and at least three times to remove residual 

NBF.  

4. Decalcify the fixed bones by keeping them in 0.5M EDTA solution for 2-4 

weeks shaking at 60 revolutions/ min at RT. Change EDTA solution every 3-

4 days. 

5.  Following decalcification, bones will be rinsed in PBS (three 60-minute 

washes at 4o C) to remove residual EDTA.   

6. Proceed with paraffin embedding according to standard protocols. 

7. Utilizing a microtome, generate 6-8 µm thick sections according to standard 

protocols88.  
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8. Deparaffinize and rehydrate tissue samples by immersing the slides in 100% 

xylene or citrisolv and EtOH gradient as described below.  

9. Immerse slides in Citrisolv three times for 5 minutes each.  

9. Immerse slides in 100% EtOH for 5minutes. 

10. Immerse slides in 95% EtOH for 5minutes. 

11. Immerse slides in 70% EtOH for 5minutes. 

12. Immerse slides in distilled water for 5minutes.  

13. Immerse slides in the freshly made silver nitrate working solution for 60 

minutes and store the slides in the dark during this incubation. 

14. After silver nitrate incubation, wash the slides three times with distilled water 

for 5 minutes each.  

15. Incubate slides in 5% sodium thiosulfate for 10 minutes and perform three 

washes with distilled water for 5 minutes each at RT. 

16. Following silver nitrate staining, counterstain the slides with cresyl violet 

working solution for 4-30 minutes. 

17. Rinse the slides in distilled water and proceed to dehydrate the sections by 

incubating the slides in the EtOH gradient (70%, 95%, 100%, 100%) for 5-10 

dips each.  

18. Immerse slides in 100% Isopropyl alcohol for 5-10 dips.  

19. Clear sections by immersing in Citrisolv solution three times each for 5 

minutes. 

20. Using a toluene/xylene-based permanent mounting-medium add a coverslip 

onto the slide and prepare it for microscopy. 
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Protocol - Morphological Assessment of Osteocytic PLR via Dil/Phalloidin Stain (3D) 

Materials 

1. 0.5 M Ethylenediaminetetraacetic Acid (EDTA) 

2. Sucrose (10%, 15%, 20% and 30%) solutions prepared in 1X PBS 

3. Normal Donkey Serum (NDS) 

4. Bovine Serum Albumin (BSA) 

5. Dil Stain: 1,1’-Dioctadecyl-3,3,3’,3’-Tetramethylindocarbocyanine 

Perchlorate (Invitrogen) 

6. Dimethyl sulfoxide (DMSO) 

7. Alexa Fluor 488 Phalloidin (Invitrogen) 

8. 4′-6-Diamidino-2-phenylindole (DAPI)  

9. 2,2’-Thiodiethanol (TDE) 

10. Frozen optimum cutting temperature (OCT) embedded sections  

11. 48-well plate 

12. Toluene/ formaldehyde-free nail polish 

13. 4% PFA: Add 4g of paraformaldehyde (PFA) to solution containing 50 ml of 

water and 1ml of 1 M NaOH. Dissolve PFA by continuous stirring on a heating 

block set to 60°C. Add 10 mL of 10X PBS and allow the mixture to cool to 

RT. Adjust the pH to 7.4 with 1 M HCl and bring the volume to 100ml. Store 

4% PFA aliquots at −20°C for several months and avoid using solution that 

is repeatedly frozen and thawed. 

14. Blocking buffer (PBS/1%NDS/1%BSA): Dissolve 2.5µl Bovine Serum 

Albumin (BSA) and 2.5µl Normal Donkey Serum (NDS) in 200µl PBS.  

15. Dil solution: Dissolve 100µM of Dil stain in 50% DMSO: 50% PBS. 
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16. Phalloidin solution: Dissolve 5µl of Alexa Fluor 488 Phalloidin stock solution 

in blocking buffer.  

17. DAPI solution: Make 4µg/ml DAPI in 1X PBS. 

18. Tissue clearing and mounting media: Prepare 10%, 25%, 50%, 95%, & 97% 

TDE in 1X PBS using the TDE stock. 

Methods 

1. Dissect and clean bones of surrounding tissue, remove periosteum from 

surface of bones.  

2. Fix bone samples by incubating in 4% PFA for 48 hours.  

3. Rinse the fixed samples in 1X PBS to remove residual PFA and decalcify the 

bones in 0.5M EDTA for 2-4 weeks on shaker at 60 revolutions/ minute at 

RT. Change EDTA solution every 3-4 days.  

4. Following decalcification, bones will be rinsed in PBS (three 60-minute 

washes at 4o C) to remove residual EDTA.   

5. Cut off the ends of the bone and gently remove the bone marrow by flushing 

with PBS using a syringe and needle.  

6. Wash samples in 1XPBS and subject them to a sucrose gradient (10%, 15%, 

20%) described in steps 7-9 below.  

7. Immerse samples in 15% sucrose solution for 15 minutes at RT. 

8. Immerse samples in 20% sucrose solution for 15 minutes at RT. 

9. Immerse samples in 30% sucrose solution overnight at 40C 

10. Following sucrose gradient, gently dab dry samples with tissue, ensuring no 

liquid remains in the marrow cavity, and proceed to frozen embedding. 

11. Embed samples in OCT media as per standard protocol or as described in 

the Demineralized Murine Skeletal Histology section of this reference.  Cut 
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40-100 µm thick cryosections of the embedded bones either onto microscope 

slides or wells of a 48 well plate containing ~250 µl RT 1X PBS.  

12. Rinse sections three times with 1X PBS for 5 minutes each until all OCT is 

removed.  

13. Incubate the sections with the blocking buffer overnight at 40C (~50 µl per 

well) in parafilm sealed plate.  

14. Rinse the slides in 1X PBS three times each for 5 minutes. 

15. Incubate the slides with the Dil solution in the dark at 40C for 1 week. This 

dye stains hydrophobic structures including cell membranes, which is why 

long staining time is required for diffusion throughout the LCN.  

16. Rinse the slides in 1X PBS three times each for 5 minutes.  

17.  Incubate the slides in Phalloidin solution overnight at 40C in parafilm sealed 

well plate. This dye stains the actin cytoskeleton.  

18. Rinse the slides in 1X PBS three times each for 5 minutes. 

19. Incubate the slides in DAPI solution at RT for 30 minutes to stain the 

osteocyte nuclei.  

20. Rinse the slides in 1X PBS five times (~250 µl per well).  

21. For mounting the sections, conduct sequential incubations in TDE gradient 

solutions namely, 10% TDE, 25% TDE and 50% TDE in PBS. Each of these 

incubations are 2 hours long and performed at RT. Finally, incubate slides 

overnight at 40C in 95% TDE solution in parafilm sealed well plate.   

22. Place a drop (~10-20 µl) of 97% TDE onto slide (if slide mounted, wick away 

previous solution with kim wipe and place 97% TDE directly on tissue) and 

gently place section directly into drop with forceps, curled sections should 
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unroll in solution. Place cover slip and seal edges with toluene/formaldehyde 

free nail polish.  

23. Image immediately or store slides in -200C for a few weeks.57 
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Quantitative and Descriptive Parameters of the Osteocyte LCN 

Given the broad range of parameters reported about the LCN in both two and three dimensions 

we suggest a standardization to the reporting of these details. A term representative of the whole 

LCN should be first supplied, i.e. “LCN area / bone area” in 2D and “LCN volume fraction” in 3D. 

Terms dissecting the differences of the osteocyte cell bodies or lacunae from the canaliculi are 

also ideal and include lacunar area (2D) and volume (3D), lacunar number densities (2D/3D), 

canalicular length (2D*/3D), canalicular spacing (3D) and tortuosity (3D), and canaliculi per 

osteocyte or canalicular density. Standardized protocols for the collection for these parameters 

utilizing publicly available software (ImageJ/Fiji) or other commercially available image processing 

software (IMARIS) are provided below. 

  

 
* Canalicular Length in 2D can be misleading as canaliculi often bend in and out of the 
focal or cut plane of a traditionally prepared thin paraffin section (6-7 µm). Use of this term 
in 2D should be accompanied by the recognition that canaliculi are three dimensional 
structures and length in 2D does not accurate capture the full length of these features. 
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Protocol - Canalicular Length (2D) 

Requires  
• RBG image of the Osteocyte LCN via Silver Nitrate Staining 
• Fiji (ImageJ) 

 
1) Load Image into Fiji (can click and drag) 
2) Set Scale 

a. Use the line tool to trace the length of the scale bar 
b. Analyze > Set Scale 

3) Duplicate the Image so you can edit /track progress without altering the original image. 
c. Shift + D  or Image > Duplicate 

4) Using the Line Tracer Tool star from the base of a canaliculi at the edge of the lacuna 
and extend straight outwards towards the tip/last discernable point of the continuous 
canaliculi 

a. Hit “M” key to measure 

 
5) Hit “Delete” key to delete the pixels underneath the line tracer 

b. This helps keep track of which canaliculi you have already measured 
c. Ensure you are working on the Duplicated copy, do NOT alter original image 

6) Repeat steps 4-5 for 
d. 10 canaliculi / cell 
e. 3-5 cells per image 
f. 3-4 images per mouse 

7) Average ALL observations from above for a single (1) averaged biologic replicate 
g. Collect 6-8 biologic replicates per group 
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Protocol - LCN Area / Bone Area (2D) 

Requires  
• RBG image of the Osteocyte LCN via Silver Nitrate Staining 
• Fiji (ImageJ) 

 
1) Load image into FIJI (can click and drag) 
2) Convert from RBG image type to 8-Bit by splitting color channels 

a. Image à Colors à Split Channels 
b. Select which channel gives best nature contrast and detail in 8-Bit (usually Red) 
c. Close unwanted color channels 

3) Background Subtraction 
a. Process à Subtract Background 

i. You can mess around with the “rolling ball radius”, depending on your 
feature size it will need to change. The default value is 50, 20 does a 
good job but can get too busy. 

4) Enhance Local Contrast 
a. Process à Enhance Local Contrast (CLAHE) 

5) Convert to Binary Image 
a. Process à Binary à Make Binary 

i. IFF this inverts the expected B&W areas (i.e. lacuna are not white with 
black borders) you will need to invert the Look Up Table to create a 
negative image 

ii. Image à Lookup Tables à Invert LUT\ 
6) Set Scale Bar 

a. Analyze à Set Scale 
7) Manually Section out and fill in Lacuna 

a. When selecting Black or White, only use color selector from toolbar, don’t try to 
select a black or white from a color palate.  

b. Use paint brush tool to circle around lacuna in white to separate them from rest 
of network 

c. Ensure that Lacuna borders are solid black (no pixel gaps) and fill in Black with 
paint can. 

8) Measure Lacunar Area 
a. Analyze à Analyze Particles 

i. Set a lower bound around 5-10 um to exclude small features 
ii. Can set a larger bound to exclude obviously large features. Lacuna are 

usually within 20-60 um in area. 
iii. Select Show “Outlines” in the drop down menu 
iv. Check “Display Results”, “Summarize”, and “Exclude on Edges” 

9) Repeat steps 6-7 until you are satisfied with the results 
a. Save results by copy-paste into excel or saving results as a .CSV file 
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Protocol - Lacunar Number Density from 2D Fluorescent Tile Scans or Large Bone 

Sections 

 
Requires:  

• ImageJ 
• Florescent Image of (large) bone cross section with osteocytes labeled. DAPI or other 

nuclear stain is appropriate. 
o Ensure that a scale bar is part of the image or know the pixel dimensions 

 
1) Load color (RGB) image/file into ImageJ 
2) Set Scale 

a. Use the line tool to trace the length of the scale bar 
b. Analyze > Set Scale 

3) Remove Background  
a. Process > Subtract Background 
b. Rolling Ball Radius begin at 50 pixels, adjust smaller if needed 
c. No other options should be selected in menu window 

4) Increase contrast  
a. Shift + C or Image>Adjust>Brightness and Contrast 
b. Adjust to bring cells out and remove tail end of background that’s left 

5) Convert to 8-bit 
a. Image > Type > 8-bit 

6) Invert image to for white background with grey bone/cells 
a. Shift + I or  Edit > Invert 

7) Clean Edges to remove soft tissue 
a. Polygon Selection tool on tool bar 
b. Click to Loop around soft tissue pieces and delete 

8) Despeckle Background 
a. Process > Noise > Despeckle 

9) Save your Grey Scale Image 
a. File > Save as… > Tiff… 

10) Measure Inner and Outer Area 
a. Using the Polygon Selection tool, outline the endosteal circumference  
b. Analyze > Measure or “M” 
c. If “area” isn’t recorded, go to “Analyze > set measurements” and select area as a 

portion 
d. Repeat with periosteal circumference 
e. Subtract inner area from outer area for full bone area 

11) Convert to Binary 
a. Process > Binary > Make Binary 

12) Remove additional background if necessary 
a. Process > Noise > Despeckle 
b. Process > Binary > Erode 
c. Use whatever methods you’d like to continue to clean up background 

13) Check size of cells 
a. Zoom in until can loop a single cell with the polygon tool (Shift + “+”) 
b. Measure area of a few cells to get an idea of the range of sizes of cells 

14) Count Cells 
a. Analyze > Measure Particles 
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b. Set Upper and Lower Bounds from sizes from Step 13 
c. Select Show Ellipses to view results 
d. Select “Display Results”, ”Exclude on Edges”, and “Summarize” 

15) View the Ellipses Map results to validate if identifying cells correctly 
a. Adjust Upper and Lower Bounds and re-run Step 14 if necessary 

16) Calculate Osteocyte Density 
a. Number of cells from Step 14 divided by Area from Step 10 
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Protocol - Whole Mount Image Processing to generate RGBs, 8-Bit, and Binary Images 

(3D) 

 
Requires  

• Independent color image stacks of LCN from Fluorescent Confocal Microscopy 
o If following the included whole mount protocol, this should be 3 separate 

image channels 
§ Blue – Dapi 
§ Green – Phalloidin 
§ Red – DiI 

• Fiji (ImageJ) 
 

1) Click and drag each folder to open in Fiji as 1 color channel per image stack 
a. If used the “Confocal Image File Sorter”* python script to sort images from the 

Leica, the folders should correspond as:  
ch00 – Dapi (Blue) 
ch01 – Phalloidin (Green) 
ch02 – DiI (Red)  

b. Do NOT open as a “Virtual Stack” ensure this option is not selected during import 
2) Remove Background  

a. Process > Subtract Background 
b. Rolling Ball Radius begin at 50 pixels, adjust smaller if needed 
c. No other options should be selected in menu window 

3) Increase contrast  
a. Shift + C or Image>Adjust>Brightness and Contrast 
b. Adjust to bring cells out and remove tail end of background that’s left 
c. Complete this for each color channel, each color will have its own amount of 

adjusting that can be done 
i. DAPI can be boosted the most since we are only using this to identify 

nuclei, DiI will only be able to be boosted some without saturating the 
image 

4) Despeckle the DAPI channel only 
a. Process > Noise > Despeckle 

5) Merge the 3 channels into 1 overlaid image 
a. Image > Color > Merge Channels… 
b. Select the corresponding image stacks for their color i.e. C1 (red) – ch02 (DiI) 

 
c. Channels c4-C7 are not used to generate an RGB 

 
* The python automated file sorter code can be found within the “Protocols” directory within 
the Alliston Lab Server 
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d. Select “Make composite” and “Keep Sources Images” 
e. Images are not technically “merged” at this point, they are simply overlaid which 

allows us to still adjust each channel independently 
6) View composite image and adjust color balance here if necessary 

a. Image > Adjust > Color Balance 
7) Convert to an RGB Color Image 

a. Image > Type > RGB Color 
b. Select “slices” to merge the entire stack 
c. Select “Keep Source” to not lose the independent channels if desired 
d. This step fuses all three of the overlaid “Merged” channels into one true RGB 

colored image 
8) Remove excess background from merging 

a. Process > Subtract Background 
b. Process > Noise > Depseckle 

9) Save this image as your composite RGB within the directory the original image channels 
came from 

a. File > Save as… > Image Sequence 
b. Feel free to close any excess windows you still have open (channels, merged, 

etc..) before moving on ONCE you have saved the RGB 
10)  Convert the RGB into a grey scale 8-bit image 

a. Image > Type > 8 bit 
11) Adjust Brightness and Contrast if Desired 

a. Shift + C or Image > Adjust > Brightness/Contrast 
b. If adjusting be careful to not increase the brightness and boost background noise 
c. If removing background at this step by moving lower bound, only do so by 2-3 

steps, many smaller features of the LCN at this level are close to “noise” 
12) Save this version as your 8-bit/Grey Scale Image 

a. File > Save as… > Image Sequence 
13) Convert to Binary 

a. Image > Adjust > Auto Local Threshold 
i. Use the “Otsu” thresholding method 
ii. Try a radius of 15 to start, adjust from here as necessary 
iii. Select “White objects on a black background” 
iv. Select “Stack” 
v. Hit “Ok” to start the run, this may take several seconds or minutes as 

each stack will be thresholded individually 
14) Reduce noise if necessary 

a. Process > Noise > Despeckle 
15) Manually ‘fill’ any lacuna that are not fully white 

a. Use the paint brush or paint can tools , fill in any black portions of obvious 
lacuna with white (you will need to step through adjacent layers 1 at a time, you 
can do this with the sideways arrow keys on your keyboard 
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b. Use care when using the paint can tool, if ANY internal pixels are touching even 

a single pixel diagonally to the outer black edge Fiji considers them continuous 
features and the entire image will become white. Use the paintbrush, pen, or 
pencil tools in white to sever this connection before using the paint can 

 
i. You can undo errors with Edit > Undo or Ctrl+Z 

16) Save image as Binary version 
a. File > Save as… > Image Sequence 
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Protocol - LCN Volume Fraction (3D) 

Requires 
• Binary 3D stack image of LCN 
• BoneJ Plug-in for Fiji 

 
1) Open Binary Image Stack of the LCN 

a. Click and drag folder containing your binary image into Fiji bar 
2) Set Scale 

a. Use the line tool to trace the length of the scale bar 
b. Analyze > Set Scale 

i. If you have collected your images from the Leica at 100x, the pixel scale 
is 6.8 pixels/micron 

3) Use BoneJ to calculate Volume Fraction 
a. Plugins > BoneJ > Fraction > Area/Volume Fraction 
b. Results should appear in the BoneJ table pop-up, can copy and paste into Excel 

from here or other record  
c. BV and TV results may be given in inches3, ignore and record “BV/TV” 

BoneJ assumes you are analyzing trabecula and thus gives BV/TV results, simply ignore and 
record as the LCN volume fraction 
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Protocol - Canalicular Spacing (3D) 

Requires 
• Binary 3D stack image of LCN 
• BoneJ Plug-in for Fiji 

 
1) Open Binary Image Stack of the LCN 

a. Click and drag folder containing your binary image into Fiji bar 
2) Set Scale 

a. Use the line tool to trace the length of the scale bar 
b. Analyze > Set Scale 

i. If you have collected your images from the Leica at 100x, the pixel scale 
is 6.8 pixels/micron 

3) Use BoneJ to calculate average canalicular spacing 
a. Plugins > BoneJ > Thickness 
b. If asked about anisotropy, ignore and continue 
c. Select “Both” to analyse both thickness and spacing (sometimes the plugin will 

confuse which is which so just run both) 
d. Select “show thickness map” and “mask thickness map” to identify which 

parameter you want to keep later 
i. The “mask thickness” should be the image for the spacings and should be 

name Tb_Sp when generated 
ii. Bonej assumes we are working with uCT of trabecula so just rename to 

Canalicular Spacing 
e. To clear the BoneJ table if it becomes too crowded 

i. Pluginns > Bonej > Table > Clear Bonej results 
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Protocol - Canalicular Tortuosity (3D) 

Requires 

• 8bit 3D stack image of LCN 
• Neuroanatomy Plugin for Fiji 

 
1) Open 8-bit Image Stack of the LCN 

a. Click and drag folder containing your 8-bit image into Fiji bar 
2) Launch the Simple Nuerite Tracer (SNT) 

a. Plugins > Neuroanatomy > SNT… 
3) Set defaults 

a. 3D tab, Viewer > New with Image > Apply 
i. 2 for resampling factor is fine for observation, 1 does not resample so 

higher canalicular resolution but more noise 
b. Main tab, filters for visibility of paths (2) Only nodes within 2 nearby Z-slices 

4) Begin tracing single canaliculi 
a. Start by clicking on one lacuna and then a neighboring one to begin tracing 
b. When finished, click “Finish” to save trace 

5) Trim excess length 
a. Once a trace has been made and accepted, start another trace on top of the 

original at the point where it begins to EXIT the cell of origin and terminate it once 
it ENTERS the lacunar boarder of the terminal cell 

 
b. Delete the old trace from the ‘Path Manager’ (right click menu, delete) 

6) Trace and measure single connections from every osteocyte within the image to its 
nearest neighbor (if possible). 

a. Generally aiming for ~20 connections per image, can do more 
b. If not enough cells, you can manually measure multiple connections between the 

same cells 
i. Since the SNT will always search for the shortest path you may likely 

retrace a connection you have already made. To manually create new 
paths between previously connected cells, you can build unique paths 
step-wise. Start down a new canaliculi identified by eye a short distance,. 
After a segment of a path is created you can continue to build off of it if 
you do not select “Finish” and instead click “Yes” after asked for “Keep 
new segment?”. Continue to build the new path in small manageable 
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lengths until you have completed the new path, then select “Finish” to 
save 

7) Periodically save your traced connections as traces files 
a. File > Export as > TRACES 
b. Save into the directory with your processed image folders 
c. The tracing process can take some time, this lets you pause and save your 

progress, it can also bug and crash since its Fiji so ALWAYS save your progress 
8) When you are done, export your data 

a. Analysis > Path Properties: Export CSV 
b. Save these spreadsheets, they are the raw numeric data 

9) Calculate Average Tortuosity 
a. Open .CSV in excel 
b. Calculate end-to-end Euclidian Distance for each path/row in spread sheet 

 # = 		&((! − (")" + (,! − ,")" + (-! − -")" 
c. Tortuosity (t) = total path length / Euclidian Distance 
d. The average of paths from 3 (or more) ROI’s (stacks) per mouse (50-60 paths) is 

1 biologic replicate 
e. Collect 5-6 biologic replicates / group 
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Protocol - Canaliculi per Osteocyte (3D) 

Requires  

• Independent color image stack of LCN from Fluorescent Confocal Microscopy 
o Use best quality channel of the canaliculi that you have usually: 

§ Green – Phalloidin 
§ Red – DiI 

• IMARIS (v9.5.1) 
 

1) Convert file stack into IMARIS file with IMARIS Image Converter software 
2) In IMARIS 9.5.1 change to scene mode and ‘Add Image’ from File > Open (Fig.6A) 
3) Background subtract the image using the Imaris Image Processing sub-menu.  
4) Using the membrane dye (DiI, red, Fig.3.6A) channel as a template, create an Imaris 

‘surface’ object of the osteocyte cell bodies within the imaged region (Fig. 3.6B).  
a. Use the “Slice” sub menu to measure how large the long axis of one osteocyte 

cell body is, use this value as the pixel dimension for background subtracting 
within the surface creation wizard 

b. Remove small features with the size exclusion filter to prevent canalicular 
dendrites from being included in the cell body surface object 

c. Add an additional filter “distance from axis XYZ” to remove objects touching the 
boundaries of the volume (Fig. 3.6C).  

5) Complete a distance transformation around the new osteocyte surface objects           
(Fig. 3.6D) 

a. This requires an installed Matlab XTenstions attainable online* 
b. When installed will be found in the “Tools” submenu when a surface is 

selected/highlighted (Gear Wheel) 
c. Complete it “outside” the surface object to create a channel encoding the radial 

distances in 3D from the surface of each cell’s unique topography 
6) Generate a new surface object encompassing only a single cell (Fig. 3.6E) 

a. Set the background subtraction size close to the width of the canaliculi as 
measured from the “slice” menu 

b. This creates a new surface of the cell along with canaliculi (Fig. 3.6F)  
7) Use this new surface as a mask to generate a second new channel of only the signal 

from the original image belong to the segmented cell (Fig. 3.6G) 
a. Click the ‘pencil’ submenu when the surface is selected as select “Mask” 
b. Set source at the original image 
c. Set pixels outside to zero 

8) Open the Imaris Colocalization sub-menu to identify canalicular portions at set distances 
from the cell body 

a. Set channel 1 as the newly segmented channel of a single cell and its associated 
canaliculi 

b. Set channel 2 as the distance transform channel 
c. In the upper right, change the selection mode to “Polygon” 

 
* https://imaris.oxinst.com/learning/view/article/distance-transformation  
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d. Click and drag selected polygon to capture the portion of signal you would like to 
keep. Portions within the polygon region will appear as highlighted in white on the 
screen (Fig. 3.6H) 

i. It can be easier to select specific portions of signal along the edges of the 
selection window by changing the polygon shape into a triangle with a 
thin point, and then siding the point up and down the edge of the region 
where there is signal to position your segmented area directly at the edge 
of the cell (Fig. 3.6I) 

9) Set the distance to the canalicular surface as close to the cell membrane as possible 
and then select “Generate Colocalization Channel” to create a new channel containing 
signal from only the canalicular sprouting regions 

a. In order to prevent undercounting from merging of signal from adjacent canaliculi, 
signal from the cell membrane may be removed prior to attempting colocalization 
(Fig. 3.6J). 

i. Use the initial “Cells” surface from step 4 to create a mask on top of the 
segmented cellular channel. Set voxels inside to zero. This creates a 
channel of only canalicular signal. Use this within the colocalization tool 
instead of the version containing the cell membrane. This will allow you to 
set your colocalization point to the exact edge of the sprouting region 
without merging adjacent canaliculi (Fig. 3.6K) 

10) Return to the 3D viewing menu to visualize sprouting regions in 3D with the cell body 
surface model to ensure features have been captured in all dimensions (Fig. 3.6L).  

11) Create a final new surface object this time using the new colocalization channel as the 
source image. (Fig. 3.6M) 

a. Use the size exclusion step of the surface creation wizard to remove small 
features less than 3-4 pixels. 

b. When the new surface is finalized, highlight it and navigate to its statistics sub -
menu (bottom left, graph icon) and record the number of individual objects. This 
is the number of canalicular sprouts for that single analyzed cell 

12) Repeat this process, steps 6-11, for 3-5 cells within your image. 
13) Analyze as much as 10 individual cells from across 2-3 volumes from a single animal. 

This number averaged is considered 1 biologic replicate. 
14) Collect data from 5-8 N / group 
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Figure 3.6: Canalicular Dendrite Segmentation and Quantification at the Sprouting Point 
via IMARIS A) Background subtracted 3D construction of DiI (red) florescent staining of the 
osteocyte network in Imaris. B) Identification and surface renderings of osteocyte cell bodies 
(blue) by size filtering smaller volume canalicular features. C) Cells intersecting the image 
boundaries are removed from the cellular surface models. D) Distance Transformation generates 
a map defining regular distances from the cellular surface models. E) An ROI around a single 
osteocyte is defined to create a surface model of an osteocyte and its associated dendrites in 3D 
(F). G) Raw fluorescent signal segmented from the larger image using the single cell surface 
model as a mask. H) Overlap of single cell fluorescent signal and the Distance Transformation 
map within the Imaris Colocalization Tool identifies canalicular signal (white) at uniform distances 
from the cellular surface. Identification (I) and removal (J) of the cell body (white dashed line) 
florescent signal from the canalicular signal channel (G) prevents merging of signal from adjacent 
canaliculi within the Colocalization tool when the distance along the canalicular regions is 
constricted from an arbitrary distance away from the cell surface (J, blue arrow) to the direct 
location of canalicular sprouting at the cell surface (K, blue arrow). (L) Segmented canalicular 
signal (grey) from sprouting points is visualized in 3D along the cell surface (blue), size filtered to 
remove small and large aberrations, and rendered as 3D surfaces (M) for quantification of 
canalicular dendrite sprouts per single osteocytes. 
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V - Evaluation of the Bone Extracellular Matrix 

PLR plays a critical role in maintaining bone quality, at least in part through its effects on 

the organic and mineral components of the bone extracellular matrix105. The unique physical 

features of collagen and mineral afford opportunities to monitor their composition and organization 

in bone and how they are affected by PLR induction or suppression.  

Organic Extracellular Matrix: Observation of collagen organization provides clues to 

osteocytic action. Collagen birefringence is a property that can be assessed using polarized light 

microscopy because of collagen’s naturally ordered structure. Staining with picrosirius red, an 

anionic dye that binds to cationic collagen fibers, enhances this birefringence under polarized 

light106,107. Using this technique, we and others find that PLR suppression due to MMP-deficiency, 

glucocorticoid treatment, or aging29,40 disrupts the normally aligned lamellar arrangement of 

collagen. In some but not all cases, PLR suppression in mouse models or in human disease 

correlates with reduced collagen alignment and reduced bone quality37. Indeed, these changes in 

collagen organization with PLR suppression are apparent even in situations where remodeling by 

osteoclasts and osteoblast is sufficiently intact to retain normal bone mass. The causal 

relationship between PLR and collagen organization remains an area of active investigation. 

Mineralized Extracellular Matrix: Osteocytes also actively engage in the management of 

mineral. Mineral resorption by osteocytes has been confirmed in studies of lactation, PTH 

treatment or regulation, and in disease models such as chronic kidney disease, Vitamin D 

deficiency, and hypophosphatemia16,33,35,108. While several enzymes are thought to be active in 

the process of mineral regulation, most evidence of lacunar resorption focuses on the idea that 

osteocytes dynamically regulate the pH within the perilacunar fluid between the cell membrane 

and the bone mineral surface to exert control over the mineral environment30. In addition, multiple 

imaging techniques reveal enlarged osteocyte lacunar size during resorption events (i.e. lactation) 

and lower bone mineral density. These effects are rapidly reversed once resorption pressure is 

lifted (i.e. weaning), implying osteocyte-specific deposition of mineral30. 
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In vivo administration of small fluorescent molecules that associate into depositing bone 

has long been used for spatiotemporal visualization of bone mineralization at periosteal and 

endosteal surfaces. Fluorescent labels also confirm osteocytes’ ability to participate in bone 

formation26. Double fluorochrome labeling has been a useful approach to assess the dynamics of 

bone formation by osteoblasts and the calculation of the bone formation rate 16,57,66. However, the 

timing of fluorochrome administration has yet to be optimized for the reproducible visualization of 

osteocyte-specific mineral deposition in homeostatic PLR. For example, fluorescent labeling in 

post-lactating mice show osteocyte-specific deposition of mineral16; however, virgin and non-

lactating controls did not show double labelling. These findings imply that lactation represents a 

significant change to osteocyte remodeling behavior and not homeostatic PLR, and that this 

technique may not yet be optimized to observe homeostatic changes in matrix deposition and 

resorption, which may be more rapid or subtle. 

Other methods that have been used to observe the mineralization state around lacuna 

and osteocyte canaliculi16,35 include X-ray computed tomography imaging, X-ray diffraction and 

absorption, and several forms of electron microscopy. These methods rely on differing attenuation 

of signal from radiation sources by the different elemental constituents within the bone. Changes 

in the mineralization of the perilacunar and pericanalicular bone matrix indirectly give important 

insight into osteocyte function. Nonetheless, these methods are insensitive to changes in cells or 

matrix that occur only in the organic phase. Care must be taken to integrate information derived 

from radiographic approaches with that derived from cellular and histological outcomes. 

X-ray based imaging is the most common method used to observe changes in the 

mineralized portions of bone due to its high energy and very low wavelengths. Micro-computed 

tomography (µCT) scanners with voxel sizes of a few microns can identify osteocyte lacunae. 

More advanced µCT imaging is beginning to push the resolution of these techniques from the 

microscale (500 nm) into the nanoscale (50 nm)12,109, which is needed to resolve individual 
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canaliculi (200-350 nm). These nanoscale approaches are for small specimens (16 µm2 field of 

view). Synchrotron radiation Micro-Tomography (SRµT) techniques can reliably capture larger 

segments of the LCN (40 mm2) and provide qualitative and quantitative outcomes of matrix 

mineralization and lacunar size and shape37,67. The best SRµT beamlines can resolve detail down 

to the canalicular level (30-40 nm with a field of view of as much as 75-80 µm2)110. However, these 

SRµT approaches are time consuming, computationally intensive, and require specialized use of 

synchrotron light sources not accessible to all researchers39,103,104. Especially since access to 

these resources is limited, we advocate adoption of online digital data-sharing practices to make 

these valuable and large SRµT datasets publicly available through established repositories 

including the Materials Data Repository hosted by National Institute of Standards and Technology 

(NIST), or other third-party repositories i.e. TomoBank111. This approach would expand access to 

any investigator to develop and apply new analytical tools to answer the many remaining 

questions about PLR.  

Several other specialized Electron Microscopy and X-Ray techniques have also been 

used to study the osteocyte LCN. Some of these include ptychographic X-ray CT, transmission 

X-ray microscopy CT, serial-focused ion beam SEM (serial FIB SEM), serial block-face SEM (SBF 

SEM), back scatter SEM, surface relief (acid etching) SEM, and others as extensively reviewed 

elsewhere34,39,70,112,113. Even as the field advances through application of these approaches, 

additional investigation is needed to understand how changes in these imaging parameters relate 

to changes in the cellular function of osteocytes at homeostasis, in metabolic stress, and in 

disease.  
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VI - Future Directions  

Answering the many questions about osteocytic perilacunar/pericanalicular bone 

remodeling will require the systematic and integrated application of approaches described here, 

as well as new and more sophisticated in vivo and in vitro outcomes. In particular, additional 

research is needed to elucidate the cellular mechanisms responsible for morphological changes 

that are apparent using histologic and radiographic approaches. Such studies may reveal distinct 

functional roles for perilacunar vs pericanalicular remodeling, peri-osteocytic acidification vs 

proteolysis, or remodeling of the mineral vs organic phases of the peri-osteocytic bone matrix.  

 Improvements to current methods that could be particularly helpful include robust 

algorithms to facilitate efficient and quantitative analysis of the LCN in 2D and in 3D. Though 

many groups have worked intensively to achieve automated detection and quantification of the 

LCN, this goal remains elusive at this time. Standardized use of common LCN parameters would 

facilitate comparison across studies. 

 Continued advances in imaging will provide a critical foundation for asking more 

mechanistic questions. This includes more widespread availability of µCT with nanometer length 

scale resolution, so that lacunar and canalicular networks can be visualized and quantified across 

larger fields of view. Utilization of fluorescent stains, reporter proteins114, and 

immunofluorescence, along with specimen clearing and advanced microscopy, would improve 

our ability to relate structural features to important biological outcomes. Approaches to monitor 

pH at high spatiotemporal resolution in vivo and in vitro would complement current outcomes. 

These approaches could be applied to discern cellular or molecular changes in vivo upon PLR 

induction and suppression, particularly in the presence of gain and loss of function perturbations, 

or disease-inducing or resolving interventions. 

 Finally, application of unbiased approaches such as RNAseq and mass spectrometry may 

be helpful in the identification of specific new RNA or serum markers of PLR. An ideal marker 
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would be osteocyte-specific, have a functional role in matrix remodeling, and be dynamically 

regulated with PLR. Not only would these markers improve the precision of research efforts to 

understand PLR, but they could also support the identification of new diagnostics of skeletal 

disease or therapeutic interventions to prevent it. Given the role of PLR in skeletal metabolism, 

bone fragility, joint disease, and aging, our collective efforts to better understand osteocytic 

remodeling could have significant clinical impact. 

 

* Protocols discussed and outlined herein may be found at the Alliston Laboratory website: 

https://allistonlab.ucsf.edu 
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Chapter 4: Disrupted 
Osteocyte Connectivity 
and Pericellular Fluid Flow 
in Bone with Aging and 
Defective TGFb Signaling 
 
Introduction 

Age-related bone fragility results from the concomitant decline of bone mass and bone quality 

over a lifetime. Deregulation of osteoclast and osteoblast function with age contributes directly to 

this bone fragility, especially the loss of bone mass1,2.  Although osteocytes comprise 90-95% of 

all bone cells, relatively little is known about their role in the age-related decline in bone health.   

Osteocytes reside within the bone matrix in a series of cavities and channels, known as the 

lacunocanalicular network (LCN)3,4. Within the LCN, osteocytes act as master regulators of bone 

health by supplying nutrients to other osteocytes distal to the vasculature, by coordinating the 

activity of osteoblasts, osteoclasts, and other cell types to balance bone deposition and 

resorption5,6, by sensing and responding to mechanical forces7, and by actively remodeling their 

surrounding bone matrix via perilacunar/canalicular remodeling (PLR) 8–10. Recent advancements 
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in optical imaging have provided morphologic evidence for the degeneration of the LCN and the 

osteocyte network with age11–13, but how these architectural changes to the osteocyte network 

impact aged bone health remains unclear. 

 Aged bone demonstrates several defects including losses in mechanostimulation14, 

uncoupling of bone deposition and resorption1,2, alterations to bone material properties15,16, and 

degeneration of the LCN17. Mechanical load applied at the organ scale compresses the 

mineralized bone tissue, driving interstitial fluid flow through the organic pericellular matrix that 

lines the mineralized walls of the LCN18–21, with the resulting fluid-induced stresses and strains in 

osteocytes transduced into biochemical cues. Osteocytes respond to fluid flow with increased 

expression of  bone anabolic genes and a corresponding increase in bone formation in young, 

murine tibial loading studies22. However, bones from middle-aged mice experience tempered 

responses to load that progressively worsen with age1,14,23,24. Additionally, osteocytic PLR 

maintains bone matrix material properties, one of several aspects of bone quality that decline with 

age, leading to the increased risk of fragility fractures in elderly individuals, even those with 

clinically normal bone mass8,9,25–28. Age also takes a toll on the osteocyte LCN, with a loss of 

canaliculi and changes in lacunar geometries in old bone11,13,29. Similarly, microcracks caused by 

fatigue loading can cause severe localized damaged to the LCN, with a loss of connectivity and 

nutrient supply leaving local osteocytes vulnerable, and preventing local adaptive remodeling30. 

Because osteocytes rely on the LCN for mechanosensation and for coordinating bone remodeling 

to maintain bone mass and quality, we hypothesized that the age-related degeneration of the LCN 

plays a causal role in the decline in bone health and increased skeletal fragility in aging.   

 Several hallmarks of aged bone also appear in bone from mice with limited transforming 

growth factor beta (TGFb) signaling, including impaired mechanical adaptation, poor bone quality, 

and LCN degeneration. First, in mice that express a dominant negative version of TGFb receptor 

type II (TbRII), bone apposition in response to loading was significantly impaired compared to wild 
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type controls, implicating intact TGFb signaling in the anabolic response of bone to mechanical 

stimulation31. Second, osteocyte-intrinsic ablation of TbRII (TbRIIocy-/-) causes severe bone quality 

defects without meaningful changes to cortical bone mass, including reduced fracture toughness9. 

Third, silver nitrate staining of the LCN shows that bones from TbRIIocy-/- mice have a shortened 

canalicular phenotype, which is attributed to the coordinated repression of genes required for 

PLR, such as MMP13, MMP14, and Cathepsin K9,32. Thus a similar set of bone phenotypes arise 

from the systemic effects of aging and from the osteocyte-intrinsic effects of TbRII ablation. 

However, the extent to which these similarities are mechanistically related remains unclear.  

Either way, given the importance of TGFb in fracture repair, osteogenesis imperfecta33, Camurati 

Engelman disease34 (CED), and other human skeletal syndromes35, understanding the role of 

TGFb in maintaining the LCN and bone strength may give new insight to clinical bone fragility. 

 Functional analysis of the osteocyte LCN faces challenges in isolating and manipulating 

specific LCN features, especially within the complex, mineralized ECM. Here we apply 

quantitative in silico approaches to probe the function of osteocyte networks, visualized deep 

within cortical bone using confocal laser scanning microscopy11–13  We test the hypothesis that 

LCN degeneration, whether due to systemic aging or osteocyte-intrinsic TGFb deficiency, 

compromises osteocyte mass transport and mechanosensation. Unraveling the functional 

consequences of LCN degeneration could advance the search for therapeutically tractable 

mechanisms to improve bone mass or bone quality with age.    

 

Results 

Suppressed TβRII levels and canalicular architecture in aged and TβRIIocy-/- bone.                  

The reported degeneration of the LCN with aging11,17 led us to examine the effect of aging on 

skeletal gene expression in osteocyte-enriched cortical bone. We used Nanostring arrays, 

including a custom array of over 800 genes associated with skeletal cell differentiation, 
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extracellular matrix (ECM) remodeling, and relevant signaling pathways such as Wnt, PTH, and 

TGFb. Relative to young mouse cortical bone (2 mo), genes implicated in ECM remodeling and 

TGFb signaling were among the most strongly repressed in aging (36 mo) (Fig. 4.1A). The age-

dependent LCN degeneration corresponded with the repression of MMP13, MMP14, and other 

ECM remodeling enzymes implicated in osteocyte perilacunar/canalicular remodeling (PLR), a 

process that supports the maintenance of the LCN8–10,32. Investigation of all genes within the TGFb 

signaling KEGG pathway included in the Nanostring arrays showed systematic deregulation of 

TGFb signaling with aging (Fig. 4.1A, 4.1B, black bars). The most significantly repressed genes 

are those encoding the canonical TGFb R-Smad (Smad3) and TGFb target genes Smad6 and 

Ski.  Systemic aging also leads to the repression of the TGFb type II receptor in bone, with a 

magnitude comparable to that observed in mice with genetical ablation of a floxed Tgfbr2 allele in 

osteocytes under control of 10 kb DMP1-Cre, relative to Cre-negative controls (Fig. 4.1B, grey 

bars).   Also like aging bone,  bone from these TbRIIocy-/- mice also expresses low levels of MMP13 

and MMP149.  

 Whether due to aging or to osteocytic Tgfbr2 deficiency, the deterioration of the osteocyte 

LCN is evident.  Staining of the LCN in paraffin sections shows the sparse canaliculi in old or 

TbRIIocy-/- bone relative to young or TbRIIctrl bone (Fig. 4.1C-F). Quantitative analysis shows that, 

relative to their controls, the average canalicular length is reduced in both old and TbRIIocy-/- bone, 

and statistically indistinguishable between each other (Fig. 4.1G).  Therefore, to understand the 

functional impact of LCN degeneration, resulting either from systemic aging or from osteocyte-

intrinsic defects in TGFb signaling, we evaluated LCN structure and function in each of these two 

mouse models.  
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Figure 4.1: Aged and TβRIIocy-/- bone share molecular and canalicular morphologic 
changes. A) Volcano plot of 800+ genes from nanoString panels shows downregulation of genes 
involved in matrix interaction and remodeling in aged bones. B) Log2 expression fold change of 
TGFβ signaling pathway genes from nanoString showing systemic regulation with age (36 mo. 
N=4 vs 2 mo. N=3, black bars). RNA from TβRIIocy-/- bone shows significant repression of only 
Tgfbr2 (TβRIIocy-/- vs TβRIIctrl  N= 4 ea. grey bars). * significant effect wrt. age, # significant effect 
wrt.TβRIIocy-/-, * p< 0.05, ** p<0.01, *** p< 0.001 by student’s t-test. Silver nitrate staining (C-F) of 
the osteocyte lacunocanalicular networks  showing shortened canalicular lengths in 2D at 36 mo. 
(N=4) or with disrupted TGFβ signaling (N=5). Young C57BL/6 mice (n=4) showed no significant 
differences in canalicular length to TβRIIctrl mice (n=6), additionally mice with ablated TGFβ 
signaling showed no significant differences from aged mice *,+ indicates Tukey corrected p value 
to 2 mo. C57BL/6 mice or 2 mo. TβRIIctrl mice respectively (G) ** p<0.01, *** p< 0.001, **** p< 
0.0001. Maximum z-projections (H-K) of a single plane of osteocytes (~12 μm). Scale bar = 20 
μm. (L-O) 3D reconstructions of 75 x 75 x ~35 μm sections of LCN captured by confocal imaging 
showing loss of canaliculi and canalicular organization in aged (I,M) (N=6) and TβRIIocy-/- (K,O) 
(n=6) mice compared to 2 mo. WT controls (H,L) (N=4) and 2 mo. TβRIIctrl mice (J,N) (n=6) 
respectively. Quantification of LCN parameters completed in 3D within a 30 μm thick selection (P-
T) shows similar changes in aged and TβRIIocy-/- bone, with the exception of osteocyte area density 
(Q) showing loss of cell bodies in only aged bone. * p<0.05 by students t-test to proper control.  
 

 Limitations of visualizing this elaborate three-dimensional network in thin paraffin sections 

led us to examine the LCN using fluorescent confocal microscopy of thick cleared cortical bone 

sections (Fig. 4.1H-O).  These detailed three-dimensional images strikingly reveal the loss of 

canalicular density and organization in aged or TbRIIocy-/- bone.*  Quantitative analysis of these 

images shows that the shortened canalicular phenotype of old or TbRIIocy-/- bone, apparent in 

paraffin sections (Fig. 4.1G), in part results from canaliculi bending in and out of the focal plane 

due to increased canalicular tortuosity, ., (Fig. 4.1P). 

 Consistent with previous findings, canalicular architecture is altered by defective TGFb 

signaling without changes to lacunar number as previously noted by Synchrotron radiation Micro-

Tomography (SRμT)9, but both lacunar and canalicular features deteriorate with age11,13 (Fig. 

4.1Q,R). Analyses of canalicular features revealed similar patterns of canalicular alterations  in  

aged and TbRIIocy-/- bone relative to controls, with reduced canalicular dendrite numbers (Fig. 

4.1R) observed through Imaris-aided quantification of the direct canalicular sprouting point before 

 
* https://movie-usa.glencoesoftware.com/video/10.1073/pnas.2023999118/video-1 
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the first bifurcation as well as reduced LCN volume fraction and increased canalicular spacing 

(Fig. 4.1S-T). How these changes to osteocyte canalicular architecture precisely impact cellular 

performance is unknown.  

 

Maintenance of network architecture but loss of nodal interactions with age and TGFβ 

signaling disruption 

Given the challenges in manipulating and observing osteocyte networks in vivo and in vitro, we 

applied in silico approaches to probe the functional implications of LCN degeneration on osteocyte 

connectivity, mass transport, and mechanosensitivity. First, using network scale connectomic 

analysis, a non-dimensional collection of nodes and edges is constructed on top of 3D osteocyte 

networks derived from bone of young and old, or TbRIIctrl and TbRIIocy-/- mice (Fig. 4.2A)36,37.  

Nodal analysis provides important insight into the prevalence and type of canalicular junctions, 

which can impact solute transport and fluid mechanics38.   

 Although the average number of nodes was decreased in both the aged and TbRIIocy-/- 

models compared to young or Cre-negative controls (Fig. 4.2B), underlying aspects of network 

architecture are unaffected by LCN degeneration.  For example, mean node degree (n), a 

measure of network architecture that reflects the number of connected nearest neighbors, is equal 

across all groups, when excluding end-point nodes (Fig. 4.2C, left), emphasizing high level 

maintenance of network organization. Furthermore, while the osteocyte density within the 

connectomes was kept constant to prioritize canalicular path behavior (Fig. 4.2D) the primary 

node types (t and c nodes) remain proportionally constant with age or with TGFb-deficiency (Fig. 

4.2E-F). However, increases in the number of end-point nodes in the LCN of aged and TbRIIocy-/- 

bone stratified them from their controls (Fig. 4.2G). The increase in end-point nodes (n=1) in aged 

and TbRIIocy-/- networks significantly affects LCN architecture by lowering the mean node degree 

(Fig. 4.2C, right) by identifying an increase in non-functional path choices where canaliculi  
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Figure 4.2: Nodal analysis shows maintenance of network architecture but loss of total 
network interactions with age and TGFβ signaling disruption in osteocytes. Individual node 
classification (A) from connectomic analysis of the LCN from skelentonized confocal images 
shows a dramatic loss of total identified nodes (B) in aged and TβRIIocy-/- bone compared to 
controls. Mean node degree (connections per node) without considering end-point nodes (C, left) 
shows maintenance of the underlying network architecture even with degeneration. In contrast, 
inclusion of end-point nodes (C, right) demonstrates the detrimental effect of disjointed paths in 
the network. While maintaining equal osteocyte number within volumes studied (D), the relative 
proportion of branch-like t nodes (E) and cluster-like c nodes (F) persisted across all models, 
while there was an increase in the proportion of end-point nodes (G) in degenerated models. 
Canalicular branching identified through segmentation in expanding concentric positions away 
from the cell body (K) reveals degenerated models showed specific loss of canalicular number at 
the sprouting point (H, yellow arrows) but continued to branch normally at the first region of 
bifurcation (I, dashed yellow) and again further into the network (J, yellow). * p<0.05 to young, 
WT controls. N=5 for all groups. 
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terminate within the matrix without reconnecting to the network, revealing higher numbers of 

discontinuities at the termini of canaliculi in degenerated models. Investigation of branching 

through segmentation of canalicular features at regular concentric distances  

away from the cell body (Fig. 4.2K) shows that, although degenerated models lose canalicular 

number at the root (Fig. 42H), remaining canaliculi in the aged and TbRIIocy-/- models expand at 

similar rates to controls within the first region of canalicular bifurcation (Fig. 4.2I, white) and again 

at further into the network (Fig. 4.2J, yellow).Therefore, as the LCN ages in cortical bone, rather 

than changing canalicular organization and adopting a more web-like state as found in woven 

bone36,37,39, it undergoes pruning by which dendrites retract or degenerate, but branching near 

cell bodies is unaffected.  

 

Aged and TβRIIocy-/- osteocyte networks have impaired transport capabilities 

While higher-order LCN structure is preserved with age and TGFb disruption, the loss of canaliculi 

and canalicular junctions may limit fluid and solute movement. If mass transport through the LCN 

is compromised, it could influence osteocyte nutrient exchange and the ability of osteocytes to 

signal with one another and with other cell types. Therefore, to determine the effect of LCN 

degeneration on mass transport, we applied Betweenness Centrality (BC) analysis to the LCN 

connectomes of young and old, TbRIIctrl and TbRIIocy-/- bones. BC is defined as the fraction of 

shortest paths within a network running through any particular node (Fig. 4.3E) where high BC 

scoring nodes represent heavily used paths (Fig. 4.3A-D). Nodes that appear in at least 1% of 

paths within the connectome are shown in color, with red nodes being the most heavily utilized. 

 Using BC analysis, we find that with age or osteocytic TGFβ-deficiency, the number of 

available paths is reduced, with the obvious consequence that remaining paths are much more 

heavily utilized.  Specifically, the proportion of nodes scoring above the 1% threshold is increased 

in the LCN of aged and TbRIIocy-/- bones compared to their young and TbRIIctrl controls (Fig. 4.3F).  
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Figure 4.3: Aged and TβRIIocy-/- osteocyte networks have limited pathway availability and 
lower transport capabilities in in silico connectomic models. Projection of 3D skeletonized 
maps of the LCN with nodes color-mapped to their individual betweenness centrality (BC) values 
(A-D). Colorbar indicates BC score for individually plotted nodes.  Higher BC scoring nodes align 
to show heavily used pathways within the network (BC>0.01), with a higher fraction in 
degenerated models (F) indicating more limited pathway choice. See Supplemental Videos 2 & 3 
for 3D representation. Comparison of transport capacity within bone from the skeletonized-
connectomic network models show an increase in non-dimensional diffusive speed gain (G) in 
networks of young, control bones compared to respective degenerated models (H). This is 
primarily driven by a decrease to canalicular length density (I) in degenerated models increasing 
distance to the LCN from the  matrix (dLC ,J) rather than an increase in distance to the nearest cell 
directly through the matrix (dL,K) or from points within the LCN to the nearest lacuna through the 
network (dnet, ,L). * p <0.05. N=5 for all groups. 
 

Low scoring nodes (blue, BC=0.01-0.1) abundant in healthy, young bone, dissipate in the 

degenerated models indicating fewer available paths for mass transport within the networks. In 

contrast, fewer paths exist in old or TbRIIocy-/- bone and are much more heavily utilized (yellow-

red, BC>0.1), features that are readily apparent in videos showing BC values within the 3D 

connectomes.* Therefore, the greater reliance on fewer pathways with age is a feature of these 

compromised networks.  

 We next modeled the effect of LCN degeneration on its ability to complete a diffusive task 

using measured network distances and physical diffusion constants (Fig. 4.3G). With a smaller 

diffusive speed gain than controls, the aged LCN has diminished ability to shuttle material through 

the network (Fig. 4.3H).  The effect of aging on the diffusivity of the LCN was almost identical to 

that resulting from osteocyte-intrinsic loss of TGFβ signaling (Fig. 4.3H).  In both cases, the 

diminished diffusivity is largely due to the decreased canalicular density (Fig. 4.3I). With ~40% 

lower canalicular length-density, the distance a molecule must travel to get from the ECM to the 

LCN (dLC, Fig. 4.3J) is significantly increased in degenerated networks compared to their 

respective controls. Other variables that affect diffusive speed gain (dL and dnet Fig. 4.3K-L) 

remain unchanged by LCN degeneration in these models. Intuitively, this analysis shows that, of 

 
* https://movie-usa.glencoesoftware.com/video/10.1073/pnas.2023999118/video-2 
  https://movie-usa.glencoesoftware.com/video/10.1073/pnas.2023999118/video-3 
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the many LCN features disrupted by aging or osteocytic TGFb-deficiency, including canalicular 

number and tortuosity, the loss of canalicular number or density is the most important driver of 

the reduced diffusivity in this model.  

 

Fluid dynamics modeling demonstrates lower fluid velocity and shear stress as a function 

of pericellular space volume and not canalicular tortuosity 

Given the importance of the LCN for osteocyte mechanosensation, we sought to determine how 

LCN fluid flow shear stress changes following LCN degeneration, due to either systemic aging or 

osteocyte-intrinsic suppression of TGFb signaling. To that end, we used computational fluid 

dynamics to model load-induced interstitial fluid flow within the pericellular space (PCS) 

surrounding single osteocytes (Fig. 4.4A). Standard PCS volumes were modeled from the same 

set of confocal fluorescence images of osteocyte networks from young and old, and TbRIIctrl and 

TbRIIocy-/- bone (Fig. 4.4B). Computational complexity limited our analysis to individual 

osteocytes, which were segmented consistently to eliminate confounding local features, such as 

blood vessels. Using these models, we can easily modify the dimensions of the PCS 

parametrically to mimic volume changes caused by the suppression (0.5x, Fig. 4.4C) or induction 

(2x, Fig. 4.4D) of perilacunar/canalicular remodeling. Even at the single cell scale, the loss of 

osteocyte surface area surface in aged and TbRIIocy-/- bone is still evident (Fig. 4.4E). The 2-fold 

in silico changes in PCS thickness roughly double or half the total calculated volume of the 

modeled LCNs within each group, whereas differences between young and old, or TbRIIctrl and 

TbRIIocy-/- bone account for no more than a 60% change in PCS volume (Fig. 4.4F).  
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Figure 4.4: Finite Element models of individual osteocytes. A) Meshing of individual 
osteocytes and (B) modeling  of surrounding pericellular space at standard width (0.08 μm)  and 
constricted or expanded  width by a factor of 2 (C,D, 0.04, 0.16 μm respectively). Osteocyte 
surface area (E) varied between controls and degenerated models. Manipulation of PCS 
thickness caused comessurate changes in PCS volume (F) with greater changes within groups 
(age/genotype) at different PCS thicknesses than between groups at the same PCS thickness. 
 

 Modeling of interstitial fluid flow at constant volume and pressure revealed profound 

differences in the shear stress magnitude and distribution in the PCS of old and TbRIIocy-/- 

osteocytes, relative to their young or TbRIIctrl controls (Fig. 4.5A).  Maximum fluid velocities of 

686.95 μm/s around young osteocytes, and similarly 525.70 μm/s for TbRIIctrl osteocytes, were 

approximately double those predicted for osteocytes from aged and TbRIIocy-/- bones, at 242.82 

μm/s and 321.86 μm/s, respectively (Fig. 4.5B). Likewise, maximum shear stresses are 

significantly higher for young and TbRIIctrl osteocytes than for aged and TbRIIocy-/- cells (Fig. 4.5C).  

 These reductions in fluid velocity and shear stress with LCN degeneration could arise from 

several factors, such as changes in canalicular length (Fig. 4.1G), LCN or PCS volume (Fig. 4.1T, 

Fig. 4.4G), or tortuosity (Fig. 4.1Q). Using fluid dynamics modeling we tested the contribution of 

PCS volume and tortuosity to fluid flow shear stress.  We were surprised to find, by modelling 
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fluid flow in individual canaliculi across a range of tortuosity, that increasing tortuosity had no 

significant effect on either fluid velocity or shear stress (Fig. 4.5D). This suggests that osteocytes 

in degenerated networks do not gain any mechanosensitive advantage by generating canalicular 

tortuosity.   

 On the other hand, the expanded PCS volume, and the resulting increased flow rates, 

generated significantly greater maximum fluid velocities than in baseline conditions, while 

constriction of this space had the opposite effect (Fig. 4.5E). Remarkably, PCS expansion 

increased the fluid flow velocity and shear stress predicted for aged or TbRIIocy-/- osteocytes such 

that these values were statistically indistinguishable from young or TbRIIctrl controls at baseline 

PCS volumes (Fig. 4.5F,G). These findings emphasize the importance of PCS volume on 

osteocyte pericellular fluid movement and highlight the potential to rescue impaired osteocyte 

mechanosensation due to LCN degeneration in aging by increasing PCS volume.  
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Figure 4.5: Fluid dynamics modeling demonstrates lower fluid velocity and shear stress 
as a function of pericellular space volume and not canalicular morphology. Visualization of 
streamlines (A) and quantification of fluid flow within the pericellular space (PCS) around single 
osteocytes from both aged and TβRIIocy-/- show significant reductions to fluid velocity and shear 
stress compared to controls (B,C N=5, 3 individual cells per N). In contrast, no appreciable change 
in flow within single canaliculi (D) of varying tortuosities was observed. Parametric modulation of 
PCS volume around the same osteocyte geometries maintains trends between models as seen 
in the base condition, but overall magnitude changes when the PCS is constricted or expanded 
(E). Expansion of the PCS in degenerated models recovers shear stress values to levels 
comparable to young controls at standard PCS volume (F). Streamline visualization of the effect 
of volume modulation (G) shows recovery of shear magnitude for aged osteocytes with an 
expanded PCS volume to that observed for young osteocytes (outlined in orange). * p <0.05. 
 

Discussion 

This study provides the first evidence that the decline of bone health with age is 

mechanobiologically linked to the age-related degeneration of osteocyte lacunocanalicular 

network structure and function. By examining the functional implications of LCN degeneration on 

osteocyte mass transport and pericellular fluid flow, this work informs the biological and physical 

decline of bone during aging and suggests strategies to defend against this loss. Specifically, by 

utilizing a combination of in silico analyses we identified that reductions in canalicular number and 

connections reduce diffusion within the LCN and pericellular fluid velocity, a driver of osteocyte 

mechanosensation.  Connectomics analysis revealed the LCN architectural changes that occur 

with age in cortical bone and how LCN pruning limited pathway availability and mass transport in 

old bone. FE modeling identified that loss of osteocyte canaliculi alone is sufficient to reduce the 

LCN surface area and limit shear mechanostimulation along this surface. Finally, FE modeling 

showed that deficits to fluid velocity and associated shear of aged osteocytes are recoverable by 

increasing PCS volume, even without changing the remaining architecture of the LCN. These 

observations apply whether LCN degeneration results from systemic aging or from a targeted 

defect in osteocytic TGFb signaling. Thus, this work identifies lost fluid dynamics and 

mechanostimulation as consequences of LCN pruning in response to osteocyte TGFb deficiency 
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or aging, and provides evidence that restoration of osteocyte stimulation through pericellular fluid 

flow is physically possible without the need to regrow lost canaliculi. 

A key strength of this study is the ability to distinguish the functional effects of lacunar and 

canalicular changes by comparing LCN degeneration in aging and TbRIIocy-/- mice.  Previous 

studies of the LCN of aged bone note canalicular losses as well as diminished osteocyte number 

and lacunar size11,13,29, confounding the ability to dissect lacunar and canalicular contributions to 

LCN function. On the other hand, TbRIIocy-/- bone lost canaliculi to the same extent as aged bone 

with no change in lacunar number. This finding using optical imaging is similar to previous findings 

in this model using Synchrotron radiation Micro-Tomography (SRμT) documenting no loss to 

lacunar number with TGFb signaling disruption9, highlighting the ability to assess the contribution 

of the canalicular network to osteocyte function and health using this model. Therefore, 

canalicular loss, in either model, is sufficient to compromise key aspects of osteocyte function, 

including mass transport and mechanosensation.  

 As in TbRIIocy-/- bone9, aged bone showed suppression of genes encoding TβRII and PLR 

enzymes. Since PLR supports the maintenance of the osteocyte LCN10,40 reduced TGFb signaling 

may play a causal role in the  age-related degeneration of the LCN. While the molecular 

mechanism responsible for declining TGFb signaling and PLR with age in bone has yet to be 

explored, this work establishes that both aged and TbRIIocy-/- bone share canalicular defects that 

impair the LCN in both form and function. Although the effects of DMP1-Cre/TbRIIfl/fl on osteocyte 

morphology and health have previously been recapitulated through pharmaceutical inhibition of 

TGFb signaling in skeletally mature mice, it is important to note that the constitutive nature of the 

removal of TbRII through DMP1 may also occur in “late-stage” osteoblasts as they begin their 

transition into osteocytes. While this may result in some lingering developmental defects 

impacting the osteoblast-osteocyte transition, and thus unrelated biologically to the aged-related 

loss of canaliculi, the TbRIIocy-/-  phenotype is still canalicular-specific and also subtle compared 
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to other models of altered TGFb signaling within the skeleton where phenotypes are much more 

severe33,34. Additionally, disruptions to TFGb  signaling are independently observed in our 

nanoString analysis of aged osteocytes, including specifically TbRII, supporting the rationale to 

utilize this mouse model in parallel with aged mice. To definitively address the role of TGFb 

signaling in mature osteocytes within the LCN, the use of an inducible Cre mouse without 

additional skeletal effects is desired, while our model is sufficient in understanding the canalicular 

contributions to LCN degeneration. 

 These imaging and computational analyses point to the role of canalicular loss and 

pruning in LCN degeneration in both aged and TbRIIocy-/- bone. LCN pruning can occur prior to, or 

independently of, osteocyte death, since canalicular density is low in TbRIIocy-/- bone even when 

osteocyte density is preserved. Concentric canalicular feature identification showed a primary 

defect of whole canalicular loss in degenerated models while remaining dendrites branch and 

expand normally, while end-point nodal classification identifies pruning at the distal end of 

processes as they withdraw from the network, severing connectivity. Both these alterations to the 

network compromise the size and pervasiveness of the network throughout the bone matrix and, 

along with previous work estimating the size limit for particle diffusion through the LCN of 

40kD41,42, compromise osteocyte function. This is supported by our findings that predict a 30-45% 

reduction in the speed of particle movement through degenerated networks. These limitations to 

mass transport within bone impact all three major bone cell types since osteocytes rely on the 

LCN for nutrient supply25 as well as for signaling to osteoclasts and osteoblasts. Thus canalicular 

morphology is altered in multiple ways, raising further questions about the different biologic 

processes that control different aspects of canalicular morphology and how this may impact 

cellular crosstalk, bone remodeling, and the decline in bone mass and bone quality with age43. 

 Fluid flow within the LCN is a primary mechanism by which mechanical stimulation drives 

bone anabolism, a response that is diminished in aged bone44 that additionally depends on 
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canalicular path availability. While fluid shear stress has previously been postulated to stimulate 

osteocytes, as is presented here as a functional outcome/defect, it is likely that the fluid stimulation 

occurs via fluid drag-induced strain at molecular attachments and focal adhesions along 

canalicular dendrites and the canalicular wall42,45. Therefore the changes in velocities reported 

here likely have commensurate effects on the strain stimulation of the osteocytes, as has been 

shown in previous modelling studies19,46–48. While losses of osteocyte cell bodies and changes to 

lacunar geometry towards smaller and rounder lacunae with age13,49 have already been implicated 

in reduced fluid flow in the LCN50, here we report complementary canalicular changes with age. 

Given that the osteocyte canaliculi is predicted to be the primary mechanosensing portion of the 

LCN50,51 knowledge of which of these geometric changes most diminishes fluid flow remains a 

significant knowledge gap.  

 Our prior work, using idealized canalicular models, predicted that tortuosity would slightly 

increase localized mechanical stimulation19. Thus, we hypothesized that the increased canalicular 

tortuosity may allow aged or TbRIIocy-/- osteocytes to increase local mechanical stimulation. 

Stream line plots qualitatively identified local regions of enhanced fluid shear around canalicular 

bends, but these hotspots were insufficient to overcome the greater loss of fluid velocity and shear 

stimulation caused by canalicular loss. Because these models applied a uniform baseline PCS 

thickness of 0.08 µm, derived from prior studies, the effects of other known local changes in 

canaliculi are undetectable in this model, such as canalicular hillocks near tethering 

elements42,52,53. Nonetheless, these models demonstrate the importance of LCN surface area and 

canalicular loss on fluid stimulation.  

 Despite localized increases in canalicular shear, we were surprised to find that the severe 

bending of canaliculi in aged and TbRIIocy-/- bone is insufficient to overcome the losses in physical 

stimulation in the models caused by the broader degeneration of the LCN. Inclusion of 

proteoglycan tethering elements may reduce the magnitude of lost stimulation in these models52. 
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However, since mechanostimulation at either the surface of the canalicular dendrite or on 

perpendicular tethering elements will increase or decrease with flow velocity, this finding refutes 

the idea that control of canalicular geometry alone is a meaningful way to restore lost mechanical 

stimulation with age driven by the broader loss of LCN volume that is the result of pruning.   

 On the other hand, osteocytes have the capacity to modulate the size and quality of their 

pericellular space through PLR10,54.  For example, relative to bone from virgin control mice, 

canalicular diameter increases by 20-30% with lactation, and returns to baseline after weaning54, 

demonstrating expansion and constriction of the local PCS. Our fluid dynamics modeling 

demonstrates the important functional implications of changing PCS diameter through a process 

like PLR. First, a 50% constriction of the young wild type osteocyte PCS renders a shear stress 

that matches aged and TbRIIocy-/- osteocytes at baseline PCS thickness.  Second, doubling the 

PCS of aged and TbRIIocy-/- osteocytes returned shear stress to levels that were indistinguishable 

from young or wild type controls How these changes to the PCS impact the proteoglycan-rich 

PCM and its modulation of local fluid drag or tensional homeostasis55 remains to be determined. 

Nonetheless, control of the pericellular space, possibly through PLR, presents a mechanism by 

which osteocytes can homeostatically adapt their mechanical microenvironment to reclaim 

meaningful amounts of lost physical stimulation in age and disease, although further resorption 

of bone would need to be carefully considered in osteoporotic cases. 

 This in silico work highlights the opportunity to overcome experimental complexities 

inherent in studying the relationship between osteocyte LCN structure and function. Of the many 

LCN features sensitive to age11,17 or TGFb-deficiency9, these computational models allowed us 

to identify those that are most important for the impaired mechanosensitivity of bone in each 

model14,38,48. Given the important role of PCS volume, agents that regulate PLR emerge as 

potential therapeutic candidates to restore function lost in aged bone and motivate further study. 
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Chapter 5: The Role of 
TGFβ-regulated Osteocytic 
Perilacunar/canalicular 
Remodeling in Age-related 
Bone Fragility 
 
Introduction 

Age-related bone fragility is the consequence of changes to material, cellular, and molecular 

mechanisms controlling both bone mass and bone quality over a lifetime. While age-related 

imbalances to the behaviors of osteoblast and osteoclasts, the bone lining cells responsible for 

depositing and resorbing bone respectively, are direct causes to age-related bone loss and 

osteoporosis, mechanisms controlling bone quality with age are less well understood. 

Consideration of bone quality is key in understanding age-related bone fragility and preventing 

fracture because losses to bone mass alone are not entirely predictive of fragility fracture in aged-
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populations and even individuals receiving treatment for bone loss can still exhibit fragility fracture 

despite meaningful increases to bone mass1,2.  

Bone quality consists of a collection of several interconnecting parameters including bone 

microarchitecture, bone tissue material properties, alterations to the chemical composition of 

bone, microdamage, and others3,4. Thus, bone quality and the age-related changes to it spring 

from the fundamental changes to bone organization, matrix material properties, and nanoscale 

mechanics. Targeting and understanding bone quality at the molecular scale offers potential new 

avenues to advance fracture prevention in the absence of bone mass deficits and will help close 

the gap of understanding behind the cellular and material mechanisms that lead to molecular 

bone aging and its resultant fragility. 

 Transforming growth factor beta (TGFβ) is one of the few known molecular regulators of 

both bone mass and bone quality, exerting its effects through its action on all members of the 

bone remodeling unit3,5–8. Alterations to TGFb signaling within the skeleton can lead to dysplasia 

and increased fragility in diseases including osteogenesis imperfecta and Camurati-Englemann 

disease9,10. TGFb is deposited within the bone matrix by osteoblasts and osteocytes and released 

upon osteoclastic resorption. Liberated and activated from the bone matrix, TGFβ has multiple 

cellular targets within the skeleton impacting osteoclast differentiation, recruitment, and function 

and survival6 and osteoblast proliferation and migration8,11 helping balance both bone resorption 

and formation12,13. The role for TGFb in osteocytes regulates homeostatic perilacunar/canalicular 

remodeling (PLR), by which osteocytes both resorb and replace their surrounding bone matrix in 

a dynamic process that supports bone quality and fracture resistance14–16. While hypothesized 

changes to TGFb signaling with age are thought to be linked to imbalanced osteoclast and 

osteoblast action and thus bone loss with age17, the role of TGFb-directed osteocyte 

perilacunar/canalicular remodeling in maintaining aspects of bone quality with age are unclear. 
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Previously, in a model of disrupted TGFb signaling in osteocytes through removal of the 

TGFb receptor type II (TbRII) by Cre recombinase expressed under control of the DMP1 promoter, 

young male mice demonstrated several alterations to bone quality that resemble hallmarks of 

age-related bone fragility. Osteocyte-intrinsic ablation of TbRII (TbRIIocy-/-) resulted in severe bone 

quality defects without meaningful changes to cortical bone mass, including reduced fracture 

toughness similar to age-related bone fragility16. 3D visualization of the osteocyte 

lacunar/canalicular network (LCN) revealed that bones from TbRIIocy-/- mice have increased 

canalicular tortuosity and lower canalicular number, cellular defects similarly found in aged 

bone18,19. The degeneration of the osteocyte LCN within TbRIIocy-/- males occurred alongside 

coordinated repression of genes required for PLR, such as MMP13, MMP14, and Cathepsin K. 

Transcriptional arrays performed on osteocyte-enriched cortical bone RNA from wild-type aged 

mice showed lower expression of matrix modifying enzymes such as MMP13, MMP14 and Loxl2, 

among many others19. Results from this experiment also demonstrated systematic repression of 

the TGFb signaling pathway in the bones of aged male mice. Thus, osteocyte-intrinsic repression 

of TGFb signaling and the repression of PLR generates an “aged” brittle bone phenotype while 

aged bone displays lost activity within this same pathway hinting at a shared molecular 

mechanism.  

 Age-related fracture incidence and risk displays a large gender disparity with some 

estimates of increased fracture incidence in females as much as three times higher than men20–

22. While much of this difference can be accounted for by differences in bone mass through 

differences in peak bone mass accrual, mature bone size, and an earlier decline in bone mass 

with age in females than males23,24, approximately half of age-related hip fractures in women do 

not occur in individuals with low bone mass2. This highlights the importance of understanding the 

contribution of bone quality towards fracture resistance specifically in females, especially in the 

light of evidence that the osteocyte LCN, whose integrity is linked to bone quality and cellular 
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function and is maintained by PLR19,25, degenerates more rapidly with age in females than in 

males18,26,27 emphasizing sexually dimorphic aging in osteocytes. Interestingly, female TbRIIocy-/- 

mice do not exhibit the same bone quality defects at young ages as their male counterparts. 

However, females did fail to induce further PLR during lactation, a metabolic challenge during 

which PLR is used to liberate calcium from the bone mineral for milk production14,28. The lack of 

this homeostatic mechanism in mutant reproductive age females raises additional concerns about 

PLR’s contributions to declines in bone strength later in life, suggesting that the loss of TGFb-

directed PLR may be critical in the material decline of bone in aging females.  

 Age-related bone fragility in both sexes has been independently associated to stiffening 

of collagen within the bone matrix through increased crosslinking in the form of advanced 

glycation end products29,30 (AGEs). These direct changes to the bone collagen matrix, among 

other chemical alterations, contribute to the reduced ability for collagen within aged bone to strain, 

as seen in synchrotron generated X-ray exposure during mechanical tests. Mechanical tensile 

tests on aged bone link a specific molecular culprit of increased collagen crosslinking with age to 

reduced mechanical performance on the molecular scale, but the cellular mechanisms 

responsible for their accumulation are currently unknown. Given the importance of osteocyte PLR 

in remodeling the internal bone compartments and the documented loss of expression of specific 

genes utilized by osteocytes to remodel their matrix, including several MMPs and other proteolytic 

enzymes, in aged bone, here we test the hypothesis that age-related degeneration of bone 

strength and quality via alterations to the bone material matrix are caused, at least in part, by a 

loss of TGFb signaling and osteocyte activity. 
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Results 

Aged and TbRIIocy-/- Bone Show Related Expression Changes to Bone Remodeling Genes 

and Regulatory Pathways 

To determine similar molecular mechanisms of osteocyte function, RNA sequencing was 

performed on osteocyte enriched cortical bone from two independent sets of mice, 1) a series of 

progressively aged male mice from the C57BL/6 line (Buck Institute) and 2) a set of mice with 

osteocyte-specific ablation of TGFb receptor II (TbRIIocy-/-) with bone quality defects and losses to 

perilacunar/canalicular Remodeling (PLR) activity. Aged mice were compared to young (2 

months) mice from the same colony while TbRIIocy-/- mice were compared to their littermate Wild-

type controls (Ctrl).  

 

Figure 5.1: Similar transcriptional regulation in aged bone and bone with osteocytic 
interruptions to TGFb signaling. RNA from progressively aged mice displayed reductions to 
expression by RNA sequencing for genes within the TGFb signaling pathway (A) and genes 
utilized in osteocyte perilacunar canalicular remodeling (B). The Lysyl Oxidase family of enzymes 
responsible for enzymatic collagen maturation was also significantly repressed in aged bone (C). 
RNA sequencing for mice with osteocytic interruptions to TGFb signaling, with known inhibition of 
PLR, displayed reductions to other markers of osteocyte behavior (D) including Loxl2, and 
increased markers of inflammation frequently found in aged tissues such as markers of  TNF and 
NF-kB signaling (E) and the senescence associated gene linked to osteoarthritis X-link Inhibitor 
of Apoptosis (Xiap). * p<0.008 wrt. 4 months or wild type Ctrl. # p<0.008 wrt. 1 yr. 
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 Aged C57BL/6 (WT) mice showed age-related changes to genes involved in PLR including 

matrix metalloproteinases 2,13, and 14, while genes encoding acid-catalyzed enzymes Cathepsin 

K and ACP5 showed reductions at one year of age but rebounding activity at two (24 months) 

and two and a half years (30 months) of age (Fig. 5.1A). These mice also show commensurate 

changes to genes involved in TGFb signaling including on the receptor level (Tgfbr1, Tgfbr2), the 

intracellular transducer level (Smad3, Smad6), as well as reductions to downstream target genes 

(Pai1) (Fig. 5.1B). In line with reductions to TGFb signaling, aged bone demonstrated losses to 

expression of the TGFb-regulated Lysyl Oxidase family of enzymes responsible for maturation of 

collagen type 1 in the bone extracellular matrix41 (Fig. 5.1C).  

In addition to reduced expression of genes important for bone remodeling through 

perilacunar canalicular remodeling, TbRIIocy-/- bone showed differential regulation of genes in 

other important cellular functions. For example, TbRIIocy-/- bone exhibited a loss in expression in 

Lysyl Oxidase-like 2 (Loxl2), one of the major isoforms of Lysyl Oxidase, indicating losses to 

osteocyte regulation of bone matrix crosslinking in these mice similar to what was found in aged-

bone sequencing. Along the same lines, TbRIIocy-/- mice showed losses to both Mepe and Sost as 

well as several membrane-bound ATP-driven ion channels, e.g. ATP6v0e2, genes important for 

osteocyte function, bone mineralization, and coordination of bone homeostasis. (Fig. 5.1D). 

Selected genes up-regulated in TbRIIocy-/- bone, relative to Cre-negative controls (Fig. 5.1E) 

suggest increases to activity in both the TNF and NF-kb pathways through increased expression 

of Traf3 and Traf6, members of the TNF receptor superfamily, and Nkap, an effector of NF-kb 

signaling. Interestingly, the senescent marker Xiap, X-linked Inhibitor of Apoptosis, linked to 

senescent-induced osteoarthritis42, was also found to a significantly differentially regulated and 

induced gene in these mice.  
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Aging and Losses to TGFb Signaling affect Male and Female LCNs Differently  

The osteocyte lacunar/canalicular network is one of the largest cellular networks within the body 

whose functions range from cell-cell communications, maintenance of mineral homeostasis, and 

nutrient transport to the sensation of mechanical cues and the regulation of distal bone cell 

behavior in response to mechanical loading43,44. All osteocyte functions within the skeleton rely 

on the integrity and organization of the LCN, which degenerates or becomes disorganized in age 

and disease19. Alterations to the LCN in these situations have functional consequences and thus 

are a good marker to assess osteocyte health and function. To assay cellular health and the 

integrity of the osteocyte LCN, fluorescent confocal microscopy was used to capture and 

reconstruct large sections of the cellular network within the bone of young and aged TbRIIocy-/- 

mice and their age-matched controls in 3D (Fig. 5.2A, 5.2D).  Structural measurements of each 

network were made. Canaliculi per osteocyte is the most direct measure of osteocyte heath and 

network integrity. In males, young TbRIIocy-/- bone showed a genotype-dependent loss of canaliculi 

per osteocyte compared to controls. While the wild-type control bones displayed an expected 

age-related loss of canalicular connections, TbRIIocy-/- males did not show further significant losses 

to cellular connections up to 15 months (Fig. 5.2B).  An additional parameter that captures 

changes within the LCN is canalicular tortuosity, or the excess winding of individual channels 

between two adjacent osteocytes. Canalicular tortuosity in young lamellar bone increased with 

age in wild type mice, but young male TbRIIocy-/- bone displayed early degeneration of the LCN as 

marked by increased canalicular tortuosity that was maintained with aging, (Fig. 5.2C).  Female 

TbRIIocy-/- bone, on the other hand, again displayed a resistance to the effect of diminished 

osteocytic TGFb signaling at young ages, showing no differences in canalicular number and 

osteocyte canalicular tortuosity at young ages compared to controls (Fig.5.2E, 5.2F). With age, 

both TbRIIocy-/- and control females showed losses to canalicular number and increases to 
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canalicular tortuosity compared to their young counterparts but never differed between the 

genotypes at the same ages. 

 

Figure 5.2: Age-related degeneration of the osteocyte network in males occurs in a TGFb-
dependent method but may occur through other mechanisms in females. Visualization of 
the osteocyte lacunar/canalicular network via fluorescent confocal microscopy (A,D) shows a 
genotype specific degeneration of the network in males with losses to canaliculi/osteocyte (B) and 
increased canalicular tortuosity (C) in TbRIIocy-/- bone that does not worsen with age. Females 
showed only age-related changes to these parameters that with mirrored changes in both 
genotypes (E,F). TGFb ligand levels from multiplexed ELISA of homogenized bone lysate showed 
age-related reductions to ligand abundance in the bone of both males and females (G-J). 
Circulating ligand levels remained stable over time in males but showed decreases in females, 
possibly influencing cellular changes. (B-f) *p<0.0125 in post-hoc pairwise Fischer’s LSD test after 
two-way ANOVA (G-J) *p<0.008 wrt. 4 mo. within genotype control, ☨p<0.008 wrt. age matched 
genotype control in post-hoc pairwise Fischer’s LSD test after two-way ANOVA. 
 

Depletion of TGFb Ligand Levels in Bone, but not in Circulation, with Age 

TGFb ligand, produced by both osteoblasts and osteocytes, is embedded in an inactive, latent 

state within the forming mineralized bone matrix. Upon bone resorption, either through 

osteoclastic action or locally by osteocyte perilacunar/canalicular resorption, this growth factor is 
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released, and activated either through acid catalyzation or mechanical force, from the bone matrix 

and is able to interact locally or systemically. In bone, TGFb  has many roles, including balancing 

bone deposition and resorption by controlling osteoblast and osteoclast numbers and activity and 

for regulating osteocyte PLR. Given the importance of TGFb in regulating the behavior of cells 

that manage bone mass and quality, and the deregulation of bone cell activity with age, we sought 

to quantify the amount of ligand, and thus one measure of signaling potential, of TGFb in bone 

over time. Though TGFb ligand was quantified in both TbRIIocy-/- bone and controls, very few 

genotype dependent differences were observed and genotype overall was not a significant 

predictor of ligand abundance in in both uni- and multivariable linear mixed models (Table 5.1). 

Removal of genotype as a fit variable from this analysis did not alter the resultant fit coefficients 

(not shown), emphasizing its lack of influence on ligand abundance. The most significant predictor 

of ligand abundance overall from either tissue source was age, with coefficient weight increasing 

with time. In pairwise comparisons of ligand amount via age (i.e. vs 4 mo.), both TGFb1 and 

TGFb2 concentrations decreased with age in lysate analysis in both males and females (Fig. 

5.2G-J). TGFb3 was too dilute or under the limit of detection of this assay for statistical analysis 

from either tissue source. The only significant trend with age in serum was a decrease over time 

in TGFb2 in females (Fig. 5.2J). Pairwise comparisons between tissue source (bone lysate vs 

serum), showed that, in both males and females, the levels of TGFb1 were higher in serum than 

in bone lysate, while TGFb2 levels were equivalent, except in 15-month-old females where TGFb2 

levels in serum were lower than lysate concentrations. Investigation of interactions between 

variables in the multivariate analysis revealed a small interaction between gender and tissue 

source, showing that while there are no differences in the amount of TGFb within bone, females 

overall had 25% more circulating ligand levels than males. Interaction of time and gender 

however, showed that although both sexes experienced losses of total ligand amount with time, 

females showed a greater loss than males.  
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Table 5.1: Univariable and Multilevel linear mixed models describe age as the primary 
driver of lost TGFb ligand abundance. Prediction of ligand abundance from TGFb ELISA shows 
the strongest predictor of concentration is age, followed by what tissue type (bone or serum) 
samples were taken from with serum usually having higher amounts of concentration. There is a 
small but significant association for females to exhibit higher ligand concentration than males. 
Genotype (TbRIIocy-/- vs Ctrl) was not a significant predictor of ligand abundance. 

 

 

TbRIIocy-/- Males Exhibits Accelerated Aging in Tissue Scale Mechanics 

To determine tissue scale bone quality changes in the TbRIIocy-/- bone and the contributions of 

PLR to age-related bone fragility, the TbRIIocy-/- model of poor bone quality was allowed to age 

alongside its littermate controls and whole tissue scale bone strength was assayed via three point 

bending mechanical tests. Mice ages were grouped as young, but skeletally mature, (4 months) 

and aged with separate cohorts at 1 year (12 months) and at a later time point of 15 months in 

both male and female mice. Genotype-dependent alterations in tissue-scale skeletal mechanics 

-  stiffness, force at fracture, and post-yield displacement -  were found to be limited primarily to 

male TbRIIocy-/- mice and these differences became more pronounced with age. Control males 

displayed normal growth and aging patterns45 including the expected age-related losses in post-

yield displacement from 4 to 12 months that remained stable thereafter from 12 to 15 months.  

The changes in WT mice with age were mirrored in young TbRIIocy-/- bones. Specifically, young 

male TbRIIocy-/- bones exhibited increased bending stiffness and ultimate fracture load compared 
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to age-matched controls (Fig.5.3A, 5.3B) that matched values seen in the aged controls. TbRIIocy-

/- bones, however, continued to display aging effects as seen in continued increases in stiffness 

and strength over time, remaining greater than controls at each time point. Post-yield 

displacement also demonstrated similar, if inverse, changes demonstrating an aged-like 

phenotype in young TbRIIocy-/- bone with limited flexibility (Fig. 5.3C). This remained low with no 

further age-related significant changes in knockouts with time. Compared to age-matched 

controls, TbRIIocy-/- post-yield displacement remained significantly lower, emphasizing an 

additional deficit in tissue level structural properties caused by the disruption in osteocytic TGFb 

signaling.  

 While the resolution of three-point bending can be insensitive to material property 

changes, especially in the presence of macrostructural differences, aspects of these tests can be 

utilized for material insight. Unfortunately, observation of bending modulus (stiffness normalized 

by bone shape) in males (Fig.5.3D) as well as Work to Fracture as defined by the area under the 

Load-Displacement curve (Sup. Fig. 5.1) did not show significant differences between genotypes 

at any age. Work to Fracture, another material scale property gleanable from these tests, 

calculated as the area under the Load-Displacement curve, is a combination of a materials 

stiffness and post-yield behavior. Investigation into the Load-Displacement curves showed that 

although TbRIIocy-/- bones were stiffer than controls and load values rose more rapidly than 

controls during testing, they tended to fracture sooner and terminate the length of the curve where 

control bones were more ductile displaying longer post-yield behavior before fracture. Thus, the 

two portions of this parameter independently showed differences in opposite directions in the 

genotypes, mathematical confounding the material assessment of these bones via Work to 

Fracture. However, observation of the fracture surfaces of the bones post-testing via SEM (Fig. 

5.3I, Supp. 5.1 E,F) revealed striking differences between male controls and TbRIIocy-/- bones. 

While control bones frequently displayed jagged or oblique fracture surfaces, evidence of cracking 
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and crack deflection mechanisms utilized by brittle materials during fracture to dissipate stress 

and increase toughness46, TbRIIocy-/- bones did not display these behaviors and had flat fracture 

surfaces almost directly perpendicular to the direction of loading, indicative of a material 

weakness in male TbRIIocy-/- bones not identified by this specific test.  

 Mechanical testing of female bones matched previous results of in young bone and 

revealed possible divergence from normal aging patterns with age in knockout females. Female 

controls and TbRIIocy-/- bones did not significantly differ in terms of whole bone stiffness at any age 

but did show some trends towards increased stiffness over time as expected of aging (Fig. 5.3E). 

Similar relationships were found for other parameters including post yield displacement, fracture 

force, and bending modulus (Fig. 5.3F-H). Within their genotype, female TbRIIocy-/- bones from 4 

to 12 months displayed a significant increase to fracture load, likely the result of changes to bone 

structure and increases to their average bone size at this age.  The only other significant change 

with age in females was a loss of post yield displacement in control females from 4 to 15 months, 

traditional of normal aging in bone. Female bones of each genotype did exhibit some other 

marginal age-related changes over time but not to a significant level over the time studied. 

Interestingly, female TbRIIocy-/- bones at higher ages trended to exhibit some increases over 

controls to fracture load resembling the activity of male TbRIIocy-/- bone but these changes were 

not significant 

 While sex differences are generally not compared in this study, females overall showed 

lower mechanical outcomes in structural and material parameters than males. Males did show 

greater percentage changes with age than females in both genotypes from 4 to 15 months. 
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Figure 5.3: TbRIIocy-/- bone demonstrates tissue level fragility similar to aged bone 
stiffening. Three-point bend mechanical testing of femurs from TbRIIocy-/- bone and aged matched 
controls at 4, 12, and 15 months show an increase in stiffness (A) and fracture load (B) along with 
a decrease in post yield displacement (C) in male TbRIIocy-/- mice. Age-related trends in TbRIIocy-/- 

bone over time resembled accelerated patterns of aging in their wild type controls. Bending 
modulus was not any different by genotype for males but saw some age-related trending 
decreases (D). Females (E-H) do not show significant changes to their genotype controls except 
for elevated fracture load at 12 months. Fracture surfaces from male controls by SEM showed 
jagged and oblique fracture surfaces indicative of cracking that was absent from TbRIIocy-/- bone 
with flat fracture surfaces (I). *p<0.008 wrt. 4 mo. within genotype control, ☨p<0.008 wrt. age 
matched genotype control in post-hoc pairwise Fischer’s LSD test after two-way ANOVA. 
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Accelerated Growth and Aging in TbRIIocy-/- Skeletal Morphology 

To understand the changes to bone structural properties from 3-point bending, skeletal 

phenotyping via µCT of the cortical midshaft was completed to assay changes in bone shape and 

growth in TbRIIocy-/- bone compared to controls. The most visually obvious (Fig.5.4A) difference 

in male TbRIIocy-/-  bone shafts compared to controls was the presence of large intracortical pores 

at young ages (Fig. 5.4B) that persisted or increased throughout their lifetimes. By 15 months, 

control bone began to display some porosity that decreased the difference between themselves 

and knockout mice at this age. Cortical porosity is a hallmark of normal aging in bone and is seen 

in other age-related human skeletal morbidities such as osteoporosis and diabetes47. These 

porosities result in a “trabecularization” of the cortex which resulted in thinner cortical thickness 

measurements by traditional Scanco algorithmic methods (Fig. 5.4C) despite a visual increase in 

“apparent” cortical thicknesses visually (Fig. 5.4A). 

 In addition to these porosities, there is a genotype-specific alteration in young male 

TbRIIocy-/-   bone shape towards larger, more circular bone compared to age-matched controls. 

Overall, increased size in the TGFb deficient males is noted by the increased area moment of 

inertia and total volume (Fig.5.4D, 5.4E) in the TbRIIocy-/- bones. In mechanics, the area moment 

of inertia describes the resistance to bending or rotation of an object around a particular axis. For 

a hollow cylinder, such as diaphyseal cortical bone, this can be loosely described as MOIn = π(do
4 - 

di
4)/64 for rotation about any given ‘n’ axis and is influenced by the inner and outer diameters of 

the hollow cylinder. As such, it is a more precise description of bone shape illustrating the 

expansion of the cortical shell than the more granular total volume measurement that emphasizes 

bone mass rather than shape. Loss of genotype significance (P<0.007) at 12 or 15 months in 

either parameter is likely due to growth, such that control bones catch up with the accelerated 

growth within the TbRIIocy-/- mice. Both controls and TGFb-deficient bone showed 
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Figure 5.4: Accelerated bone growth and aging in TbRIIocy-/- cortical bone. Male TbRIIocy-/- 

bone exhibits several signs of an accelerated age-like phenotype including the development of 
intracortical porosities (A,G) that results in a trabecularization of the cortex and thus thinner 
cortical thickness measurements (B) the progressively worsen with age. Accelerated growth was 
also seen in male TbRIIocy-/- bone through increased moment of inertia (C) and total volume (D) 
measurements. Though TbRIIocy-/- males demonstrated a lower bone mineral density (E) the tissue 
mineral content as measured by TMD (F) within the analyzed volumes were no different across 
genotypes. Females do not show any genotype specific differences up until 1 year where they 
begin to display small increases to porosity and cortical trabecularization (H,I,N) increased bone 
size similar to males (J,K). Females also displayed lower bone mineral density and a slower age-
related accrual bone (L) with no difference in total mineral density (M). *p<0.008 wrt. 4 mo. within 
genotype control, ☨p<0.008 wrt. age matched genotype control in post-hoc pairwise Fischer’s LSD 
test after two-way ANOVA. 
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significant expansion of bone with age compared to their young (4 mo.) counterparts, as expected 

of normal growth.  

Tissue mineral density, describing the mass per volume of mineralized bone tissue (TMD), 

showed an age-related accrual of bone mineral in each genotype consistent with traditional 

growth and bone aging45,48. However, TbRIIocy-/- males compared to controls displayed a lower 

TMD and mineral density within the bone at all ages studied (Fig. 5.4F)45,48. In addition, TbRIIocy-

/- males demonstrated a slower rate of accrual not showing significantly elevated TMD in 

comparison to their 4-month-old counterparts until 15 months. This contrasts with the assessment 

of mineral density inclusive of soft tissue and marrow across the whole bone, as seen in bone 

mineral density (BMD) (Fig. 5.4G) values where TbRIIocy-/- males are not significantly different 

from controls despite their lower TMD. This is likely due to the increased size and amount of bone 

physically present in knockouts. 

 Female cortical bone morphology was largely resistant to the effects of disrupting TGFb 

signaling in osteocytes at young ages (Fig. 5.4H), as was noted previously15. In addition, up to 

one year of age, bone growth in the TbRIIocy-/- females is normal with no significant differences in 

the cortical compartment with respect to age matched controls (Fig. 5.4I-N), although at 12- and 

15-months TbRIIocy-/- females exhibited elevated MOI and total volumes compared to their age-

matched controls, similar to the enlargement seen in the males. Other genotype-specific 

differences in the females include the beginnings of the formation of intracortical pores in the 15-

month old female TbRIIocy-/- bone (Fig. 5.4I) leading to the beginnings of cortical trabecularization 

(Fig. 5.4H, 5.4J), and lightly decreased tissue mineral density (Fig.5.4M) in knock-out females 

compared to controls which reach significant levels by 15 months. Similar to males in this 

parameter, TbRIIocy-/- females were slower to accumulate bone mineral with age their wild type 

controls. 
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Table 5.2: Male TbRIIocy-/- trabecular bone displays resistance to aging in µCT parameters. 
Trabecular bone parameters measured by µCT showed mainly genotype specific differences in 
males where male TbRIIocy-/- resisted traditional age-related bone loss as seen in sustained 
BV//TV and TB.BMD and a tempered loss in connective density (CD) impacted by maintained 
Trabecular number and spacing with age. while control makes and females of both genotypes 
experienced age-related bone loss. *p<0.008 wrt. 4 mo. within genotype control, ☨p<0.008 wrt. 
age matched genotype control in post-hoc pairwise Fischer’s LSD test after two-way ANOVA. 

 

 Within the trabecular compartment (Table 5.2), control males saw rapid decreases to 

trabecular number and spacing with age as early as 6 months (not shown), resulting in lower 

connectivity density but saw no changes to trabecular thickness over time. Controls saw typical 

age-related losses to trabecular BV/TV, indicative of increases to age-related bone resorption and 

osteopenia45.  Young male TbRIIocy-/- bone showed increased BV/TV in comparison to control mice 

as well as higher mineral density (TB. TMD) but no differences to parameters such as trabecular 

number, thickness, or spacing. In contrast, BV/TV remained elevated over time in TbRIIocy-/-  males 

compared to controls, although it experienced marginal age-related losses, showing tempered 

age-related bone losses in knockout males. Trabecular thickness remained stable overtime in 

both controls and TbRIIocy-/- bone and never differed from each other during the time observed. 

 Female trabecular values also were largely similar between genotypes, while age-related 

trends were more obvious than in male bones. In contrast to the male TbRIIocy-/- bone that resisted 

aging, female mice of both genotypes experienced age-related losses to trabecular connectivity 

and trabecular number and increases to trabecular spacing without significant changes to 

Sex Genotype Age (mo) BV/TV TB. TMD (mg HA/cm3) CD (1/mm3) TB.N (1/mm) TB.Sp (mm) TB.Th (mm)
M TβRII ctrl 4 0.16±0.04 1044.81±46.54 235.35±48.24 5.23±0.37 0.19±0.02 0.045±0.005

12 0.07±0.07* 1112.88±31.58* 71.38±118.28* 3.11±1.12* 0.35±0.10* 0.049±0.006
15 0.05±0.05* 1143.29±41.13* 40.78±44.10* 2.65±0.71* 0.40±0.10* 0.053±0.008

TβRII ocy-/- 4 0.22±0.09 1110.76± 8.43☨ 204.19±61.45 5.29±0.86 0.18±0.04 0.050±0.008
12 0.18±0.05☨ 1160.49±30.16 146.04±89.69*,☨ 4.24±0.60☨ 0.23±0.03☨ 0.052±0.009
15 0.17±0.06 1125.68±64.34 100.11±67.18* 3.33±0.52* 0.31±0.05* 0.063±0.020

F TβRII ctrl 4 0.11±0.03 1125.09±16.84 115.69±38.85 3.76±0.32 0.27±0.03 0.050±0.002
12 0.08±0.09 1205.10±57.69* 12.83±11.95* 2.07±0.45* 0.51±0.10* 0.069±0.033
15 0.06±0.05 1195.93±53.49* 16.73±21.98* 1.77±0.27* 0.59±0.09* 0.063±0.023

TβRII ocy-/- 4 0.18±0.10 1161.28±28.78 97.51±55.42 3.65±1.03 0.30±0.13 0.072±0.023
12 0.09±0.09 1192.31±35.88 25.91±19.64* 2.20±0.51* 0.49±0.10* 0.064±0.022
15 0.09±0.09 1190.79±46.77 22.01±30.24* 1.86±0.37* 0.60±0.11* 0.071±0.025
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trabecular thickness (Table 5.2). Interestingly, similar to male TbRIIocy-/- bone, female TbRIIocy-/- 

trabecula showed significantly increased mineral density (TMD) and BV/TV at younger ages. 

These genotype differences were small however and disappeared with age. 

 

Epistatic Relationship of Aging and Osteocytic-TGFb Signaling Extends to Nanoscale 

Material Mechanisms 

In order to investigate the epistatic relationship between the changes in material properties with 

age and disruption to osteocytic TGFb signaling as evidenced by the lack of cracking in male 

TbRIIocy-/- bones during whole bone mechanical tests, synchrotron generated X-ray scattering and 

diffraction was utilized to investigate the composite materials of bone, collagen and 

hydroxyapatite mineral during mechanical stress30,49,50. Synchrotron X-ray exposure allows for the 

discrimination between collagen and mineral status through the difference in interaction of the X-

ray beam with the periodic structures on different length scales of the bone composite materials. 

As described by Bragg’s law, 2dsinθ=nλ, where n is the number or order of peak observed, theta 

(θ), the angle at which incident X-rays on a material are returned (scattered, diffracted, reflected, 

etc..) to a detector depends on the wavelength of the X-ray (lambda, λ) and the periodic distance 

between the material interacting with the beam (d). Leveraging the capability of synchrotron X-

ray light sources to generate high intensity monochromatic X-rays (single, constant X-ray 

wavelength λ), Bragg’s Law mandates that the only remaining factor that can impact the angle of 

return from synchrotron X-ray-exposed material is the d-spacing. The hierarchical and ordered 

structure of bone is well suited for use with X-rays in this method because both collagen and 

hydroxyapatite display ordered, periodic structures that exist on length scales of different 

magnitudes. Collagen’s ordered structure results in a d-spacing between consecutive collagen 

fibrils of approximately 67 nanometers, where the mineral c-lattice periodicity (the mineral crystal 

dimension parallel to the orientation of collagen periodicity) exists on a length scale approximately 
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100 times smaller than collagen’s at 6-7 angstroms. This difference in periodic structure length in 

collagen and mineral generates separate signals from collagen and mineral components of bone 

from a monochromatic X-ray source. Collagen weakly scatters (shallow theta angle) X-rays while 

bone mineral diffracts (high theta) incident X-rays. This aspect of bone’s hierarchical structure 

allows for Small Angle X-ray Scattering (SAXS) and Wide Angle X-ray Diffraction (WAXD) to be 

used to dissect the behaviors of collagen from mineral in bone. During exposure, when bone 

material is strained during mechanical testing, the periodic distances in each composite material 

stretch changing the relative d-spacing and altering the scattered or diffracted angle of the X-ray. 

This changes the position of the X-ray signal on the detector that can be traced over time 

throughout the mechanical test revealing the stretching, or straining, of the composite material 

from the separate SAXS and WAXD signals (Fig. 5.5A). Changes in the d-spacings over time are 

compared to the original unstrained d-spacing to generate composite material specific strains and 

that are then related to tissue level to determine the performance of bone’s nanoscale 

components with respect to whole tissue deformation. 

 Within these in-situ synchrotron tensile tests, the amount of strain carried by the composite 

material (collagen or mineral) can be determined by plotting the composite material’s X-ray 

captured strains against the tissue scale strain as calculated from whole tissue images captured 

on camera. Fitting this relationship can give an indication how much of tissue strain is captured 

by the specific composite material strain on the nanoscale, where a slope of 1 in this plot would 

indicate 100% of tissue strain is captured by whatever material is represented. For example, the 

slope of this line from the SAXS scans for the young, control males is around 0.75, indicating 

collagen is carrying the majority of strain on the nanoscale. With age, the best-fit slope of collagen 

specific strain to tissue strain increased from m=0.75 at 4 months to m=0.84 by 12 months, 

indicating that collagen is bearing a larger amount of tissue strain at 1 year of age than it was at 

4 months implying an increased ability for aged collagen to carry strain, or a stiffening of the 
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collagen matrix with age. Compared to age and sex matched controls, collagen from the young 

TbRIIocy-/- males displayed an inability to strain when uniaxially stretched with a best-fit slope of  

 
Figure 5.5: Synchrotron SAXS/WAXD shows altered collagen behavior in TbRIIocy-/- bone 
during in situ tensile testing. Synchrotron generated X-ray exposure during tensile testing of 
forearm bones of TbRIIocy-/- and controls at multiple ages generates signals unique to organic 
collagen (SAXS) and inorganic mineral components (WAXD) of bone based on their hierarchical 
size, order, and structure (A). Young TbRIIocy-/- males showed a deficiency in collagen strain 
capacity compared to controls (B) that was not seen in female knockouts (C). With age, collagen 
in all genotypes tightened increasing strain capacity (slopes of best fits). Male and female TbRIIocy-

/- increased in strain capacity faster than their age-matched controls such that TbRIIocy-/- males 
caught up with their controls (D) and females outpaced their age-matched controls in terms of 
strain capacity (E). Young mineral performance mirrored collagen behavior with young male 
TbRIIocy-/- bones demonstrating an inability for mineral to carry strain (F) while females remained 
unaffected (G). * indicates p<0.006 in comparisons of individual slopes to global fit in an extra 
sum-of-squares F test. 
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its collagen to tissue strain m=0.45, where the control bones rise with a slope of m=0.75, a value 

significantly lower than controls (Fig. 5.5B). TbRIIocy-/- females do not display this collagen 

associated weakness at young ages as the males do, where fits of control bones result in a slope 

of m=0.65 and female TbRIIocy-/- at m=0.67. Both sets of scatter plots were able to be fit using the 

same regression and were determined to be non-statistically different from one another (Fig. 

5.5C). Like its controls, 12 months, TbRIIocy-/- bone also demonstrated an increase in its material 

to tissue strain slope from m=0.45 to m=.74. This is a greater relative increase in slope from 4 

months to 12 months, of 64%, than male controls, who only increased by 12%. With age, collagen 

carries increased amounts of tissue strain in both TbRIIocy-/- males and controls, a process that is 

accelerated in TbRIIocy-/- bone such that by 12 months TbRIIocy-/- has overcome its initial inability 

to engage in straining and is no longer statistically distinguishable from its age-matched controls 

(Fig.5.5D). For females, control bones did not display any significant age-related changes to 

collagen strain slope values from m=0.65 at 4 months to m=0.57 at 12 months, fits were 

statistically insignificant between each other (Supp. Fig. 5.2B). However, Female TbRIIocy-/- bones 

saw a dramatic increase in collagen-tissue strain from m=.67 to a slope of m=0.92, resulting in a 

fit slope significantly different from control females at the same age (Fig. 5.5E).  

 In within-genotype comparisons between age groups, (i.e. male 4 mo. control vs 12 mo. 

control), to observe the effect of aging alone within each mouse line, slopes from fits for male 

control mice at 4 and 12 months do not differ from one another (P=0.1382) (Supp. Fig. 5.2A) and 

neither do fits from female controls at the same ages (P=0.023) (Supp. Fig. 5.2B), although this 

trended to see a small amount of slackening in female collagen with age. However, in the aged 

comparisons within the TbRIIocy-/- line, there was significant amounts of tightening over time in 

both the males and females (P<0.0001 for each) (Supp. Fig. 5.2C-D). 
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 Comparison of mineral behavior from WAXD in the young bones showed similar results 

as SAXS. TbRIIocy-/- males displayed a deficiency for the mineral to be strained or stretched when 

comparing best fit slopes of m=0.38 for controls and m=0.24  TbRIIocy-/-, fits statistically different 

from one another (p<0.0001) (Fig.5.5F). Fits from mineral-tissue strains from WAXD for females 

resulted in slopes of m=0.2 for controls and 0.25 for TbRIIocy-/-. Likely because of high variability 

in individual tests and low sample number (N) from this test, comparisons of these fits are currently 

statistically insignificant (Fig.5.5G).  

 

Collagen Modification and Arrangement is altered in TbRIIocy-/- mice 

Post-translational modification of type I collagen in the form of inter-fibril crosslinks has been 

shown to alter mechanical properties of bone in situations of normal aging and diseases such as 

diabetes29. While there are multiple types of chemical crosslinks present in the collagen fiber 

super structure, they predominantly fall under two categories: either enzymatically or non-

enzymatically generated51. Enzymatic crosslinks form as part of the normal maturation of collagen 

during its self-assembly and are regulated by the family of Lysyl Oxidase enzymes and are site 

limited to specific amino acids residues along the collagen fiber. The normal maturation process 

transforms weaker divalent crosslinks to more stable trivalent crosslinks imparting stability to the 

collagen superstructure52. With time these types of crosslinking events stabilize and reach a 

homeostatic level in fully mature collagen. Non-enzymatic crosslinks, on the other hand, occur 

spontaneously on any open lysine or arginine residue along or between collagen fibrils and can 

accumulate to up to 5-10 times greater than their enzymatic counterparts with aging52. This 

spontaneous crosslinking is often a result of glycosylation or glycoxidation events that can form 

permanent excessive intra- and interfibrillar chemical connections among collagen fibers. These 

types of crosslinks are known as Advanced Glycosylation End-products (AGEs) and negatively 

impact collagen’s ductility and ability to engage in specific deformation mechanisms such as 
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sacrificial bonding and inter-fibril sliding during deformation53. Additional AGEs that do not form 

crosslinks but instead interact with the surface receptor of AGEs, RAGE, can also form as part of 

this process and these have many different impacts on bone metabolism and remodeling54. One 

of the most common species of crosslinking AGEs that form within bone is pentosidine, a cyclic 

5-member carbon structure that naturally fluoresces allowing for it to be relatively easily quantified 

using a standard plate reader. Pentosidine represents only a fraction of crosslinking AGEs in bone 

as other non-fluorescent AGEs do accumulate in bone, including Carboxymethyl lysine (CML), 

and these are associated with increased risk of osteoporosis and fracture.55–57 Given the 

importance of collagen ductility in bone quality and strength, and the abundance to which AGEs 

naturally accumulate in bone over time, fluorescent AGEs were quantified in the bones of TbRIIocy-

/- and control mice. 

 Quantification of fluorescent AGEs from TbRIIocy-/- bones from both sexes showed no 

genotype-dependent differences at young ages compared to control mice (Fig.5.6A, 5.6B). By 12 

months, both control and TbRIIocy-/- bones showed an increase in AGE content compared to their 

young within-genotype counterparts, as is expected of aging bone. Interestingly, both male and 

female TbRIIocy-/- bone saw an additional amount of AGE accumulation compared to their age-

matched wild-type controls at 12 months, resulting in the aged TbRIIocy-/- bones to have the highest 

concentration of AGEs normalized to total collagen content. There were no differences in AGE 

concentration between male and female mice within genotypes at both ages studied. 

 An additional marker of collagen health and a marker of bone remodeling and proper 

upkeep is collagen orientation. Collagen within lamellar bone is normally aligned in regular parallel 

sheets, or lamella. Disorganization of this arrangement has been noted in the bones of mice with 

disrupted osteocyte perilacunar remodeling through losses of MMP13, a proteolytic enzyme 

responsible for mediating collagen degradation58, and in glucocorticoid induced osteocyte death 

and osteonecrosis33. To evaluate ensemble collagen order, a feature of the SAXS pattern 
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describing collagen orientation was quantified. During exposure, scattering of X-rays from bone 

generates smeared ‘arcs’ of signal whose width describes how well collagen is aligned, thus 

analyzing the intensity distribution of these arcs yields information about collagen lamellar 

orientation. The numeric representation of this ‘smearing’ feature of the scattering arcs is known  

 

Figure 5.6: Collagen quality is impacted by both age and osteocytic TGFb signaling. 
Quantification of nonenzymatic collagen crosslinking in the form of advanced glycation end 
products (AGEs) shows an accelerated rate of accumulation in male and female TbRIIocy-/- bone 
(A,B), while collagen structural order as assayed by synchrotron generated SAXS showed a 
marginal but statistically significant loss of order in male (C) ,but not female (D), TbRIIocy-/- bone 
independent of age. 
 
as the “Hermans Orientation Factor” or the Second Legendre Coefficient (P2)59,60, and ranges 

from 1, perfectly linearly aligned collagen fibers, to 0, representing complete randomness and 

disorder in the fiber arrangement. 

 Comparison of this parameter from the unstrained condition from male and female control 

and TbRIIocy-/- bone at both 4 months and 12 months showed a minor loss of orientation in male 

TbRIIocy-/- bones as a main effect of genotype in two-way ANOVA analysis, with no change with 
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respect to age, and no alterations to female bones in either genotype at either age (Fig. 5.6C, 

5.6D).  

Discussion 

Age-related bone fragility arises as a consequences of lost bone mass and quality, but while 

mechanisms controlling bone mass with age are well understood, the cellular and molecular 

culprits behind lost bone quality are not clear and there is a lack of treatments specifically targeting 

this root cause of age-related fracture. TGFb is one of few known master regulators of cellular 

activity across all main bone cell types with many congenital skeletal dysplasias attributed to 

either under or over activation, further signifying its importance as a keystone in skeletal 

homoeostasis during growth and aging5,9,11,17,61. Aged bone shares many tissue and cellular level 

characteristics to bone with limited TGFb signaling in osteocytes including reduced fracture 

resistance, a degenerated osteocyte LCN, and lower levels of gene expression for enzymes 

involved in osteocyte PLR. Additionally, naturally aged bone shows decreases to gene expression 

within the TGFb signaling pathway on the receptor, transducer, and effector levels. Given the 

conspicuous similarities in these models of bone fragility and the implication of lost TGFb signaling 

as a potential mechanism behind the development of bone fragility, we hypothesized that specific 

molecular defects common with age may arise due to a loss in TGFb-directed osteocyte 

perilacunar canalicular remodeling, or a loss of bone material matrix upkeep on the cellular and 

molecular levels.  

 The role of TGFb in systematic aging is complex but has been linked to processes such 

as cellular senescence, inflammation, neurodegenerative disorders, cancer, and obesity among 

others62. In many of these cases, increases to the level of TGFb signaling have been implicated 

as a potential root molecular cause32. While TGFb is generated by a wide variety of cell types, it 

is actively stored in the mineralized matrix of the skeleton in an inactive state by bone forming 

osteoblasts and osteocytes17. Upon bone resorption, TGFb ligand is released from storage within 
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the bone matrix and converted into its active form allowing it to act both locally and systemically. 

With age, there is a natural uptick in bone resorption as osteoclast action and number 

increases17,63, potentially releasing elevated levels of TGFb into circulation while simultaneously 

depriving internal bone osteocytes of a needed stimulus for proper bone upkeep. This hypothesis 

could help explain the seemingly contradictory nature of age-related TGFb effects where systemic 

aging is associated with heightened activity in this pathway while reductions to it in bone lead to 

disruptions in normal cellular activity and subsequent bone fragility. While there are many factors 

of this theory left to be interrogated, deprivement of the signaling events caused by TGFb ligand 

within osteocytes through a removal of Tgfbr2 at the cellular level results in the generation of a 

bone phenotype eerily reminiscent of aged bone complete with degenerated osteocyte networks 

and increased bone fragility. Given these deficits appear at young ages in TbRIIocy-/- bone, 

interrogation of what other processes of bone growth or aging arise over time within this TGFb 

deprived context can help elucidate specifically what aspects of bone aging and its mechanical 

consequences are solely or partially dependent on functioning TGFb signaling within osteocytes. 

 The tracking of several aspects of bone quality across the lifetime of mice with osteocytic 

interruptions to TGFb signaling confirmed several aspects of our initial hypothesis. While aged 

bone does resemble young bones with disrupted TGFb signaling in osteocytes19, it was unclear 

what portions of the aged phenotype were TGFb specific and osteocytic in origin. Visualization of 

the osteocyte network from young and aged TbRIIocy-/- mice offered the most direct assessment 

of the effects of age and TGFb deprivement. Young male knockouts showed the greatest initial 

changes with losses to LCN integrity through lost osteocyte canalicular number and increases to 

individual canalicular tortuosity, changes we have demonstrated to be hallmarks of larger 

degeneration within the network with negative functional impact. Again, similar to previous 

results15, young females of this line were resistant to the effects of lost Tgfbr2 in homeostatic 

conditions as measured by these parameters. With age, control males displayed the same defects 
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that young TbRIIocy-/- mice showed while aged TbRIIocy-/- mice did not display any further 

degeneration of their network. This is potentially because at the cellular level, the inability of 

osteocytes to engage in TGFb signaling is sufficient to generate an aged cellular phenotype, 

signifying that aging in the male bones occurs through a TGFb-dependent mechanism. Over time, 

females of both genotypes demonstrated canalicular loss and increased network tortuosity, 

showing that although the mechanism by which they degrade may be TGFb independent, the 

phenotypic and functional consequences of age are the same for both males and females.  

 The TGFb superfamily is highly diversified and has the ability to engage in signaling not 

only though its own receptors, but also through various other related receptors including those for 

activin and BMPs62, and many of these receptors are relevant to osteocyte responses to relevant 

stimuli including fluid flow shear stress64.  Thus, despite the ability for young mutant females to 

compensate for the loss of Tgfbr2 in some measures of bone quality as seen here and in previous 

studies15, the age-related degeneration of the LCN in female bone may not be entirely TGFb 

independent. ELISA results document the loss of ligand from both the bone compartment and 

from circulation. While the direct levels of crosstalk among receptors in the TGFb family are not 

known in this context, the decreased capability for these events to occur with age would be directly 

related to decreasing amounts of ligand and signaling capability. Thus, as ligand levels within 

bone drop with age, specific defects related to the loss of TGFb may arise from the loss of 

signaling either on the receptor or the ligand level, even if female systems have a mechanism to 

compensate for loss of Tgfbr2.  

 On the tissue scale, the loss of TGFb signaling in young bone seems to result in an 

accelerated aging or growth of bone. From three-point bend tests young male TbRIIocy-/- mice 

demonstrated lost ductility as exhibited by the loss in post-yield displacement and a compensatory 

increase to stiffness and failure load compared to controls. Overtime, control bone also increased 

in stiffness and ultimate load while also losing ductility, as expected of age in bone. By 15 months 
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control bone quantitatively resembled the 4-month-old TbRIIocy-/- bone in these measurements, 

signifying that young TbRIIocy-/- males did display an aged macromechanical phenotype early in 

life. Interestingly, TbRIIocy-/- bone progressively followed typical age-related trends continuing to 

increase stiffness and strength overtime, implying that while these bones were predisposed to 

obtain age-related defects early, they can accrue more severe changes over time. This is 

significant because it emphasizes the difference in mechanism on the biologic scale from cells to 

whole tissue where the cellular defect, if established early, may continue to impact progressive 

change on the tissue scale. 

 Female TbRIIocy-/- bone primarily displayed aging effects rather than genotype differences 

to bone mechanics through time-dependent trends towards increases in stiffness and fracture 

load. Interestingly though,  TbRIIocy-/- females did begin to display some possible accelerated aging 

past 12 months with increased fracture force and a small loss in post yield displacement. This 

pattern is similar to what occurred in male mice, and their emergences later in life in females 

suggests that the resistance or compensation for lost TGFb signaling capability in females may 

dissipate over time raising additional questions about the molecular mechanisms supporting 

osteocyte behavior in females. Overall, however, changes to bone mechanics in the aged TbRIIocy-

/- females hints that in aged contexts, lost osteocyte function contributes to changes to bone 

mechanics in females. 

 The changes to bone mechanics seen on the tissue scale are primarily alterations to 

parameters stemming from bone structure, but the reason for the alterations to structure are 

unclear. TbRIIocy-/-  male alterations to bone shape, seen through µCT of the femoral shafts, 

included increases to bone volume, MOI, and cortical thickness. Following simple application of 

beam theory, it is logical that increases to bone thickness and size would result in a less pliable 

structure that is able to withstand higher loads prior to fracture. Interestingly, TbRIIocy-/-  males were 

hypomineralized, likely resulting in a bone with lower modulus, as seen in nanoindentation of 
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these bones previously . This loss of bone mineral density would directly impact the unit for unit 

ability for bone to resist deformation and support load implicating a loss in material properties as 

well as changes to structural ones. Three-point bending tests can obscure differences in material 

properties as it is sensitive to structural changes within the material tested. In the TbRIIocy-/- males 

with elevated stiffness, this was noticed in the lack of an expected material difference between 

the genotypes seen through bending modulus. This is due to the normalization of stiffness by 

bone size that is required in this method for obtaining moduli. Because TbRIIocy-/-  males on 

average displayed the larger overall bone size, these changes in tissue level stiffness did not 

translate to a detectable material level difference by this method.   

 Several observations from this study suggest that TbRIIocy-/- bone does have material scale 

differences. Primarily, the mechanisms of failure during three-point bending raised concerns 

about the integrity of the bone material. TbRIIocy-/- males fractured at lower strain and failed to 

engage in traditional toughening mechanisms such as crack deflection, signifying a material deficit 

that may predispose them to fragility fracture. This is evidenced by the flat fracture surfaces of 

TbRIIocy-/- bone in contrast to the jagged and often oblique fracture surfaces of controls. 

Observation of the load-displacement curves generated during three-point bending (Supp. Fig. 

5.1A,B) shows dips (red asterix) of load values during testing of controls corresponding to 

cracking events where built up stress within the material may have been dissipated before 

continued deformation of material increased applied load. These behaviors were absent from 

male TbRIIocy-/- who’s behavior during testing was to rapidly increase load at lower strain and more 

often catastrophically fail without engaging in much post yield deflection. The inability to engage 

in cracking signifies a more fundamental change to the bone material and supports the role of 

osteocytic TGFb signaling in a critical toughening mechanism. 

  An additional marker of lower material scale properties in the TbRIIocy-/- bone is the 

significant absence of bone mineral density as seen in µCT assessment of TMD. Male mutants 



 163 

at all ages displayed a lower mineral density than controls at all ages, implying a less mineralized 

bone matrix with possibly inferior material properties. This signal of lower material properties in 

the male TbRIIocy-/-  mice was demonstrated by females around the same time that changes to 

bone mechanics begin to emerge in female knockouts. By 12 months, female TbRIIocy-/-  bone 

compared to their age matched controls, begin to demonstrate lost TMD, showing significant 

differences by 15 months. Following the idea that lost material property would feedback and result 

in compensatory change in size tracks in females TbRIIocy-/-  bone post 12 months, implying that 

females lose their ability to regulate bone homeostasis after a certain point and become to 

resemble their male counterparts on the tissue scale. 

 One important aspect of the TbRIIocy-/-  phenotype is the generation of intracortical pores. 

While the precise mechanism for the appearance is currently unclear, these pores represent a 

significant change to bone architecture underlying cellular behavior. Additionally, their accelerated 

emergence in females of this line post reproductive age points again to females succumbing to 

lost osteocyte TGFb signaling capacity. Importantly, the development of intracortical pores is a 

feature of other diseases in bone related to aging including obesity and diabetes. Aged bone 

naturally forms these additional pore structures18,47 and has obvious impacts to bone health, 

increasing bone surface area and availability for osteoclastic bone resorption. While how and why 

pores like these form in bone with age and disease is unknown, their presence in bone without 

functioning TGFb signaling in osteocytes further points to the importance of this cellular process 

in maintaining bone health and how its loss may predispose or be casual in bone aging. 

 Changes to bone mechanics, losses to mineral density, and the inability to engage in 

cracking during failure prompted the investigation of bone material properties. Given that limiting 

TGFb signaling in osteocytes directly impacts osteocyte’s ability to manipulate their surrounding 

bone through PLR by loss of matrix remodeling enzymes, we sought to determine how this 

impacts bone mechanics on the same relevant scale. Results from in-situ synchrotron tensile 
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tests showed that collagen from male TbRIIocy-/- bone had an inability to engage in fibril straining 

as seen by a lack of increasing collagen D periodicity during bone stretching. This confirmed a 

material scale defect in the young TbRIIocy-/- males, where bone that is more pliable would result 

in lower bending resistance and explain the corresponding need for altered bone structure to 

compensate. However, quantification of excess collagen crosslinking via AGE fluorescence did 

not show differences between young controls and knockout bones, eliminating non-enzymatic 

crosslinking as a molecular defect responsible for this specific weakness. 

 Although non-enzymatic crosslinking is not sufficient to explain the initial weakness 

present in young TbRIIocy-/- bone, AGEs are not often present in high enough concentrations in 

young bone to be of consequence. With age, AGE concentration can increase as much as ten 

times initial concentrations increasing their relevance to bone mechanics with age. Given that 

osteocytes normally recycle their surrounding matrix, halting or diminishing this behavior may 

increase the rate at which AGEs accumulate in bone. Quantification of AGEs in aged TbRIIocy-/- 

bone revealed this with AGE concentrations in aged knockouts significantly elevated compared 

to wildtype controls. While wild type mice did show about twice their initial value of AGE 

crosslinking from 4 to 12 months, as expected of age-related increases to AGEs, TbRIIocy-/- bones 

contained triple the amount of their 4-month values, demonstrating an accelerated accumulation 

of non-enzymatic crosslinking in the bone without osteocytic bone remodeling. This resulted in 

12-month TbRIIocy-/- bones, in both males and females, to contain approximately 30% higher AGEs 

than normally aged controls. This occurred alongside dramatic increases to TbRIIocy-/- collagen 

strain in both aged conditions, where controls with lower amounts of non-enzymatic crosslinking 

did not display significantly increased collagen strain. This is perhaps because in wild type mice 

this amount of accumulation does not yet have a mechanical consequence or that there are other 

regulatory mechanisms at play promoting proper collagen function absent in knockout bones. The 

data from these experiments suggest that loss of osteocytic TGFb signaling compromises 
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material properties of the bone collagen matrix in two ways: 1) unknown deficits that result in  

collagen with insufficient tensile properties as seen in the young male TbRIIocy-/- bone and 2) an 

accelerated accumulation of non-enzymatic crosslinks with age, including fluorescent AGEs 

(pentosidine) and likely others (CML), that can increase crosslinking within the matrix resulting in 

a stiffer bone. While the young females did not display this first deficit, perhaps due to some 

compensatory mechanism, it is important to note that collagen tightening and accelerated AGE 

accumulation did occur in knockout females at 12 months, again suggesting that females begin 

to display the effects of lost TGFb signaling in osteocytes over time. Whatever the case for norm-

aging, proper TGFb signaling in osteocytes limits the accumulation of AGE chemical alterations 

to the bone matrix that have mechanical consequences towards bone stiffening.  

 Synchrotron analysis of mineral behavior from WAXD revealed similar patterns of material 

regulation in young bone. In the TbRIIocy-/- males, mineral crystal lattice spacing did not increase 

in knockouts during bone straining to the same rate as controls. This may be because the bone 

itself is hypomineralized and the mineral crystals less able to transfer strain among themselves. 

The absence of this behavior in mutant females, and non-significant differences in TMD at this 

time in female TbRIIocy-/- and control bones supports this claim, although WAXD results from 

females requires clarification at this time.  

 The loss of TGFb signaling in osteocytes generates an accelerated aging phenotype in 

bone by altering cellular performance that compromises fundamental material properties and 

leads to altered bone structure. In the absence of TGFb, the osteocyte network degenerates, an 

early sign of cellular disfunction. Osteocytes normally regulate their surrounding bone material 

with a wide range of secreted factors that require TGFb for expression including matrix modeling 

and remodeling enzymes such as Loxl2 and Mmp13. Loss of this cellular action results in a 

collagen matrix with insufficient tensile properties. In addition, the removal of osteocytic TGFb 

signaling results in a hypomineralized bone matrix, possibly leading to a softer, more pliable 
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mineral. The inability to regulate both the organic and mineralized inorganic components of bone 

on the cellular scale results in bone with poor material quality that cannot properly engage in 

molecular deformation and toughening mechanisms, as seen through the lack of collagen strain 

from SAXS and an absence of crack deflection on the tissue scale during failure. Through 

unknown mechanisms, TbRIIocy-/- bone seems to compensate for their poor material quality by 

increasing the amount of bone present and by altering their bone shape. With time TGFb mutant  

bone demonstrates an accelerated accumulation of nonenzymatic collagen crosslinking 

compared to age-matched genotype controls, likely influencing the rate at which collagen strains 

during mechanical stress, perhaps as another compensatory mechanism or more 

straightforwardly a consequence of lost cellular bone remodeling. In any case, this results in less 

pliable bone potentially more prone to fragility fracture. The changes that occur in younger 

TbRIIocy-/- bone foretell the changes that occur in wildtype bone over time. Wildtype bone 

demonstrates similar changes to bone shape with age as well as increases to nonenzymatic 

collagen crosslinking. Several markers of TGFb signaling and PLR are decreased in aged bone, 

suggesting that lost osteocyte mediated bone remodeling is behind changes to bone material with 

age, namely the increase in nonspecific collagen crosslinking and the consequent tightening of 

the bone matrix. While these changes can occur along-side changes declines bone mass with 

age, the identification of the accelerated accumulation of AGEs in a TGFb deficient context 

reveals a bone-mass independent, osteocyte-specific mechanism that negatively impacts bone 

quality. 

 Synthesis of these findings reveal a role for TGFb mediated osteocyte PLR in age-related 

bone quality. As PLR acts as a homeostatic mechanism that maintains bone quality, losses to its 

behavior would consequently result in lack of regulation of chemical and material changes to the 

bone matrix with age. Wildtype aged bone demonstrated losses to TGFb signaling gene 

expression while levels of TGFb ligand decline in bone with age suggesting that cellular behaviors 
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regulated by this pathway would decrease with age as well, as was seen in losses to PLR gene 

expression with age. Age-related alterations to the osteocyte LCN, which mirrored changes seen 

in young TbRIIocy-/- bone, confirm a cellular defect with age that is related to the documented loss 

of TGFb signaling. Suppression of osteocyte regulatory behaviors result in changes to the bone 

material, namely chemical alterations to the collagen matrix, which on the nanomechanical scale 

was seen in increases to collagen strain and was mirrored by changes on the tissue scale through 

increased bone stiffness and lost bone ductility with age. Thus, maintaining osteocytic PLR over 

a lifetime may be a tractable way to prevent the alterations to bone material properties with age, 

protect bone toughness, and reduce fragility fracture in elderly populations.  

 While the role for osteocytic PLR in maintaining bone quality with age has been elucidated, 

several questions remain about the root of bone quality deficits in the young, male TbRIIocy-/- bone 

and the role for osteocytic TGFb signaling in early bone growth and maturation. Young TbRIIocy-/- 

males demonstrated deficits to bone density, collagen orientation, collagen strain, all while 

demonstrating tissue level increases to stiffness. Specifically, the lack of both collagen and 

mineral components of TbRIIocy-/- bone to carry strain on the nanoscale, as seen through in situ 

synchrotron tensile tests, raise concern about the integrity and chemical composition of the bone 

matrix on the molecular scale. Compositional analysis that could confirm a molecular root for 

changes to material properties would require techniques such as FTIR or Raman Spectroscopy 

analysis. This future work would be critical for understanding the role of osteocytes in bone 

development and maturation as osteocytes may also be the cellular agent responsible for the 

maturation of enzymatic collagen crosslinks. The turnover from divalent to trivalent crosslinks in 

collagen are part of the normal maturation process in collagen and increases to crosslinking would 

increase the ability for collagen to carry strain. The enzymes responsible for these specific 

transformations include the Lysyl Oxidase family of enzymes, and RNAseq from young male 

TbRIIocy-/- revealed that Loxl2, one of the main Lox isoforms, is significantly decreased in the bones 
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of these mice. Lox and its isoforms are tightly regulated by TGFb signaling in many contexts41, 

thus lack of appropriate TGFb signaling in osteocytes may be behind the loss of Lox-induced 

collagen crosslinking leading to the inability of young TbRIIocy-/- collagen to carry strain. Changes 

to bone matrix material properties could result in the compensatory changes to bone size that are 

demonstrated in young TbRIIocy-/- bone. Investigation of the molecular regulatory systems 

responsible for these tissue level architectural changes in this context may also reveal 

mechanisms by which aged and disease bone also acquire these changes, namely intracortical 

porosities, that may negatively impact bone strength. Thus, continued investigation into the 

specific ways in which TGFb signaling in bone helps shape material and tissue scale properties 

during growth and development are warranted.  
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Supplemental Figures 
 

 
Supplemental Figure 5.1: Evaluation of load-displacement curves revealed changes to 
mechanical behavior during bending tests despite no change to energy dissipated during 
fracture. 
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Supplemental Figure 5.2: Within genotype comparison of collagen strain with age shows 
increased collagen strain in male and female TbRIIocy-/- bone. 
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Chapter 6: Summary, 
Conclusions, and Future 
Directions 
 
Summary and Conclusions 

Osteocyte perilacunar/canalicular remodeling (PLR) is a dynamic process by which bone 

embedded osteocytes resorb, replace, and renew their surrounding bone matrix. Given the 

dramatic size and surface area of the osteocyte cellular network, second in the body only to the 

nervous system, this cellular process has immense potential as a mechanism of material upkeep 

and supporter of bone quality within the skeleton. The role of the skeleton in supplying mechanical 

support and motion to the body places it under great mechanical stress and strain leading to wear 

and damage over time that may lower its structural integrity. Fragility fracture, fractures that occur 

at subcritical energies, are most common in aged individuals or in those with congenital dysplasia 

- conditions that worsen the material strength of the bone. In these situations, the physical material 

of the skeleton suffers from a lack of quality on the molecular scale resulting in an uncoupling of 
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bone mass from bone strength leading to bone fragility. Aging throughout the body is marked by 

a broad decline in cellular function, so it stands to reason that the skeleton and skeletal cells 

would not be uniquely immune to deleterious aging. If age-related bone fragility is related 

specifically to bone quality and bone material properties, then the cellular mechanisms, namely 

osteocyte perilacunar/canalicular remodeling (PLR), responsible for its upkeep are implicated in 

bone fragility. Thus, PLR’s nature as a cellularly derived mechanism portends its susceptibility to 

aging and declines to bone quality with time.  In broad strokes, this supports the idea that healthy 

osteocytes provide a homeostatic mechanism for renewal of bone material maintaining its 

mechanical strength, and with age this process declines leading to an accumulation of 

damage/alterations to the skeleton that lower both bone quality and fracture resistance. Much is 

still unknown about the molecular regulators of osteocyte PLR, much less its regulation over time, 

or how these molecular pathways interact with other mechanisms of aging. What age-related 

defects arise within bone as specific consequences of arrested osteocyte bone remodeling, and 

strategies to prevent or restore these weaknesses, remain a large knowledge gap in the effort to 

protect skeletal health with age.  

Herein, I explore the role for one specific regulatory mechanism, the Transforming Growth 

Factor Beta (TGFβ) pathway, and its role in the age-related changes to osteocyte function and 

thus the development of bone fragility interrogated. Previously, TGFβ was shown to be a main 

molecular regulator of osteocyte PLR in young homeostatic conditions where loss of TGFβ 

signaling in the osteocytes of young males resulted in the development of severe bone quality 

defects1. Interestingly, the defects within bone resulting from osteocytic TGFβ deprivement eerily 

resembled aged bone, including poor fracture resistance and a degenerated osteocyte 

lacunar/canalicular network. Results provided here document decreases to TGFβ signaling within 

aged bone for the first time, including a loss of TGFβ receptor II, the specific defect experimentally 

induced within osteocytes to create young bone without functional TGFβ signaling. These cellular, 

molecular, and mechanical similarities lead to the hypothesis that age-related bone fragility 
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stemming from a loss in osteocyte-controlled bone quality is the result of decreases to TGFβ 

signaling over time in osteocytes. 

Systemically, TGFβ exerts potent growth inhibitory activities in various cell types, and 

increased TGFβ signaling with age has been linked to the phenotypes of cellular senescence, 

stem cell aging, inflammation, and tissue fibrosis2–4. In addition, accumulated evidence has 

indicated a multifaceted association between TGFβ signaling and other aging-associated 

disorders, including Alzheimer’s disease, muscle atrophy, and obesity5–8. Within bone, TGFβ 

balances the cellular activities of the three main bone cell types, regulating osteocyte PLR, 

promoting osteoblast differentiation and migration, and promoting bone resorbing osteoclast 

survival. With age, TGFβ may be partially responsible for the uncoupling of bone resorption and 

bone deposition by increasing surface osteoclast numbers, but its role in osteocyte aging and its 

decreased activity within aged bone remains unexplained. TGFβ itself is stored in a latent form 

within the bone matrix and is activated upon bone resorption. Over time as osteoclastic bone 

resorption increases, increasing amounts of local TGFβ ligand may be liberated from the bone 

matrix allowing it to act systemically to drive distal responses to TGFβ while depleting local bone 

cells of this important homeostatic stimuli. This change in ligand balance may help to partially 

explain the seemingly contradictory nature of TGFβ signaling increasing and driving aging 

systemically and the loss of it locally in bone leading to the declines of bone-regulatory 

mechanisms. Thus, activity within the TGFβ signaling pathway with age may be reduced at 

multiple stages including both at the ligand and receptor levels and beyond. 

Within the landscape of altered local and systemic changes to TGFβ signaling with age, 

the loss of osteocyte intrinsic TGFβ signaling with age within the bone is an important potential 

mechanism by which age-related bone fragility may arise through lost osteocyte bone remodeling. 

Results from this work explore the functional consequences of age on the osteocyte network, the 

importance of osteocyte PLR in maintaining bone quality over time, and propose a role for the 

decline in osteocyte TGFβ signaling as a driving factor behind these changes in bone. 
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Osteocytes reside within bone in cavities termed “lacuna” and extend their long 

cytoplasmic dendrites into the mineralized bone through narrow canals called “canaliculi” 

connecting to other osteocyte dendrites via gap junctions, as well as with bone lining osteoblasts 

and osteoclasts, and vasculature, to form the lacunocanalicular network (LCN). Entombed within 

the mineralized matrix of bone, osteocytes rely on the integrity of the LCN and their cellular 

connections for both function and survival. Thus, the osteocyte LCN is a hallmark and marker of 

generalized osteocyte health. While the greater architecture of LCN can change based on location 

and bone type, a healthy LCN is characterized by its many, mostly linear, canalicular connections, 

as this aides in fluid motion within the LCN that drives nutrient exchange and mechanosensation. 

Degeneration of this architecture either by a loss of canalicular connections or a change in 

pathway geometry may compromise these important functions of the LCN that are the backbone 

behind osteocyte behavior. Independent, side-by-side, observations of LCN architectural change 

in both aged osteocytes and osteocytes without functional TGFb signaling showed increases to 

osteocyte canalicular tortuosity and lost canalicular numbers per osteocyte, raising questions of 

precise functional consequences of degeneration in both these models. Interestingly, TGFb 

deficient bone did not demonstrate the losses of entire osteocyte cell bodies that the aged cohort 

did, signifying that TGFb may have a role in specifically maintaining osteocyte canaliculi. The 

shared canalicular defects in both models also resulted in similar outcomes for functional tests of 

these networks. In both simulated diffusion and fluid flow dynamics, the degenerated networks 

performed worse than controls identifying osteocyte-specific functional losses that are tied to 

connectivity of the LCN within bone. These experiments showed that the functional losses 

experienced by aged osteocytes can be recapitulated in young bone through removal of TGFb 

signaling, implicating TGFb signaling in functional aging of the osteocyte LCN.  

Although TGFb is implicated in the functional losses, leveraging of behaviors controlled 

by TGFb, namely PLR and osteocyte resorption of local pericellular space, provides a way to 
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restore some amounts of LCN function lost with age. For example, relative to bone from virgin 

control mice, canalicular diameter can increase by 20-30% during lactation and returns to baseline 

after weaning, demonstrating expansion and constriction of the local PCS9. Thus, PLR could be 

a mechanism that can influence remaining LCN architecture even in a diseased or aged bone.  In 

computer models, doubling of the pericellular space around both of aged and TbRIIocy-/- osteocytes 

returned modeled fluid shear stress to levels that were indistinguishable from young or wild type 

controls. This demonstrated that control of the pericellular space, possibly through TGFb 

mediated PLR, presents a mechanism by which osteocytes can adapt their mechanical 

microenvironment to reclaim meaningful amounts of lost physical stimulation in age and disease. 

While the degeneration of the LCN in both aged bone and bone with TGFb signaling 

disruption matched each other and were both correlated to the same functional consequences, 

the casual role of TGFb in aging was not clear. Analysis of gene expression within the TGFb 

pathway from aged bone confirmed a negative regulation of TGFb signaling in these bones at all 

levels within the pathway including losses to expression on the receptor, transducer, and target 

gene level as well as increased expression of antagonists of the pathway including markers of 

TNF and NF-kb10–12. In a separate analysis, TGFb ligand levels in bone measured through ELISA 

showed decreases in total ligand abundance, and thus signaling capability, within bone over time. 

These findings confirmed for the first time a generalized loss of overall TGFb signaling within aged 

bone. Previous studies have described the role of TGFb in mediating osteocytic bone remodeling 

to maintain bone quality while these results support the idea that age-related bone fragility may 

arise due to lost TGFb mediated cellular bone remodeling.  

While disrupting TGFb signaling in young osteocytes was sufficient to generate a 

phenotype resembling aged bone at the level of specific cellular changes and increases to bone 

fragility, and aged bone does display reductions to TGFb signaling and share mechanical and 

functional loss with TbRIIocy-/- bone, it was unclear what portions of the aged phenotype were 
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TGFb specific and osteocytic in origin. In order to interrogate the role of TGFb in generating an 

age-related phenotype, mice with eliminated TGFb signaling in osteocytes were aged alongside 

control littermates to observe differences in the development of bone quality defects with age 

within the two lines. Observation of the LCN from these mice over time showed lost osteocyte 

canalicular number and increases to individual canalicular tortuosity in the young male knockouts 

compared to their young control counterparts, and no further significant changes to the LCN with 

age up to 15 months in males. By 15 months, wild type males displayed the same defects that 

young TbRIIocy-/- mice showed. This is potentially because at the cellular level, the inability to 

engage in TGFb signaling is sufficient to generate an aged cellular phenotype, signifying that 

cellular aging in the male bones may occur primarily through a TGFb-dependent mechanism. 

Over time, females of both genotypes demonstrated canalicular loss and increased network 

tortuosity, showing that although the mechanism by which they degrade may be TGFb 

independent, the phenotypic and functional consequences of age are the same for both males 

and females. 

Changes to the cellular network in these bones hinted at altered cellular performance and 

maintenance of bone quality and material properties. Osteocytes normally regulate their 

surrounding bone material with a wide range of secreted factors that are regulated in a TGFb 

dependent manner1.  Expression data from young TbRIIocy-/-  males showed loss of the matrix 

remodeling enzyme Loxl2, which aids in the enzymatic maturation of collagen crosslinking, and 

other previous results documented the loss of other remodeling enzymes such as MMP13 in these 

mice1. Changes to the matrix modifying enzymes resulted in important functional changes within 

the bone matrix to insufficient tensile properties. In addition, the removal of osteocytic TGFb 

signaling resulted in a hypomineralized bone matrix, possibly leading to a softer, more pliable 

mineral phase. The inability to regulate both the organic and mineralized inorganic components 

of bone on the cellular scale resulted in bone with poor material quality.  
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Interestingly, TbRIIocy-/- bone seemed to compensate for their poor bone material quality 

by increasing the amount of bone present and by altering bone shape. These changes in bone 

shape in the knock-out bones foretold the eventual changes that the wild-type bone would 

eventually experience including periosteal expansion and the development of internal porosities 

often seen in age and in diseases such as diabetes. This provides evidence that bone growth is 

influenced by TGFb but is also managed through TGFb-independent mechanisms.  

With time, the lack of osteocytic PLR in TbRIIocy-/- bone resulted in increased accumulation 

of nonenzymatic collagen crosslinking, increasing collagen strain perhaps as another 

compensatory mechanism for initial poor bone quality or more straightforwardly a consequence 

of lost osteocytic PLR. In any case, this resulted in stiffer bone that is potentially more prone to 

fragility fracture. Control bones demonstrated similar changes, increases to non-enzymatic 

collagen crosslinking and tissue level bone stiffening, but to a lesser extent. This is perhaps 

because our ending time-point of 15 months for this study is not sufficiently aged into see dramatic 

changes in bone with initially intact TGFb signaling. However, age mice have been shown to 

display these specific chemical changes to their bone matrix and consequently demonstrate poor 

bone quality and mechanics13. Results from our own highly aged mice at 30 months old revealed 

expression-related repression of several markers of TGFb signaling and PLR, suggesting that lost 

osteocyte mediated bone remodeling is behind changes to bone material with age, namely the 

increase in nonspecific collagen crosslinking and the consequent tightening of the bone matrix. 

While these changes to the collagen matrix can occur along-side declines to bone mass with age, 

the identification of the accelerated accumulation of AGEs in a TGFb deficient context reveals a 

bone-mass independent, osteocyte-specific mechanism that negatively impacts bone quality with 

age. 
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Considerations and Future Directions 

While the major findings from this work are significant in that they reveal the cellular 

process behind a specific material level alteration within bone that occurs with age, several 

considerations and future work will further solidify these claims as well as reveal other 

mechanisms behind bone aging.  

The noticed increase to collagen strain capability with age is likely a combination of 

changes in several types of collagen crosslinking with age and not solely the effect of the single 

fluorescent AGE, pentosidine, that we have evaluated, but we have not fully assessed other 

cross-linking types in our aged conditions. One important consideration about the claims made is 

that currently we can only make correlative comments on the mechanical influence of nonspecific 

crosslinking on collagen mechanics within bone. There exist other forms of crosslinking - namely 

enzymatically generated trivalent mature crosslinks pyridinoline (PYD), deoxypyridinoline (DPD), 

and other forms of nonenzymatic crosslinks such as carboxymethyl lysine (CML) - but we have 

not evaluated the condition of these in our samples at this time and thus cannot attribute all the 

change in collagen behavior to fluorescent AGEs alone. However, previous work has 

demonstrated no statistical correlation with DYD or PYD concentration and bone mechanical 

properties in aged contexts, and instead note a high correlation between AGEs and mechanical 

stiffness. Of course, these observations are all correlative as it is hard to demonstrate causality 

at the moment in vivo without a way to directly enact AGE clearance. Agents that may modulate 

large amounts of bone turnover, i.e. PLR, may be a future method of demonstrating the direct 

control of collagen crosslinking from the cellular level via bone turnover.  

Currently, young male TbRIIocy-/- mice demonstrate a lack in collagen strain capability 

compared to their wildtype controls. Analysis of AGE crosslinking in these samples showed no 

difference in the amount of fluorescent crosslinks between these two groups at this time. This 

implies that the AGE crosslinking does not greatly impact the collagen mechanics at young ages, 

in line with other previous studies. In addition, the great difference in collagen behavior must be 
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attributed to other kinds of chemical modifications in the organic matrix of bone besides 

fluorescent AGEs. The other major species of crosslinking in young bone that does have 

mechanical influence is the transition from immature divalent crosslinks 

(dihydroxylysinornorleucine (DHLNL) and hydroxylysinonorleucine (HLNL)) to their stronger 

trivalent forms (PYD and DPD). This conversion is enzymatically enacted by Lysyl Oxidase (Lox) 

and its numerous isoforms (Loxl2-4). There exist many positive regulators of these enzymes, 

TGFb among them. RNAseq from young TbRII males showed a significant loss of Loxl2 in the 

bones of these mice, suggesting that these mice may have a deficiency in the normal maturation 

of collagen crosslinking. This would result in bones with immature collagen and poor tensile 

properties, as we have seen by SAXS. In order to confirm that this initial defect stems from a lack 

of TGFb driven Lox enacted conversion of divalent to trivalent crosslinks, direct measurements of 

the different species of enzymatic crosslinks in these bones would reveal whether or not the 

deficiency stems from the lack of normal bone maturation. Compositional techniques such as 

FTIR, Raman Spectroscopy, or HPLC are all possible methods that could interrogate these 

changes. At the time of writing, a set of bones from young TbRII mice have been set aside for 

analysis by FTIR but are not included in this current write up. This specific role for TGFb in bone 

growth and maturation is most important at young ages before nonenzymatic crosslinking 

dominates in mechanical influence on bone, and the rapid increase in collagen strain with age in 

the TbRIIocy-/- males at 12 months overcoming their initial mechanical deficiency demonstrates this 

effect. Given that the lack of collagen strain in the young TbRIIocy-/- males represents a 

developmental defect, this initial collagen deficiency does not seem to be associated with “aging” 

post normal skeletal maturation as much as other processes like the spontaneous generation of 

AGE crosslinks in bone.  

In addition to a more complete understanding of the condition of collagen, the mineral 

components of bone should be looked at with greater detail as well. Currently, we have only a 
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small number of samples that we have analyzed via WAXD to observe mineral specific 

deformations during mechanical testing. From these we can see that the mineral within the 

TbRIIocy-/- males also demonstrates an inability to carry strain. While currently the TbRIIocy-/- males 

show statistically different behavior within the mineral compared to their age-matched genotype 

controls, the females do not. These behaviors match observations in the young bones during 

SAXS assessment of collagen behavior, but these tests are low in N and very well could be 

skewed by the small number of replicates. Increasing replicate numbers for the WAXD is an 

important next step in confirming the nanomechanical behavior of the mineral crystals during 

testing. In addition, there is currently no WAXD data for the aged cohorts, so knowledge of the 

effect of age on the mineral is unknown, which may be critical in understanding the development 

of bone fragility and attributing the fault to either the organic or inorganic portions of bone or to 

both. In the synthesis of information about bone quality in these animals, it will be important to 

understand the status of the mineral, especially given that young male TbRIIocy-/- bone is 

hypomineralized and previous results via nanoindentation have shown a small, but statistically 

significant, loss in indentation modulus. These findings suggest that the bone mineral is more 

susceptible to mechanical stress and confirmation of this via WAXD will help us understand where 

fragility arises in this model and its dynamic behavior with age will elucidate the effects of aging 

on the mineral crystals of bone. 

 A current exciting and ongoing area of investigation in our system is interrogation of the  

molecular landscape at play in the samples observed here. At the time of writing, there are efforts 

to complete analysis for RNA sequencing on aged bones with osteocytic specific losses to TGFb 

signaling. These results will give us a greater knowledge of the molecular tools active within the 

osteocytes responsible for bone upkeep, their regulation and relation to TGFb signaling, and their 

behavior with age. Given our knowledge of the role of osteocytes in bone remodeling via PLR and 

the nano-mechanical data from SAXS, we suspect there to be a lack of expression for genes 
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involved in PLR, e.g. MMP13, CatK, Acp5, etc…, but we will not know this for sure until expression 

results can be confirmed. In addition, while the RNAseq should give us a detailed knowledge of 

gene expression, these RNA samples analyzed are not entirely osteocytic in nature. In order to 

more precisely attribute these changes to osteocytes, immunofluorescence and immunohistologic 

methods are additionally being advanced on tissues sections to visualize changes in expression 

within osteocytes and not neighboring cells. 

 In addition to the outstanding data to be collected as discussed above, there are new 

avenues of research that are prompted by the findings from this work. First, the mechanism by 

which the TbRIIocy-/- bone compensates for its lost material behavior to change its structural 

properties and increase its stiffness and ultimate load capacity is unknown. Physically, we 

observe an increase in bone stiffness and overall strength in the TbRIIocy-/- mice that can be 

attributed to the change in bone shape and size. What remains unexplained is how regulatory 

cells in these mice “know” that their bone material suffers from insufficient strength on the 

molecular scale and then enact this accelerated growth in turn to compensate. This question is of 

particularly interest in that it opens up questions surrounding the role of TGFb in osteocyte 

mechanosensation. The relationship with bone loading and bone formation with TGFb, especially 

in the context of the regulation of SOST, is complex and results from our own lab demonstrate 

multifaceted responses14–17. In conditions of a dominant negative TGFb receptor II, mice do not 

respond to the anabolic effects of load in that loss of TGFb responsiveness prevents the inhibition 

of SOST. Constitutively active SOST expression would prevent osteoblast differentiation and thus 

inhibit bone formation. However, in the TbRIIocy-/- mice, others from the lab have shown increased 

SOST expression in osteocytes in the knees and the jaws of these animals, two particularly 

mechanically active regions. Increased levels of SOST in these regions raises questions about 

the homeostatic regulation of SOST versus the mechanically induced expression after large 

amount of bone loading required for anabolic responses. In addition, we observe in this work that 
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bone formation is likely increased overall in these mice since the bones are larger and grow more 

quickly than their control counterparts. These intriguing findings suggest that the role of TGFb 

and mechanotransduction in osteocytes is a complex regulatory mechanism likely context and 

time dependent and is thus a fertile area of future research. 

 Another area of future research that may have clinical benefit stems from the findings 

within the female TbRIIocy-/- bone. The females of this line demonstrate either protection or a 

compensatory mechanism that prevents the loss of function within osteocytes in a TGFb deprived 

context. These mice demonstrate intact homeostatic PLR and do not develop the same 

developmental defects that the young males of this line do, including a maintenance of collagen 

order and mechanical behavior. With age however, characteristics of lost osteocyte behavior 

begin to emerge at an accelerated rate and the bones of females begin to behave more similarly 

to the aged males. This would imply the females lose their protective or compensatory mechanism 

with age. One initial thought is quite obviously that this mechanism is regulated through an 

endocrine or hormonal mechanism. Estrogen has many positive effects on bone including the 

preservation of bone mass by promoting the apoptosis of osteoclasts through a TGFb dependent 

mechanism.18 Estrogen also promotes synthesis and activation of TGFβ ligand in bone, which in 

a balanced context, also promotes and regulates bone quality.19 Post-reproductive age, estrogen 

levels fall in mammals leading to a host of changes, including potential dramatic changes in bone 

mass and strength, and potentially specifically to bone quality related parameters as well. Given 

that TGFb directed PLR declines with age, it is possible that the concurrent losses to both TGFb 

and estrogen effects in females may play compounding effects towards the losses to bone quality. 

An interesting proposal though would be to 1) know what the mechanism is that circumvents 

TGFb susceptibility in females 2) prevent its loss with age in females and 3) utilize it as a method 

to defend bone quality with age as TGFb itself declines. Thus, exploration of the hormonal 
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landscape and sex-hormone dependent regulation of the bone remodeling machinery is an 

important field of basic biology with high levels of clinical relevancy and significance. 

 A final area of future work concerns the utilization and leveraging of existent osteocyte 

machinery to defend or improve bone health. PLR is an important homeostatic mechanism that 

maintains bone health. Given that this process slows in aged bone, it seems reasonable that 

reactivation of this cellular behavior may reinvigorate lost bone quality. Unfortunately, one of the 

only well-known direct regulators of osteocyte PLR is TGFb and there are several difficulties with 

utilizing TGFb alone to treat bone quality deficits. As previously discussed, TGFb is involved in a 

host of other age-related pathologies, most of which are related to over expression within this 

pathway leading to tissue fibrosis or other debilitating conditions. These concerns exclude 

systemic TGFb supplementation as a choice for treatment. Thus, a study screening novel agents 

that can selectively modulate osteocyte behavior and PLR while avoiding the detrimental effects 

of elevated TGFb signaling elsewhere in the body is highly desirable.  
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